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Thanks!
Thanks for choosing ReBirth RB-338!

It is our sincere belief that this program will prove to be a valuable, exciting and
ative tool in your music making. Our primary goal during the development of R
Birth RB-338 has been to deliver what software synthesis for so long has prom
a real alternative to expensive and – in this case – partly “extinct” hardware. W
simply love synthesizers, and this love has been a major motivation during th
velopment process.

Now we hand our creation over to you. We hope you will have as much fun u
it as we had designing it!

We’d also like to take this opportunity to thank everybody that helped out dur
development, for the enormous support!

Please stay in touch, preferably via the web sites (www.propellerheads.se an
www.steinberg.net). We need your comments and ideas for the future!

Again, thanks!

Propellerhead Software/Steinberg Soft- & Hardware GmbH

About this Documentation

● All the snapshots in this manual have been taken with the standard version of 
ReBirth RB-338. We recommend that you don’t start using “Mods” until you 
feel comfortable with the location of the various controls on the panel. The 
reason for this is that in a “Mod”, controls may be named differently and will 
certainly not look like in the standard version.

Using Acrobat Documents

The following methods will help you find the information you require:

• Use the Table of Contents provided by the Adobe Acrobat Reader pro-
gram.

• Use the Adobe Acrobat Reader Find function.
• Click on a cross-reference (green text) to jump to the respective topic.

It is possible to print out this document or parts of it.

Additional Information on how to use the Adobe Acrobat Reader program can
found in its on-line Help.
- 8 - 



       
How the Documentation is Organised

The documentation for ReBirth RB-338 is divided into two parts:

• The printed documentation.
This describes how to install the program and gets you started using it.

• This on-line documentation
This contains detailed instructions, reference material, troubleshooting and 
index.
- 9 - 
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Introduction
It is extremely important that you make the correct audio settings on your com
ter. Please follow the instructions for each computer platform, below.

Windows Computers
The following text is a duplication of the help file that appears automatically w
you first launch ReBirth for Windows. If you have just followed the on-screen 
structions, you naturally don’t need to do this all again!

Selecting an Audio Card Driver

● If you are unsure about the terminology and concepts used in the following 
text, look up the chapter ”Audio on Computers” in this manual.

First, you must determine if you have DirectX installed on your system, or not

1. Open the Preferences dialog and locate the sound card settings.

The sound card settings in the Preferences dialog.

2. Pull down the Audio Card driver pop-up and select the last item.

3. Check the text below the box, does it say ”Driver type: Direct X”?

• If it does, you have DirectX installed. Proceed to the next step, “Finding 
out if your DirectX Driver is Emulated or not”.

• If it doesn’t, instead skip to the heading “Selecting an MME Driver” below.
- 11 - 
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Finding out if your DirectX Driver is Emulated or not

If (and only if) you have DirectX installed you need to find out if the audio card
driver is emulated or not. You should not use an emulated DirectX driver with Re-
Birth RB-338. To find out which type of driver you have, proceed as follows:

1. Pull down the Audio Card driver pop-up and select the drivers that corre-
spond to the card you want to use, one by one.

2. For each one, check the text after ”Driver type:” below the pop-up.

• If one says Direct X only (and the word emulated is not mentioned), use 
this driver. Then proceed to the heading “Setting the Audio Card Buffer”, 
below.

• If all say emulated, you should not use any DirectX driver. Instead read 
“Selecting an MME Driver”, below.

Selecting an MME Driver

To select the appropriate MME (Multimedia Extensions) driver, proceed as fo
lows:

1. Pull down the Audio Card driver pop-up and select the first item on the 
menu that corresponds to the name of the card you want to use.
You should avoid choosing generic driver names.

2. Check the text below the box, it should say ”Driver type: MME”. If it 
doesn’t, select another driver.

3. Proceed to the heading “Setting the Audio Card Buffer”, below.

Setting the Audio Card Buffer

It is very important that you trim the buffer setting properly. The buffer setting 
balance between fast response to control changes on one hand and “safe” au
playback on the other.

1. Open one of the demonstration songs.

2. Activate Playback.

3. Open the Preferences dialog, from the Edit menu.

4. In the Preferences dialog, locate the playback performance slider and 
drag it all the way to the right.

5. Now drag the playback performance slider to the left, a bit at a time. Try 
positions further and further to the left, until the sound starts ”breaking 
up” and the Underruns indicator starts incrementing.

6. Drag the fader a little bit to the right, so that the sound is OK again.
- 12 - 
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• If you use DirectX under Windows 95, you will normally be able to trim 
the buffer sizes down to between 40 and 90 milliseconds. 

• If you use MME under Windows 95, the same figure will normally be 
around 160 milliseconds.

7. Close the dialog.

You are now finished with your audio settings for ReBirth. The settings you ju
made are stored automatically.
- 13 - 
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Macintosh Computers

Why are there two ways of Playing back Audio?

ReBirth uses the Sound Manager on the Macintosh to play audio. This allows
play in the background and happily co-exist with other audio applications. Gre
care has been taken to make ReBirth compatible with all other Sound Manag
plications. This is what we call “Multitasking friendly” audio playback.

However, there’s a problem with some combinations of Sound Manager versi
and certain Mac hardware, where ReBirth can’t automatically determine the co
“audio buffer size”. This might lead to crackles or glitches in the audio playbac

● We recommend all users to check the buffer size, as described below, even if 
you don’t have problems with your audio. If you can use a lower buffer setting 
than the default, the program will be more responsive to control movements.

On some rare occasions, adjusting the buffer size might not be enough to rem
the Sound Manager problems. In this case, you have the option of selecting an
method for playing back audio, which we call “Crackle safe”. Selecting this 
method has some drawbacks though, see the end of this chapter.

Setting the Correct Buffer Size 

Normally you should leave the Sound Manager Audio setting at “Multitasking 
friendly”. However, you should make sure you have the correct audio buffer s
setting. Proceed as follows:

1. Open one of the demonstration songs.

2. Activate Playback.

3. Open the Preferences dialog, from the Edit menu.

4. Locate the Buffer size pop-up.

5. Select the smallest buffer size that allows you to play back audio without 
problems.

6. If none of the buffer sizes seem to work, switch from “Multitasking 
friendly” to “Crackle safe”, in the Preferences dialog and set the buffer 
pop-up to the value closest to “(1024)”.
- 14 - 
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About the Crackle Safe Option

Selecting the Crackle Safe option will make sure that ReBirth RB-338 
works properly in all situations. However, the mouse pointer will not move 
as smoothly and you might possibly run into audio problems with other 
programs playing via the Sound Manager. Furthermore ReBirth RB-338 
might possibly disturb other background processes such as networking.

System 8 note

System 8 users should make sure virtual memory is turned off in the Memory
trol panel, since it affects audio playback.

If you have to have virtual memory activated for some reason, you might have
raise the buffer settings drastically to get clean audio playback.

System 8.1 Note

In Mac OS 8.1, Apple have reduced the size of their sound buffers, which me
that latency has been cut in half. To take advantage of this, proceed as follow

1. Open one of the demonstration songs.

2. Activate Playback.

3. Open the Preferences dialog, from the Edit menu.

4. Make sure the Multitasking friendly option is selected.

5. Locate the Buffer size pop-up.
This allows you to adjust the audio buffer size.

6. Select the smallest buffer size.
This will probably make the sound completely garbled.

7. Select the next larger buffer size.

8. Repeat with the next larger buffer size, until the sound is OK.
You now have the smallest possible buffer setting that works on your system.
- 15 - 
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Introduction
This chapter introduces you to some basic methods and concepts in ReBirth 
338. To get a “hands-on” introduction to the program, read the quick tutorials in
printed documentation.

● All the snapshots in this manual have been taken with the standard version of 
ReBirth RB-338. We recommend that you don’t start using “Mods” until you 
feel comfortable with the location of the various controls on the panel. The 
reason for this is that in a “Mod”, controls may be named differently and will 
certainly not look like in the standard version.

Song Mode vs. Pattern Mode

The Song/Pattern Mode switch.

These are the two major modes in ReBirth RB-338. Basically, Pattern mode i
creating Patterns and experimenting with sounds and other settings. Song m
for stringing Patterns together and recording the automation of controls. Here 
couple of the major differences between the two modes:

• In Pattern mode, the controls are all manual, that is, if you move them they 
stay where you left them. In Song mode, the controls are all automated, 
that is they will move automatically on playback, if movements have been 
recorded.

• In Pattern mode, the Loop feature has no function, the currently selected 
Patterns always loop. In Song mode the Loop is used for repeating any sec-
tion of the Song.
- 17 - 
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Setting Values
Apart from the normal operations, double clicking, dragging, using menus, etc
Birth RB-338 employs some special techniques for changing values:

Knobs

Knobs come in a number of different shapes.

Knobs are always operated in the same way: To change a value, press the m
button over the knob, and drag up/down.

Faders

An example of a fader.

To move a fader, press the mouse button over the handle and drag up/down.

Value displays

A value display.

The value displays have two small arrow buttons located beside them.

• Clicking either of these buttons changes the value one step up/down.

• Keeping the mouse button pressed over an arrow, makes the value 
change continuously.
- 18 - 
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Using the Computer Keyboard
The computer keyboard is used for four purposes:

• For menu shortcuts.
These are listed on page 220.

• For Transport controls (Play, Stop, Rewind etc).
This is mainly done from the numeric key pad. Again see page 222.

• For quick programming of the 303 synthesizers.
To do this, activate “Program Synth from Keyboard” on the Options menu. For 
more information, see page 43.

• Rhythm Tap recording.
See page 32.

• For Pattern switching.
For this to work, “Select Patterns from Keyboard” must be active, on the Op-
tions menu. See page 222 and below for details.

MIDI
MIDI is used for two things in ReBirth RB-338.

• For synchronization to other equipment, see page 112.

• For Remote Control, see page 127.

Real Time Operation
All operations in ReBirth RB-338 can be executed while the program is playin
even saving to disk! There is no need to turn off playback to perform any opera

The Song Window
There’s only one major type of window in ReBirth RB-338 – the Song window
This is a standard Windows/Macintosh window that can be moved and resized
any other. When you make the window smaller than maximum size, a scroll b
lows you to scroll the sections. The Transport bar, however, is always at the to
the window.
- 19 - 
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Pattern Selection

The Pattern selectors.

How to Select a Pattern

Each of the three main sections has 32 Patterns, arranged in 4 Banks of 8 Pa

• To select a Pattern in the current Bank using the mouse, simply click on 
the corresponding Pattern button.

• To select a Pattern from the computer keyboard, make sure “Select Pat-
terns from Keyboard” is activated on the Options menu and press the rel-
evant key, as indicated in the figure below.

• To select a Pattern in another Bank, first select a Bank, using the buttons 
labelled A to D, then select a Pattern.
No change takes place until you actually select a Pattern.

• You can also select Patterns via MIDI, see page 127.

Switching a Section Off

You can turn a section off completely, by deactivating it in the Pattern section. 
is equivalent to selecting a silent Pattern.

A section, activated and deactivated.

ÍZXCVBNM,./

ÊQWERTYUIOP
ÒASDFGHJKL;

11234567890

Synth 1 - Pattern 1 to 8

Synth 2- Pattern 1 to 8

808 Rhythm - Pattern 1 to 8

909 Rhythm - Pattern 1 to 8
- 20 - 
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Pattern Changes take Effect on the Next Downbeat

When you select a new Pattern, the change doesn’t take effect until the end o
Pattern.

This can be used to good effect, especially when switching Patterns from the
puter keyboard; you have time to hit the right key in advance.

Please note that this is true for each individual Pattern, regardless of its length
very short Patterns, it is more important to hit the key or press the mouse butt
the right time.

Using Shuffle
ReBirth RB-338 has a Shuffle (swing) feature. It used to give the music a swin
fect, often used in for example house music. This effect is achieved by delayin
sixteenth notes that fall in between the eight notes. Proceed as follows:

1. In the Pattern section, activate Shuffle for the desired sections.

2. Adjust the amount of Shuffle by using the knob to the left of the tempo 
display.
Somewhere around the “two o’clock” setting you will find a classic “triplet” 
feel.
- 21 - 
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About Focus and the Focus Bar
Many operations may only be performed on one of the three main sections in
Birth RB-338 at a time. To see which section “has the focus”, look for the vert
orange bar, to the right of the Pattern selectors.

In this example, the 808 rhythm section has the focus, as indicated by the orange bar.

The focus can be moved to the relevant section, in one of three ways:

• By clicking with the mouse in the relevant section.

• By selecting a Pattern in a section.
This automatically sets the focus to that section.

• By using the up and down arrow keys on the computer keyboard.
- 22 - 
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The Mixers

A Mixer

Section Mixers

In the Mixer parts of the various sections, you can adjust the relative balance o
ume. You can also adjust things like panning (stereo positioning) and effects.
is all covered in great detail in the chapter “Mixing & Effects” . For now please note
that:

• If a section is too loud or weak, use the volume faders to balance it.
The small meter gives you an indication of the output level from this section.

• If you want to move the sound left/right in the stereo image, use the Pan 
control.

Master Level

The Master Level section.

The master level adjusts the overall audio output from the program. For more
see the next paragraph.
- 23 - 
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About Levels
You have to be slightly careful when adjusting levels so that you don’t get any
wanted distortion on the master output, due to a phenomenon called clipping
the other hand, levels that are too low can lead to an undesired amount of no

● Clipping cannot occur within an individual section, even when it’s volume is 
set to maximum. Any distortion that appears can always be removed by low-
ering the Master level, as described below. 

Here’s our recommended procedure for setting levels:

1. Set up a rough balance between the three sections.

2. Lower or raise the master level so that the signal on the meters only hit 
“the red”, during the loudest passages.

3. If you change your mixer levels, or adjust the sound on the 303 synth sec-
tion, be sure to re-check the master level.

So why is it so important to adjust the levels correctly? Those of you who only h
experience of analog equipment should note that digital levels are completely
ferent in nature. A digital audio system can by definition only represent a limit
range of levels correctly. This is called the dynamic range.

When you try to exceed the dynamic range (when the signal is amplified to a 
the system can’t handle), hard clipping occurs, and the sound will be distorted
very harsh, unpleasant way (if you like this distortion, go ahead and use it, we 
mind. We just want to make sure you don’t run into it unintentionally.)

On the other hand, if the levels are too low the signals may not be represented acc
rately enough and unwanted noise will be audible.

Systems based on personal computers are slightly different compared to ded
digital audio systems, by nature. Maintaining the dynamic range properly is e
more critical in a personal computer system. Therefore, in our efforts to provide
with the best possible sound quality in all situations, we have handed over som
the responsibility to you, the user.

It’s up to you to check and adjust the master level. This method ensures the h
possible sound quality, in all situations.

The level should very rarely 
reach this marking.
- 24 - 
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Introduction
There are two rhythm sections in ReBirth RB-338. The upper is based on the
land TR-808 and the lower on the Roland TR-909. In this chapter we refer to t
as the 808 and 909 sections.

Preparations for Creating a Rhythm Pattern
1. If required, create a New song or Open an existing one.

2. Make sure that Pattern mode is selected.
You can only program Patterns in Pattern mode. See page 17.

3. Set the focus to the rhythm section you want to program.
See page 22 for details.

4. Select a Pattern to program.
How to do this is described on page 20.

5. The Pattern you select can be empty or it can be one already playing 
some rhythm, it doesn’t matter. If it already plays something, you can ei-
ther clear it (see later in this chapter) to start over from scratch, or mod-
ify the existing rhythm as you like.

● Please note that it is often convenient to make copies of the same basic 
rhythm into a few Pattern locations. You can then make minor or major varia-
tions to this rhythm, in each of the Patterns, and use them in various parts of 
the Song. For more info on copying, see page 51.
- 26 - 
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Soloing the Rhythm Section
If you want to make sure that you are only hearing the rhythm section you are w
ing on, while programming, you will want to turn off all other sections:

• Click on the on/off button (in the upper left corner) in the mixer for all 
other sections, to turn them off.

In this example, the synths and the 909 are turned off, so that only the 808 will be heard

Programming and Playback
You can program rhythms, either when the program is in stop mode or when 
playing. It doesn’t really matter which, but the most convenient is probably to h
playback going so that you will hear how the Pattern evolves as it repeats.
- 27 - 
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Selecting Sounds
Before you can start programming any notes, you must of course select a sou
This can be done in several ways:

• On the 808, you can use the large rotary knob to the right.
Drag up/down, as always.

The 808 sound selector knob.

• On both rhythm section you can click directly on the sound name leg-
ends.

The sound selector buttons in the 808 section.

The sound selector buttons in the 909 section.

• Via MIDI, see page 127.

A list of all sounds can be found on page 149.

About “Shared slots” in the 808 section

Some instrument “slots” in the 808 are shared by two sounds. One example is
Tom (LT) and Low Conga (LC). You select between shared instruments as the
tration below indicates:

More about shared instruments on page 34.

First click in either of these two places
...then click on the switch.
- 28 - 
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Adding and Removing Notes

808 Section – Clicking to Add or Remove notes

To add notes with the selected sound, proceed as follows:

• Click on the colored step buttons, to add a note with the selected sound.
The step buttons that are lit up indicate programmed notes.

The sixteen step buttons represent sixteenth notes in a measure. If you for ex
add notes at step 1 and step 9, you will get sounds at the downbeat and on th
quarter.

Here, a bass drum is programmed on step 1 and 9 in the 808 section.

• You can remove notes in the same way, by clicking on steps that are al-
ready lit up.

808 Section – Dragging to add or Remove Notes

You can also drag to add/remove a number of notes at the same time. Wheth
drag operation adds or removes notes depends on the step where you start dra
If this is empty, you will be adding, if it already plays a note, you will be remov

If for example you want to add a sound at all sixteenth notes in a Pattern, pro
as follows:

1. Locate a step where there is no note (not lit up).

2. Position the pointer over this step, and press the mouse button.

3. Drag back and forth over the steps, without releasing the mouse button.

4. When all step buttons are lit up, release the mouse button.

Dragging to add notes on all sixteenths.
- 29 - 
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909 Section – Clicking to Add or Remove notes

This is very much like the 808, but each sound can play with one or two levels

• Click once on a “dark” (as opposed to light) step buttons, to add a note 
with low level.
The step button displays a light color.

• Click again on the same button to switch to a note with high level.
The step button displays a brighter color.

• Click a third time to turn off the step.
The button goes dark again.

909 – Flam Programming

The 909 section features flam programming, that is, a double hit with a short 
interval in between, like when a drummer hits a drum with both sticks, but not
actly at the same time. To program flams with the selected instrument, procee
follows:

1. Activate the Flam button.

2. Click once on a step to make it play a flam hit. Click again to turn that 
step off.

Flam activated and a few flam hits programmed.

3. Adjust the “width” of the flam (the time between the two hits), using the 
Flam knob.
This setting is global for all hits.

4. When you are done with Flam programming, deactivate the Flam button.
- 30 - 
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909 – Quick Programming using Modifier Keys

You can use modifier keys to quickly access the step programming functions a
This allows you to specify the type of hit for a step regardless of what type of h
played before. It also means you don’t have to use the Flam button for progra
ming flams.

• To program a step with low volume, hold down [Command] (Mac)/[Ctrl] 
(Windows) and click once.
To turn the step off, click again.

• To program a step with high volume, hold down [Option] (Mac)/[Alt] 
(Windows) and click once.
To turn the step off, click again.

• To program a flam hit, hold down [Command]+[Option] (Mac)/
[Ctrl]+[Alt] (Windows) and click once.
To turn the step off, click again.
- 31 - 
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Tap Recording
The computer keyboard can be used for programming any and all rhythm sou
by “tapping” the correct keys.

The key row starting with A is used for accessing the drum sounds, starting w
BD, Bass Drum. The accent is reached from the minus key in the top row.

808 Section

909 Section

● All key mapping is based on an American keyboard layout!
On the Macintosh, the keys are always in the positions indicated in the pic-
ture above, but the labels on the keys may be different in your country.
Under Windows, you may need to press other keys, depending on the key-
board layout in your country.

Performing the Tap Recording

To use Tap Recording, proceed as follows:

1. Make sure you are in Pattern mode.

2. Create a simple beat as a metronome, so that you know where in the beat 
you are.

3. Make sure “Program Synth from Keyboard” is activated on the Options 
menu.

ÍZXCVBNM,./Í
ÒASDFGHJKL;'\

-
SDBD CP CY OH CHCBRSHTMTLT

MACLHCMCLC

AC

ÍZXCVBNM,./Í
ÒASDFGHJKL;'\

-
SDBD CP OH CC RCCHRSHTMTLT

AC
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4. Activate playback.

5. Make sure the desired rhythm section has the focus.
See page 22 for more info on focus.

6. Hit the relevant key at the time you want the drum played.
Getting the rhythm right might take a little bit of practice, since a computer 
keyboard wasn’t really designed for playing drums.

7. Keep playback going and add as many notes as you like.

● Please be aware that the latency phenomenon (see page 182) applies to tap 
recording as well. If your system has a large latency, you will need to hit the 
keys slightly in advance.

Deleting notes via the Computer Keyboard
You can also delete notes from the computer keyboard:

1. Select the drum instrument you want to delete.

2. With playback activated, press and hold the [Shift] key, when the notes 
you want to delete are playing.
Notes get deleted for as long as you keep the [Shift] key pressed.
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Working with Shared Instruments on the 808 section
There are 16 sounds to select from in the 808 section, plus the Accent (see page 35). 
However, there are only 11 sound slots (not counting the Accent), that is, you can
only have up to 11 sounds playing at any time (techniques for extending the nu
of sounds used in a Song can be found on page 34).

An example of a “shared instrument” is Low Tom (LT) and Low Conga (LC). Y
can only have either Low Tom or Low Conga in one Pattern.

Selecting “Shared” Sounds

To select one of the two sounds in a shared “slot”, proceed as follows:

1. Select the basic sound in the pair, using the rotary knob.

2. Flick the switch on the panel that selects between the two sounds in a 
shared slot.

You can flip the shared instruments switches at any time, even after program-
ming a sound. The Pattern will then play back with the newly selected sound, 
rather than the other.

Using Song Mode to play two Shared Instruments in one Song

● If you are not familiar with Song mode, the text below might not make sense 
to you. Please get back to this section once you have acquainted yourself with 
Song automation.

The settings of the shared instrument switches are part of the Song automatio
most other controls on the panel. This means that a Pattern programmed with 
might be played back with Congas, if that is the way the switches are set in the Song. 
While this might be confusing at first, it can also be used to good effect. You 
program sound changes as part of your song automation, and therefore have
(for example) Toms and Congas in one Song. See page 72 for more information.

These switches selects 
between two sounds in a 
pair.
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Working with Accents
The sound to the far left on both rhythm panels is labelled AC, for accent. Thi
not a drum sound as such, but rather a way to control the dynamics for a Pat
Steps where an Accent is programmed will be louder than other steps. The eff
global for all sounds, that is, they will all be louder by the same amount.

1. Select the Accent Instrument.

2. Add an Accent to steps you want to be louder.

3. Adjust the Accent volume knob, to set the difference in volume between 
accented and un-accented steps.

Accent is most often used for adding “life” to a rhythm part. To check out the e
fect, try this example:

1. Program a simple Pattern that plays a closed hi-hat on all sixteenth notes.

2. Add accents to every other step, that is step 1, 3, 5, 7 etc.

3. Adjust the Accent level.

About Open and Closed Hi-hat
Open hi-hat (OH) and closed hi-hat (CH) are mutually exclusive in each of the
rhythm sections. That is, only one of them can sound at a time. Here are the 

• If you program an open hi-hat on one step, and a closed on the next, the 
closed hi-hat will cut off the sound of the open hi-hat.

• on the 808, if you program open and closed hi-hat on the same step, you 
will get a very short open hi-hat sound, that sounds very much like a 
closed hi-hat.

• on the 909, if you program open and closed hi-hat on the same step, you 
will hear the open hi-hat sound.
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Clearing the Pattern
If you wish to clear the Pattern, proceed as follows:

1. Move the focus bar to the desired rhythm section, either by clicking be-
tween the Pattern selector and the actual “drum machine”, or by using 
the up/down keys on the computer keyboard.
Either way, you want the orange indicator to be in the rhythm section you plan 
to clear.

Focus set to the 808 rhythm section.

2. Select Clear from the Edit menu.
The Pattern is cleared.

Working with Various Pattern Lengths
By default all Patterns are one bar long, that is they are made up of sixteen sixt
note steps. However, you can shorten a Pattern to any number of sixteenth n
between 1 and 16. This allows you to program rhythms in unusual time signa

• To set the Pattern length, use the Length indicator arrow buttons.

The Pattern Length setting.

This operation can be performed at any time, whether the Pattern is empty or
and both in playback and stop mode. The change takes effect immediately.
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Sound Parameters

The 808 section sound parameters.

The 909 section sound parameters.

Each individual sound has one or more parameters for adjustment of sound c
ter and level. Every sound has a level control and many sounds have addition
rameters. Below follows a summary of the available parameters:

Level
This is simply the volume for the sound.

Tune
This is the pitch of the sound, the tuning. For the snare, please note that this 
affects the “body” of the sound, not the “rattle”.

Tone
On the 808 snare, this is a pitch control for the body of the sound.

On the 909 snare, this is a decay control for the “rattle”. The higher the settin
longer the sound.

Dec(ay)
This adjusts the length of the sound.

Snap(py)
This is only available for the snares. It adjusts the balance between the “body
the sound and the “rattle”.

Att(ack)

Adjusts the “click” in the beginning of the 909 bass drum.
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Preparations
1. If required, create a New song or Open an existing one.

2. Make sure Pattern mode is selected.
This is done using the Song/Pattern switch on the Transport panel. You can 
only program Patterns in Pattern mode.

3. Select a Pattern to program.
How to do this is described on page 20. 

The Pattern you select can be an empty one or one already playing somethin
doesn’t matter. If it is filled with notes you can either clear it to start over from
scratch, or modify the existing Pattern as you like.

Soloing a Synth Section
If you want to make sure that you are only hearing one of the synths while prog
ming, you will want to turn off all other sections:

• Click the on/off button in the mixer for the rhythm sections and the other 
synth, to turn them off.

In this example you will only hear the upper synth.
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Programming and Playback
You can program synth Patterns, whether the program is in stop mode or playi
doesn’t really matter which, but the most convenient is probably to have playb
going so that you will hear the notes you have programmed so far as the Patt
peats.

Clearing the Pattern
In a new default Song document, all Patterns are already programmed. You m
want to clear the Pattern before you start, using Clear on the Edit menu. For 
info, see page 46.

Basic Procedures
Basically, creating a Pattern is a question of selecting each of the sixteenth n
steps, and making settings for each one. These settings determine whether e
the steps plays a note or a pause, what the pitch should be etc.

Here’s a step by step instruction for the basic method of making a Pattern:

1. Make sure you are not in Pitch mode. If the Pitch mode light is lit, click 
on it to turn it off.
See page 42 for more information on Pitch mode.

Pitch mode deactivated.

2. Use the Step and Back buttons to move to the step you want to make 
changes for.
The step counter shows you where in the Pattern “you are”.

The step counter.

● If you want to move to step one, there’s a shortcut: Click on the Pitch mode 
button twice.
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3. Adjust the settings for each step, as desired.
Below follows a quick description of the possibilities, details about each one 
follows later in this chapter.

4. Use the Step button to move to the next step, and make settings for this.
If you are already at the last step, this button takes you to the first step in the 
Pattern.

5. If required, use the Back button to step back through the steps and adjust 
the settings as needed.
If you’re at the first step, this button takes you to the last step.

6. Repeat steps 2 to 5 above for the remaining steps until the Pattern plays 
as desired.

This determines whether the 
current step plays or not.

Determines whether this step should be 
played with an accent (louder and with a 
different character).

The pitch for the step.

These allow you to trans-
pose the note up or down.

Decides if the 
pitch of this step 
should slide over 
to the pitch of the 
next step.
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Using Pitch Mode
When Pitch mode is activated, the programming procedure is slightly differen
this mode, as soon as you select a pitch on the keyboard, the program automa
advances to the next step. This can be used for two things, for programming 
tern quickly from scratch, and for altering the pitches in an existing Pattern.

Programming a Pattern from Scratch in Pitch Mode

1. Set up an empty Pattern and make sure you are at the first step.
Check the step counter if you are unsure.

2. Activate Pitch mode.

Pitch mode activated.

3. For the first step, set the note/pause, octave, accent and slide switches as 
desired.

4. Select a pitch for the step by clicking the keyboard, and the program au-
tomatically advances to the next step.
Note that selecting the pitch should be the last thing you do, since the pro-
gram then advances to the next step.

5. Repeat steps 3 to 4 until the Pattern is finished.

Changing the Pitches in an Existing Pattern

Pitch Mode is extremely useful if you have a Pattern with the correct rhythmic
phrasing etc, but want to use it in different places in the song, with other pitches
example to fit different chord progressions).

1. Select the Pattern and make sure you are at the desired step, probably the 
first.

2. Activate Pitch mode.

3. Select a new pitch for the step by clicking the keyboard, and the program 
automatically advances to the next step.

4. Repeat until the Pattern is finished.

If you have a step where the pitch is already correct, you can instead just clic
Step button to advance to the next step.
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Using the Keyboard for Creating and Editing Patterns
There are computer keyboard equivalents for all the step settings. On the nex
there is a diagram of these. We strongly recommend you to take some time t
acquainted with using the keyboard, it is a much faster way of programming P
terns than using the mouse, once you get used to it.

Switching Keyboard Input to Synth programming

On the Options menu, you will find a switch for what the keyboard is used for.
use the keyboard for synth Pattern editing, set it to “Program Synth from Key-
board”.

Setting the focus to the correct section

Since there are two synthesizer sections, you must also make sure that your 
board input is routed to the correct one. This is done by moving the focus bar to
section (see page 22). This is done by clicking in the relevant section or by using t
cursor up/down keys.

In this example, the focus is set to a synth section.

The keys used for editing synth Patterns. The illustration shows a US keyboard. Note that the keys are on 
the positions indicated, regardless of which letters are printed on the keys in your particular country.

CVBNM,./Í

4567890-=ı
RTYUIOP[]
DFGHJKL;'\

Back

Step

Note/Pause

Accent
Slide

Octave Up
Octave DownPitch keys
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Tapping the Rhythm

Tapping can be used for defining a rhythm for a synth pattern. The way this w
is that when you tap, that step is set to Note (as opposed to Pause) regardles
previous state. That is, tapping only adds notes, it never deletes them.

1. Set up a Rhythm Pattern so that you have something to go by.

2. If you like, clear the synth Pattern before you start tapping.

3. Make sure “Program Synth from Keyboard” is activated on the Options 
menu.

4. Activate playback.

5. Make sure the desired synth section has the focus.
See page 22 for more info on focus.

6. Hit the [Tab] key at the time you want to add a note.
It will play back on the next lap, at whatever pitch as programmed for that 
step.

7. Keep playback going and add as many notes as you like.

● Please be aware that the latency phenomenon (see page 182) applies to tap 
recording as well. If your system has a large latency, you will need to hit the 
keys slightly in advance.

Deleting Notes

You can also delete notes using the computer keyboard. Technically this mea
switching the steps from Note to Pause mode.

• With playback activated, press and hold the [Shift] key, when the notes 
you want to “delete” are playing.
Notes get switched to Pause mode for as long as you keep the [Shift] key 
pressed.
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Working with Octave settings
The Octave settings transpose a step one octave up/down. This gives you a to
tave range of three octaves, from the lowest C transposed down to the highe
transposed up (not counting the tuning parameter, see page 48).

● You can activate both octave switches at the same time, but this is the same as 
having no transposition at all.

Working with Accents
When Accent is activated for a step, the step will be louder, different in sound 
acter and the note will be shorter. Exactly how different it will be is determined
the Accent knob setting.

If the Accent knob is all the way down, notes with Accent will only be shorter.

Working with Slide
When Slide is activated for a step, the note will be tied to the next and the pitch
continuously “glide” to the pitch of the following step.

● Please note that Slide should be activated on the note you slide from, and not 
the note you slide to.

There are a few special cases you should be aware of:

Sliding from a Pause

If a step is set to pause it won’t sound. However, if Slide is activated for that s
step, the next note will still slide in to the right pitch. The slide will start at the pitch 
set for the silent step and end at the pitch of the next step.

Several Sliding Notes after each other

If you have several sliding notes, one after the other, they will all be tied togeth
one long legato phrase. This can be used to good effect to create “wavy” or p
bend effects.

The Accent button activates 
Accent for the current step...

...while the Accent knob sets the 
amount for all “accented” steps.
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Sliding to Notes with the same Pitch – Long Notes

If two or more notes are tied together with the slide feature, but they all have 
same pitch, the result will be one long note. This is how to create longer note
(eighth notes, quarter notes etc).

Sliding and Accents

Among other things, the accent affects the envelope – the device that shapes
sound over time. However, if a note is sliding from previous notes, and you ad
cent for one ore more steps, the exact effect of the Accent depends on a num
parameters. Sometimes the Accent has less effect on sliding notes. Experime
get the hang of it!

Clearing the Pattern
If you wish to clear the Pattern, proceed as follows:

1. Move the focus bar to the desired synth section, either by clicking be-
tween the Pattern selector on the actual ‘synth panel’, or by using the up 
and down keys on the computer keyboard.
Either way, you want the orange indicator to be in the synth section you want 
to clear.

2. Select Clear from the Edit menu.
The Pattern is cleared.

Working with Various Pattern Lengths
By default all Patterns are one bar long, that is they are made up of sixteen sixt
note steps. However, you can shorten a Pattern to any number of sixteenth n
between 1 and 16. This allows you to program rhythms in different time signat

• To set the Pattern length, use the Length indicator arrow buttons.

The Pattern Length setting.

This operation can be performed whether the Pattern is empty or not, and bo
playback and stop mode. The change takes effect immediately.
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The Synth sound controls.

Waveform
This allows you to select between two waveforms for the synth oscillator:

Tune
This sets the tuning of this synth section. The range is ±1 octaves in steps of 
tones. This control can be used for matching the pitch of Patterns programme
different keys, for real time transposition and for effects.

● Please note that there is also a Transpose function (on the Edit menu), that al-
lows you to alter all notes in a Pattern (in steps of semi-tones) to fit a particular 
key.

Cutoff
This is the overall filter setting for the sound. The higher the setting, the ‘brigh
the sound. This setting interacts with Envelope Modulation as described in mo
tail under the Envelope Modulation heading later in this chapter.

Resonance
This is another control for the overall character of the sound. Technically it ro
the sound at the output of the filter back to the input, in a feedback loop. Sound
it gives the sound a more hollow, pronounced character. Together with envel
modulation, slide and accent (see page 59), it is largely responsible for the 303 
sound character. To try this out, turn the resonance all the way up, and twist th
off and Envelope Modulation knobs.

Symbol: Name: Description:

Sawtooth This is a full and rich waveform where all harmonics are in-
cluded.

Square This waveform only contains odd harmonics, which gives 
the sound a more “hollow” quality.
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Env. Mod. (Envelope Modulation)
This adjusts the way the envelope affects the cutoff frequency. Let’s describe
in more detail:

As described above, the cutoff setting is a basic tonal setting for the filter. In a
tion to this there is the envelope, which makes the cutoff frequency vary as the no
decays. This is the way many “real” instruments work, as the sound decays it
gets less bright. The envelope simulates this by making the cutoff frequency co
uously lower as the sound decays. How fast this decay actually occurs is set 
the Decay knob, see below.

• In its lowest position, the envelope has little effect on the sound.

• At higher values, the envelope makes the filter open further, that is the 
sound will be brighter.

Decay
This adjusts the length of the envelope, to make notes decay faster or slower

Accent
This knob is used for setting to what extent the steps with Accent activated sh
be different from the other steps. The setting does not only affect volume, but
the shape and character of the sound.
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● To have access to the functions described in this chapter, you must be in Pat-
tern mode, not in Song mode!

Cut, Copy and Paste (Pattern)
These functions allow you to move and copy Patterns between Pattern locati
You can cut, copy and paste within one Song document, or between two Son
uments. Proceed as follows:

1. Set the focus to the section you want to cut or copy from.
See page 22 for details about the focus.

2. Select the Pattern you want to cut or copy.

3. If you want to move the Pattern to a new location, select Cut from the 
Edit menu. If you want to make a copy of it, instead select Copy.

4. If you want to paste into another Song, click on its window, so that it be-
comes active.

5. Move the focus to the section where you want to paste the Pattern you 
just cut/copied.
If you want to Paste it in the same section, this step is not required.

6. Select the Pattern location where you want to paste.

● Note that when you select Paste, the Pattern that was currently in this location, 
will be overwritten and can not be retrieved.

7. Select Paste from the Edit menu.
The Pattern you cut or copied is pasted in at the selected Pattern location.

● You can not paste Synth Patterns into the Rhythm Section and vice versa.
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Pattern Functions
There are a number of menu functions that allow you to perform various type
editing to your Patterns.

Selecting the Pattern to be Affected

All of the functions described below always operate on one Pattern in one sec
Before you use the function you must make sure the right Pattern will be affe

Please proceed as follows:

1. Set the focus to the correct section.
See page 22 for details about the focus.

2. Select the Pattern you want to be affected.

3. Select the function from the Edit menu.

About Multiple Menu items

Some functions appear more than once, depending on the various options. W
items are available (not dimmed) might also vary with the focus. If a rhythm s
tion has the focus, other options are available than if a synth section has a fo
Let’s take Shift as an example of this:

• If a synth has the focus, there will be two active Shift items: Shift Pattern 
Left and Shift Pattern Right.

• If the rhythm section has the focus there will be four active Shift items: 
Shift Pattern Left, Shift Pattern Right, Shift Drum Left and Shift Drum Right.

Clear

To clear a Pattern completely, use this function.

• For the rhythm sections, this will deactivate all steps for all instruments.

• For the synth sections, this will set all steps to pause (as opposed to 
note), no accent, to the pitch C, no slide, and no octave transposition.
In both cases, this means the Pattern will be silent after the operation.
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Shift Pattern/Drum Left/Right

This function moves the notes in your Patterns “left” or “right”. It either acts on 
whole Pattern (Shift Pattern Left/Right), or – for rhythm Patterns – it can be u
for shifting the selected drum instrument only (Shift Drum Left/Right).

If you for example use Shift Pattern Right on a synth Pattern, notes that were
step 1 will be moved to step 2, notes that were on step 2 will be on step 3, and 
up to the notes on the last step which will be moved to the first.

This function can be used for interesting rhythmic effects. It can sometimes als
used as a rescue. If, for example, you have created a great synth Pattern but 
that the downbeat as you hear it, is not on the fist step, use this function to re
the situation. To move the Pattern several steps, simply use the function repe

● This function does not take Pattern length into consideration. It always oper-
ates on all 16 steps.

Random Pattern/Pitches/Accents etc./Drum

These functions can be used for creating a completely new Pattern, or to only
omize certain aspects of it.

Use this is as a way to generate music automatically, or as an inspirational too
terns that are generated in this way can be edited as any other, so if you don’t
the result is exactly what you need you can change it in whatever way you req

Option Description

Random Pattern Creates a complete Pattern with random pitches, accents, 
slides etc.

Random Pitches Randomizes the pitches of the Pattern without changing 
anything else.

Random Accents etc. Randomizes the Note/Pause, Accent, Slide and Octave set-
tings for the steps.

Random Drum Randomizes the programming for the selected rhythm in-
strument.
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Alter Pattern/Pitches/Accents etc./Drum

This alters existing synth and rhythm Patterns, by randomly shuffling the data 
existing Pattern. Note that there must be some material to alter for this functio
work. In other words, applying it to an empty Pattern will leave you with an em
Pattern.

If you want to create a pseudo-randomized Pattern that stays within certain mu
boundaries, try the following:

1. Activate Pitch Mode in a synth section.

2. Play the notes you want included in the Pattern, in no particular order.

3. Deactivate Pitch Mode.

4. Select Alter Pattern or Alter Pitches.

● This function does not take Pattern length into consideration. It always oper-
ates on all 16 steps.

Transpose

This function allows you to change the pitch of the notes so that the Pattern fi
other key. The dialog box that appears allows you to specify the number of st
you want to transpose up/down (±12 semitones).

The transpose dialog (Macintosh version).

● Please note that there’s a limitation to how much you can transpose notes. If 
they already have very high pitches, they might be moved one octave in either 
direction, so that they “appear” within the valid range of pitches.

Option Description

Alter Pattern Alters all aspects of the Pattern.

Alter Pitches Alters the pitches.

Alter Accents etc. Alters the Note/Pause, Accent, Slide and Octave settings.

Alter Drum Alters the rhythm of the selected instrument.
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Introduction
This chapter describes how to use the various features for creating a final mix 
sounds: levels (volumes), panning and effects.

The effects in ReBirth RB-338 consist of a compressor, a distortion unit, a delay
the PCF (Pattern Controlled Filter). These work just like their physical counterp
you connect them in the signal chain and make settings for intensity and other
acters of the effect.

Setting Levels

Section Levels

Each of the sections has a level control, the slider. This is used for adjusting th
ance of this section against the others. Here are some guidelines for setting l

• Don’t worry about cranking a section all the way up. Any distortion (clip-
ping) that occurs can always be removed with the Master Level control, 
see page 24.

• To get the lowest amount of noise, keep the levels up as much as possible 
at all times. For example, set the loudest section to play at full level and 
adjust the other levels downwards to this, to get the right balance.

Master Level and Meter

The Master level and meter.

This is used for adjusting the overall level from ReBirth RB-338. It is also used
compensating for any clipping that occurs on the output, due to loud levels from
three sections and the effects. Again, see page 24.

The Comp switch in the Master section is described on page 67.

● The Master level setting is not part of the Song automation!

The section levels are 
located in the Mixers.
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Muting

In each mixer there’s an on/off setting, a mute function. This is used for tempor
silencing the audio from a section.

● This setting is not part of the Song automation. To incorporate silent parts in 
the Song, use the Pattern on/off switches instead, see page 72.

Using Pan

Panning allows you to position a section anywhere in the stereo image. There
several uses for this:

• To increase separation between the sections, by giving them different 
stereo positions.

• To create interesting effects by panning a section one way and adding a 
delay to it, panned the other way.

• To pan sections fully hard/left to use the stereo output as two separate out-
puts. You can then get total separation of sections when recording to other 
media or using external effects.

• Using the Song automation you can create sounds that move “automati-
cally” across the stereo image.

A Mixer...
...muted...
...unmuted.

The Pan controls 
are located in the 
Mixers
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Effect Routing
• There are three insert effects: Dist, PCF and Compressor. These are con-

nected in series. That is, if you apply all three to one section, the sound 
will first pass through the Dist, then through the PCF, and last through the 
Compressor.

• There is one send effect, Delay. By using the Delay amount controls in 
each Mixer section, Delay can be applied to all sections, by varying 
amounts.
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Dist (Distortion)

The Distortion section.

Distortion makes the sound dirtier and grungier, like when you turn up the vol
on a guitar amplifier. The distortion in ReBirth RB-338 is an insert effect. This
means it will be inserted into the signal, just after the output of one of the sect
There are actually four distortion units in the program. This means that all sec
can use the distortion. However, there’s only one set of controls that applies t
sections.

Trying out the Distortion

1. Activate playback, in Pattern mode.

2. Make sure only one of the synthesizers sound, by using the Mute buttons 
in the mixers.

3. Active the Dist in that synth’s mixer, by clicking the switch so that it 
lights up.

4. Activate the Distortion, by clicking the on/off button in the Dist section.

5. Raise the Amount switch in the Dist section to about one o’clock.

6. Check the sound with and without distortion by clicking the on/off but-
ton in the Dist section. Also check the Distortion controls, Amount and 
Shape, and how they affect sound at various cutoff and resonance set-
tings.

Distortion 
on/off

Distortion 
ShapeDistortion 

Amount
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Routing

To decide which sections will use the distortion, you use the Dist switches.

• As many sections as you like can have Dist activated.

• You can turn Dist off for all sections, should you wish.

Activating/Deactivating

Once you have decided which section will use the Dist effect, you need to act
the effect itself. This is done in the Dist section by clicking the on/off button.

• When this is on, one of the sections will pass through the Distortion ef-
fect.

• When this is deactivated, no sound will pass through the distortion effect 
(bypass).

The Amount and Shape Settings

There are two settings for the distortion:

Amount

The higher this setting, the dirtier the sound.

Shape

This controls the character of the distortion, the higher the value, the “grungier
sound.

These sections have
Distortion activated.
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The PCF (Pattern Controlled Filter)

Introduction

The PCF is an extremely versatile synth effect. It allows you to change the so
from any of the sections in ReBirth RB-338, in a number of ways.

The PCF is an insert effect that can be applied on the output of one of the sec
There is only one PCF. This means that only one section at a time can use it.

Basically, the PCF is a filter with an envelope, just like there are filters with en
lopes in the synth sections. You route the output of one of the sections throug
PCF and thereby shape the tonal character of the sound.

The main difference between the PCF and the synth filters is that this filter is 
tern controlled”. There are a large number of preset patterns that allow the filt
“superimpose” pumping effects, slow sweeps and rhythmic phrasing onto the
sound. But before we go into the technical details, let us give you an example
how the PCF can be used. 

Trying out the PCF

1. Make sure you are in Pattern mode.

2. Create a simple rhythm Pattern to use as a guide.

3. Create a synth Pattern that only plays one long droning note.
One way to do this is as follows: Clear a Pattern, step through it, activating 
Slide for each step, and switch each step from Pause to Note.

4. Mute the other synth and rhythm sections.

5. Turn off Delay and Distortion.

6. Play back to make sure you hear the long note with a basic sound (set 
Cutoff at two o’clock). Leave playback on.

7. In the Mixer section of the synth you are listening to, click on the PCF 
button, so that it lights up.

8. Activate the PCF by clicking in its upper left corner, so that the LED lights 
up.

9. In the PCF, select Pattern “5” and set the filter type switch to BP. Then set 
up the faders approximately as in the picture below.
- 61 - 



s is 

han 

.

You will now hear a repeating effect occurring on quarter notes. What happen
that the filter envelope is being retriggered on quarter notes.

10.Step through PCF Patterns 0 to 11 and listen to the various rhythmic fig-
ures.

11.Before you test Pattern 12 to 21, raise the Decay and Q settings as the 
picture below indicates.

You will hear that Pattern 12 to 21 more or less imitate filter “sweeps”, rather t
repeat effects.

12.Set the controls back as they were before, and test Patterns 22 to 33.
These Patterns are more complex, they contain various rhythmic figures in-
cluding dynamic changes and various time signatures.

13.Finally, test the Patterns between 33 and above.
34 to 45 are all triggering on 32nd notes, rather than on sixteenth notes. The 
ones above this are mixed variations.

14.Experiment with various settings and apply the PCF to other Patterns 
than the one you have now.

15.Mute the synth you are hearing.

16.In the Rhythm section Mixer, click on the PCF button, so that it lights up.
You will note that the LED goes out for the synth, since only one section at a 
time can use the PCF.

17.Experiment with various settings in the PCF section.
You will notice that it is quite simple to create really interesting electronic 
sounding drum sounds.

To find out more about the various controls and the technical details, read on
- 62 - 
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How the PCF Works - Background Information

The PCF is built from two major components:

1. The Filter

This is a 12dB/octave (2-pole) design that can be switched between lowpass 
bandpass operation and has cutoff and resonance controls.

2. An Envelope with Patterns

This is a simple Attack/Decay envelope. The Decay time can be set on the PC
panel. The Attack is controlled via the Patterns, as described below. By using
AMT (Amount) control on the PCF panel, you can set to what extent the enve
affects the filter.

Block diagram of the PCF.

Envelope section

Q

Decay

Pattern

Filter section

ModeLP BP

Amt Freq
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About the Patterns

There are a large number of preset patterns that provide various rhythmic effe
They do this by controlling the following envelope parameters:

• Retriggering
This is the most basic type of control. In Pattern 0 for example the envelope is 
retriggered (restarted) at each whole note, in pattern 1 on each half note etc.

• Dynamic and Attack control.
In many of the Patterns, the envelope is triggered with different dynamics on 
different “beats”. Some “beats” also have a different attack.

The Patterns are preset, they can not be changed. Their length vary, most are
two bars, but some have been created in odd time signatures (a full list can be
on page 204 and onwards).

Routing

To decide which section will use the Pattern Controlled Filter, you use the PC
switches in the Mixers.

• The PCF comes after the Distortion, in the signal chain.
That is, if you activate both distortion and PCF for a section, it passes through 
the distortion first and then the PCF.

• Only one section at a time can have PCF activated.

• You can of course turn the PCF off for all sections.

Activating/Deactivating

Once you have decided which section will use the PCF effect, you need to ac
the effect itself. This is done in the PCF section by clicking the on/off button.

• When this is on, one of the sections will pass through the Pattern Con-
trolled Filter.

• When this is deactivated, no sound will pass through the Pattern Control-
led Filter (bypass).

This section has
PCF activated.
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The PCF Settings

Pattern

The patterns are roughly divided into the following categories:

See page 204 for diagrams of the various patterns.

Mode (BP/LP)

This switches the filter between its two major modes, lowpass and bandpass.

• The lowpass filter (LP) is similar to the one used in the synth sections in 
ReBirth. It lets all harmonics below a certain frequency (the cutoff fre-
quency) pass through.

• The bandpass filter (BP) only lets frequencies within a certain band (a 
range of frequencies) pass through.

Freq (Frequency)

This is the main frequency range the filter should operate in.

The Freq parameter is related to the Amount (Amt) parameter:

• If the Amount slider is set to zero, there will be no pattern effect at all. The 
filter can then be used as a fixed “tone control” by adjusting the Freq and 
Q parameters.

• If the Freq slider is all the way up, the Amt slider has no effect since the fil-
ter is already fully open.

Pattern 
number

Description

0 to 5 Even rhythms, no dynamics. 

6 to 11 Simple rhythms, no dynamics. 

12 to 17 Simple sweeps, slow dynamics. Try these with long decay 
times! 

18 to 21 Complex sweeps (more or less random). 

22 to 33 Complex rhythms with dynamics and varying attacks. 

34 to 45 32nd note patterns.

46 and up Mixed variations.
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Q

This is the same as the “Reso” control in the synth sections. Technically it rou
the sound at the output of the filter back to the input, in a feedback loop. Sound
it gives the sound a more hollow, pronounced character.

● Be careful when combining large Q values in the PCF with large Reso values 
in a synth, since this might lead to overloading the output of the PCF, causing 
distortion.

Amt (Amount)

This control determines the amount of effect the envelope has on the filter. Fo
Pattern effect at all, this must be set to some value above zero.

Dec

This adjusts the length of the envelope decay. This has a significant effect on
“feel” of the Pattern.

• At low values there will be a clear pumping effect.

• When the Decay is raised, the pattern effect will be “smeared”. This can 
be used to good effect with Patterns 12 to 17 for smooth “LFO” effects.

• At very high values, the envelope will not be given a chance to decay very 
much until it is retriggered, giving a “stepping” effect (similar to the old 
synth effect “sample and hold”). This is most noticeable on patterns with 
dynamics (12 and above).

The picture below shows the same Pattern with three different envelope settin

1 2 3 4 5 6 7 8
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Compressor

The Compressor section.

A compressor evens out levels to make the sound “tighter”. At high settings it
introduce a “pumping” effect. The compressor in ReBirth RB-338 is an insert ef
that can be applied on the output of one of the sections or on the master out. 
is only one Compressor. This means that only one section or the master output can
use the compressor.

Trying out the Compressor

1. Activate playback, in Pattern mode.

2. In the 909 section, set up a busy drum pattern with a prominent bass 
drum.

3. Active the compressor in that section’s mixer, by clicking the Comp 
switch so that it lights up.

4. Activate the Compressor, by clicking the on/off button in the Comp sec-
tion.

5. Set the Ratio button at it’s lowest position.

6. Set the Threshold knob somewhere between “nine o’clock” and “twelve 
o’clock”.

7. Raise the Ratio button continuously.
You will note how the level difference between the sounds is evened out. 
Some sounds will also get a more prominent attack. You might also note an 
overall reduction in level, but this can be compensated for, by using the Level 
fader.

Compression 
on/off

Compression 
Threshold

Level reduction 
meter

Compression 
ratio
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Routing

To decide which section will use the compressor, you use the Comp switches f
in the section mixers and in the Master section.

• Only one section at a time can have the Compressor activated. This is a 
mono compressor that only affects that section.

• Alternatively you can activate the Compressor for the Master section. 
This invokes a stereo compressor which acts on the entire mix.

• You can turn compression off for all sections, should you wish.

Activating/Deactivating

Once you have decided which section will use the Compressor, you need to ac
the effect itself. This is done in the Comp section by clicking the on/off button

• When this is on, one of the sections or the entire mix will pass through 
the Compressor effect.

• When this is deactivated, no sound will pass through the compressor (by-
pass).

The Settings and Display

Threshold

This a setting for which signals should be affected. As the name implies, only le
above the one you specify here (the Threshold) will be affected. Levels below
value will pass through unprocessed.

Ratio

This is the amount of level reduction, that is, the resulting reduction in level di
ence. The higher the setting, the more drastic the effect.

Level Reduction meter

This display shows you how much the level of the signal is reduced at any giv
time. The “0” setting (in the middle) means no change, whereas an indication t
left implies a level reduction.

This section has
the Compressor activated.
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The Delay section.

Delay adds echoes, or repeats, to the sound. The Delay effect in ReBirth RB-3
a send effect, which means is can be utilized by all the sections, by variable 
amounts. In addition, the Delay appears after the other effects in the signal ch

Trying out the Delay

1. Make sure only one of the synthesizers sound, by using the Mute buttons 
in the mixer.

2. Select a pretty simple synthesizer Pattern and activate playback, in Pat-
tern mode.

3. Raise the Delay setting in that synth’s mixer, to about two o’clock.

4. Activate the Delay, by clicking the on/off button in the Delay section.

5. Set the delay controls as the picture below indicates:
This will give you a basic delay with a length of three sixteenth notes with ap-
proximately three repeats.

Delay example.

Delay on/off

Feedback (number
of repeats)

Delay Length (sixteenths 
or eighth note triplets)

The panning of the 
output from the delay

Sixteenth note/eighth 
note triplet switch
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The Delay Amount Setting

The Delay knob in each section is used for determining how much of the signal
this section that should be “fed” into the delay unit.

• If you set this all the way down, no delay will be added to this section.

• If you raise it all the way up, the first repeat from the delay will have the 
same level as the original signal.

Activating/Deactivating

In addition to setting the Delay level for each section, you need to activate the D
section itself. This is done by using the on/off switch in the Delay section on t
front panel.

The Delay Settings

Setting: Description:

Number of sixteenth notes 
(Steps)

This is the length of the delay. The shortest setting is 
one sixteenth note, the longest is 32 eighth note trip-
lets (see below).

Straight notes/Triplets This allows you to switch between repeats at eighth 
note triplets and straight sixteenth notes.

Feedback This is used for setting the number of repeats, by ad-
justing how much of the signal from the output of the 
delay is fed back into the input. When this is all the 
way down, there will only be one repeat. When it is all 
the way up, there will be an infinite number of repeats, 
which means the delay will keep sounding even if you 
stop playback.

Pan This is used for setting where in there stereo image the 
delay signal will appear. For example, you might pan 
the sound from some section to the left and the delay 
right, to get a stereo effect.

This section has
Delay added.
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Introduction
In Song mode you record series of Pattern changes and knob settings and m
ments, to create a complete Song. Practically all front panel control can be reco
You can create automation of filter sweeps, level changes, effect controls, etc

● The only controls that are not affected by automation are Tempo, the Mute 
buttons in the Mixer and the Master Level controls!

About the Song/Pattern Modes

The Song/Pattern mode switch.

The Song mode is drastically different from Pattern mode. Here are some of th
ferences you will encounter:

• Knobs and buttons are automated.
In Song mode, settings and movement of panel controls are always under au-
tomation control. You can move controls manually, but if the same control is 
automated, there will be a conflict between the two. See page 74 for more in-
formation.

• Pattern selection is automated.
Again, you can switch Patterns manually, but when a Pattern change appears 
in the Song, this will be effectuated immediately. See page 74 for more infor-
mation.

• You normally don’t perform Pattern editing in Song mode.
You can re-program the currently playing Pattern. However, since the Song 
might switch to another Pattern during playback, be careful so that you don’t 
re-program the wrong Pattern!
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Playing Songs
When you open a Song, it will play back just as recorded, together with all Pa
changes, panel settings and automation.

The following possibilities are available:

• You can use the Transport controls (see the printed documentation) to 
move to any position within the Song and start playback from there.

• The Song doesn’t really have an end. All Songs can be up to 999 measures 
in Length and playback will continue up to that point, unless you stop it 
before.

• You can set up and use the Loop to repeat a section, infinitely. If you 
want the whole Song to repeat over and over, set up the Loop to encom-
pass the whole piece.

• You can move all controls on the front panel. However, note that if a cer-
tain control has already been recorded, there will be a conflict between 
this and your manual input. See page 74.

• You can always mute and unmute sections, adjust the master faders and 
adjust the Shuffle. These controls are not part of the Song automation.
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How the Song Sequencer works – The “Signal Flow”
Below follows a little bit of theory that will help you get the most out of the ReBi
sequencer.

When you are creating a Song, there are actually a number of components th
teract with each other:

• The ReBirth Front Panel and MIDI Input.
The front panel and incoming MIDI control messages are first mixed together 
into one “control” signal. This input can be used both for recording messages 
into the Song Sequencer (in Record mode) and for “manual” access to the var-
ious controls (in Play and Stop mode).

• The Song Sequencer
The sequencer records front panel and MIDI input “control data” and then 
plays it back to the sound engine. This is how you are able to automate Pattern 
and control changes. While the sequencer records, it plays back previous re-
cordings. For example, while you record the Pattern automation for one of the 
synth sections, it plays back the automation already recorded for the other 
sections.

• The ReBirth sound engine.
This receives control information both from the Song Sequencer and from 
front panel and MIDI, all at the same time.

About “Conflicts” between the Various inputs

As stated above you can use MIDI and front panel input at any time, even dur
automated Song playback. The output from the sequencer is mixed with the d
from the front panel and MIDI and this mixed signal is sent to the audio engin
Normally this is completely natural. There is only one situation to be aware of

If you have already recorded some automation for a control, and move the same 
control manually, at the same time as it is being controlled by the automation, the
will be “conflicting” input to the audio engine. This may lead to a control “flicke
ing” on screen and possibly slightly strange sound. Then again, it might just s
cool.

MIDI Input

Front Panel

Song
Sequencer

Audio
Engine

Record
mode

Play/
Stop
mode
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Preparations for Creating your own Songs

Pattern mode Preparations

1. In Pattern mode, create all the Patterns you want to use in the Song.
There’s actually nothing preventing you from switching back to Pattern mode 
at any time, to add and modify Patterns, but you probably want all the basic 
Patterns to be ready before you assemble the Song.

2. Try out the basic Pattern changes, to make sure everything works alright.
A good way to do this is to use the computer keyboard for Pattern switching, 
see page 222.

3. Set up a basic mix including all the sounds for the Song, even including 
effects.

4. Save your Song document so you can go back to this stage later.

You are now done with the Pattern mode work. Let’s switch to Song mode.

Song Mode Preparations

1. Switch to Song Mode.

2. Select “Initialize Song from Pattern mode” from the Edit menu.

This accomplishes two things:

• The whole Song is completely cleared.

• Events are inserted at the beginning of the Song so that it plays exactly 
like Pattern mode, just before you switched over to Song mode.
This includes the control (knob) settings.
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Building a String of Patterns
When creating a Song you most likely will want to create the basic chain of Pat
first, and work on the levels, sounds and effects afterwards. To create the Pa
changes, proceed as follows:

Preparations

1. Follow the preparation steps outlined above, so that you have an empty 
Song to start from.

2. Turn off the Loop.
While this is not required, Loop recording introduces some new concepts, de-
scribed on page 84. Therefore, to get started with Song creation, turn the Loop 
off.

The Loop deactivated.

3. Press Stop to “rewind” to the beginning (bar counter says “1”).

4. Press the Record button so that it lights up.

5. Select the Patterns for the first bar, by clicking the corresponding Pattern 
selectors in the three sections.
From here on there are two ways to go: Step Mode writing and Real Time writ-
ing.

Real Time Writing of Pattern Changes

1. With Record mode still activated, activate Play.

2. Change Patterns as the Song plays back.
You should hit the Pattern buttons before the downbeat. The program will then 
move it to the exact bar. In fact, Pattern changes can only happen on the be-
ginning of a measure.

You can make changes in just one section, or in several, it doesn’t matter. So
people will feel confident using the mouse to create the changes for just one se
at a time, others will use the keyboard to arrange the whole song on the fly, it’s
matter of personal taste.

● Please check the special notes for creating an end for the Song, see below.

3. When you are done, hit Stop.
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4. Rewind and play back to check.
If you made any mistakes, you can correct them now or later, as described be-
low. For now we will assume everything is OK, and that you will want to add 
Pattern changes for the other sections now.

5. Rewind to the beginning of the Song.

6. Activate Record and Play and perform the changes for the next section.

7. Repeat as needed.

Step Mode Writing of Pattern Changes

If you prefer to “punch in a list” of the Pattern changes, without activating playba
proceed as follows:

1. Follow the steps under Preparations, above. Record mode should be acti-
vated.

2. While you are still at the first bar of the Song, make sure the correct Pat-
terns are selected for this step. If they’re not, select them.

3. Click on the up arrow in the Bar section, to advance to the next Bar.

The arrow up button allows you to step through the bars in the Song, one bar at a time.

4. Select the Patterns that should play at this bar.
You only need to select actual Pattern changes. If a section should play the 
same Pattern as in the last measure, you don’t need to make any Pattern 
changes for this section.

5. Advance to the next Bar and select Patterns for this.
As soon as you do this, the previous Pattern recording for this measure is de-
leted, and whatever you now have selected will play instead.

6. Repeat steps 4 and 5 as needed.

● Please check the special notes for creating an end for the Song, see below.

7. When you are done, hit Stop.

8. Rewind and play back to check.
If you made any mistakes, you can correct them now or later, see below.

● Do not touch Fast Forward, Rewind or the down arrow in the Bar section 
while step recording. If you do, recording is automatically deactivated!
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Creating an “End” for the Song

A song is actually always 999 bars, it has no real end before that. Playback a
continues up until bar 999, unless you stop it. Furthermore, all measures in the
always play something. This has the effect that you must make sure that there a
enough silent measures at the end of the Song, for your purposes:

1. Set the start of the Loop to the position of the first bar that should be si-
lent.

2. Set the Length of the Loop to maximum value.

3. Activate Recording.

4. Either select silent Patterns or deactivate Pattern playback completely, in 
the Pattern sections.

A deactivated Pattern section.

● Do not use the level faders in the mixers for this purpose, it might lead to con-
fusing results, unless you are absolutely sure of what you are doing.

5. Select “Copy touched controls to Loop” from the Edit menu.

6. Deactivate Recording.
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Correcting Mistakes and Making changes to the Pattern 
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Starting Over

If you realize you would rather start over completely, you can always use the 
tialize Song from Pattern mode” command at any time, to clear the Song com
ly.

Making Changes to some Part of the Song – “Punching In and Out”

If some Pattern change is not as you’d like it to be, proceed as follows:

1. Move to the position of the first bar where you want to change Patterns.

2. Activate Recording.
You can make changes in Step or Real Time (Play) mode, technically it doesn’t 
matter. However, since in Play mode it can be tricky to deactivate recording at 
exactly the right point in, you might want to perform changes like this in step 
mode.

● As soon as you “touch” a Pattern selector, Pattern selection in that section is 
considered “punched in” and will from now on be showing and playing it’s 
current setting, rather than the settings recorded in the Song. However, this 
happens individually for each section. Pattern selectors in sections that you 
haven’t touched during this recording pass are not affected in any way.

3. Proceed in Step mode or Real Time (Play) mode and select Patterns for all 
the relevant measures.

● Don’t touch any other controls than the Pattern selectors, or you will have 
“punched in” on those too! See later in this chapter for details.

4. When you are at the last bar where you want to make any changes, make 
those changes and then deactivate recording just before the bar ends.

5. Rewind and check.
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Recording Control (knob) Changes
Once you have your Pattern changes down, it is time to record all the front pa
controls. Use this to “mix” the Song (volumes, panning and effects) and to se
sound for the synth and rhythm sections (any sound parameter).

Real Time Recording

1. Make sure you are in Song mode. You will probably also want to make 
sure that all Pattern changes are as you want them.

2. Turn off the Loop.
While this is not required, Loop recording introduces some new concepts, de-
scribed on page 84. Therefore, to get started with control recording, turn the 
Loop off.

3. Rewind so that you are sure you are at the first step of the Song (bar 
counter says “1”).

4. Press the Record button so that it lights up.

5. Activate Play.

6. Move the controls as the Song plays back.
You can make changes to just one control, or to several, it doesn’t matter. Also 
note that you can move the controls via MIDI, as described on page 127.

7. When you are done, hit Stop.

8. Rewind and play back to check.
If you made any mistakes, you can correct them now or later, as described be-
low. For now we will assume everything is OK, and that you will want to add 
changes for other controls now.

9. Rewind to the beginning of the Song.

10.Activate Record and Play and perform the changes for the next con-
trol(s).

11.Repeat steps 9 and 10, as needed.
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Step Recording Control Changes

You can step record control changes, just like with Pattern selections. There are
cases:

If move a control and then punch out before advancing to the next measure, t
control setting will only be valid for a short moment at the beginning of the me
ure.

If you advance to the next bar, the setting you leave the control at will be valid
the entire previous measure. In other words, that control will remain at a static
sition throughout that measure.
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Correcting Mistakes and Making Changes to Control 
(knob) Recordings

Punching In and Out – Making Changes to some Part of the Song

If some control recording is not as you’d like it to be, proceed as follows:

Punching in on the fly

1. Move to a position one or a few bars before the mistake.

2. Activate Recording and playback.
Nothing gets recorded until you actually “touch” a control.

3. When you are at the right position, press the mouse button with the 
pointer over the control you want to record, and start moving it. Perform 
the recording.

● As soon as you “touch” a control in this way, that control is considered 
“punched in” and will from now on be showing and playing it’s current set-
ting, rather than the settings recorded in the Song. Old events for this control 
will now be deleted, as long as recording continues. However, “punch-in” 
happens individually for each control, controls that you haven’t touched dur-
ing this recording pass are not affected in any way.

Recording from a specific position

1. Move to the position where you want to start recording.

2. Activate Record but not playback

• Set the control(s) to the desired initial position.
That/Those controls are now considered “punched in” (see above) and will 
now be showing and playing their current settings, rather than those recorded 
in the Song.

3. Activate playback, press the mouse button with the pointer over the con-
trol you want to record, and start moving it.

Stopping Recording

1. When you reach the Song position where you want to return to the previ-
ously recorded changes, hit Stop or deactivate Recording (by clicking the 
Record button or by pressing [*] on the numeric key pad).

2. Rewind and check.

3. Repeat the recording procedure as desired.
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Filling Measures with “Static” Control Settings

There might be situations where you want to make a “static” change to a numb
bars. You might for example want to lower the volume for the first synth betw
bars 13 and 21, or make sure the dist Amount is constant throughout the entire
Proceed as follows:

1. If you want to perform this action for just a section of the Song, set up 
the Loop to encompass that section.

2. Activate Recording.

3. If you want to, also activate playback.
It is often convenient to make a change in playback mode, since you will then 
hear what you are doing! However, note that when you touch a control in this 
mode, you will also record that action. Then again, this might not matter since 
you will in a short while fill the measures in the Loop or in the whole Song, 
with new settings for the control you just touched!

4. When you have the setting right, select “Copy touched controls to Loop/
Song” from the Edit menu.

5. Now, events for the controls you have touched during this recording 
pass, will be inserted at the beginning of the Loop/Song.

6. Deactivate Recording.

Using “Initialize Loop from Pattern Mode”

This item, on the Edit menu, is used for ”initializing” the measures inside the Lo
This can be used as a convenient way to use the settings currently in Pattern 
as initial settings for some measures in the Song you are building.

● Please note that this command clears all the Pattern changes and knob record-
ings currently inside the Loop!

Proceed as follows:

1. Switch to Pattern mode and select the correct Patterns and set up all con-
trols as you want them to be inside the Loop. 

2. Switch back to Song mode and set up the Loop to encompass the meas-
ures you want to change.

3. Select “Initialize Loop from Pattern Mode” from the Edit menu,
Events that correspond to the settings currently made in Pattern mode, will be 
inserted at the beginning of the Loop. The rest of the loop is cleared com-
pletely.
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Recording while Looping

A loop between bar 17 and 33.

All of the text above has assumed the Loop has been turned off. However, yo
also record in Loop mode. Basically this is the same as when you record with 
ing off, except for one situation: when you reach the position where the Loop s
over.

As described above, as soon as you touch a control, this is considered as “pu
in” for this recording pass, and will show and play the settings you give it now,
the ones previously recorded in the Song.

However, when you reach the loop end, all controls will be “punched out”, so 
on the next lap, they will instead play back movements recorded on the previou

● Please note that if you move the control just when the Song loops, it will be 
considered as “punched-in” again. That is, you will again be recording that 
control, which means you erase actions performed on previous laps.

To avoid this, release the mouse button just before you reach the Loop end.

About Recording Pattern changes vs. Control Changes
Actually there is only one technical difference between recording Pattern cha
and controls. Pattern changes are only recorded on downbeats (the beginnin
measure) while control changes are recorded on each 32nd note.

The only reason we have described a working order of first creating the Patte
changes and then the control recordings, is because that is the way most peo
seem to prefer to work.

If you like, you can do things in any order. Record some Pattern changes, then
controls, then re-record the Pattern changes, for example. Whatever control r
ings you have made will now affect the new Patterns instead!

You can even start by recording the controls and then make the Pattern chan
- 84 - 



 over 

u 
 Pat-
g 

attern 
at 
attern 
tern 
Making Modifications to Patterns
To make modifications to the actual Patterns, we recommend that you switch
to Pattern mode and make the changes there.

You can re-program Patterns in Song mode as well. However any changes yo
make will affect the currently playing Pattern. Since the Song probably switch
terns on the fly, you need to be very careful so that you don’t reprogram the wron
Pattern.

Secondly, you should be aware that any changes you make to a Pattern (in P
or Song mode) will immediately be reflected everywhere in the Song where th
pattern is used. The Song always plays back the Patterns just as they play in P
mode. In other words, what you record in the Song are switches between Pat
numbers, not the actual Patterns themselves.

Moving, Removing and Repeating Measures in the Song

Removing Measures

You may want to completely Remove some measures from the Song:

1. Set up the Loop to encompass the measures you want to remove.

2. Select Cut Loop from the Edit menu.
The measures are removed.

Cutting and Pasting Measures

If you want to move or duplicate some measures, proceed as follows:

1. Set up the Loop to encompass the measures you want to move/duplicate.

2. Select Cut Loop or Copy Loop from the Edit menu.
If you select Cut, the measures inside the Loop are removed and copied to the 
Clipboard, an “invisible” memory location from where they later can be 
Pasted. If you select Copy, the measures are only copied to the Clipboard.

3. Move the Song Position to the place where you want to Paste In the meas-
ures you just Cut/Copied.

4. Select Paste at Song Position or Paste Replace at Song Position.
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The Difference between Paste and Paste Replace

• When you use “plain Paste”, the measures are inserted into the Song, so 
that is lengthened. 
If you for example have Cut four bars, and use “Paste at Song Position”, at 
Song Position 13, you will get four new measures between measure 13 and 
16. These contain the pasted material. Whatever was at bar 13 before the op-
eration, is now at bar 17.

• When you use “Paste Replace”, the Pasted material replaces whatever 
was at those measures before.
Again, if you Cut four bars, and use “Paste Replace at Song Position”, at Song 
Position 13, the contents of measures 13, 14, 15 and 16 will be replaced by 
the measures on the Clipboard.

Repeating Measures

This is just a special case of Copy and Paste, as described above. If you are u
using Copy and Paste in for example a word processing program, you will see
this is the equivalent of that.

1. Set up the Loop to encompass the measures you want to repeat.

2. Select Copy Loop from the Edit menu.

3. Select Paste at Song Position as many times as you want extra copies of 
the measures to appear, after each other, in a repeated fashion.
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Using the Song Feature in a “live” situation
In a live situation you might want to have “partial automation”. That is, you mi
want Pattern switching to be automatic, but control changes to be manual, or
versa. Or you might want some controls automatic but others manual.

To a achieve this, proceed as follows:

1. Create a Song that only contains the automation you want, for example 
only the Pattern switching or only a limited set of the controls.
It is very important that there’s no “conflict” between the changes you want to 
make manually and those that you want to be automated. For example, if you 
want to manually control the Cutoff button on one synth in bar 17 to 32, 
make sure you don’t record any changes for that knob in those particular 
measures.

2. Make sure the Song starts in the right way with all the correct Pattern 
and initial control settings.

3. In the live situation, load up the Song, and position to the beginning.

4. Hit Play and perform any Pattern switching or control changes you want 
to do live.
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What is a Mod?
A Mod is a file that makes ReBirth RB-338 look and sound different. When yo
start creating a Song, you normally begin by selecting a Mod so that you get 
drum sounds you want. But you can also “transform” existing Songs by chang
to another Mod at any time.

A few Mods are included with the program and get installed with it. Additional
Mods can be added. Mods are for example available for free download from th
ternet, see page 95.

You can also create your own Mods, from scratch, see page 96!

A Mod may:

• Replace all the drum sounds with new ones, in both rhythm sections.

• Change the appearance of the front panel completely.
An exact list of the Mod contents can be found on page 96.

However, there are two important things that a Mod doesn’t do:

• It does not affect the functionality of the program in any way.
All controls will work in the same way, and will be located in the same place 
om the front panel, regardless of which Mod you use.

• A Mod can not modify the sound of the synthesizer sections or the effects 
in any way whatsoever.

Mods and Memory Requirements

The graphics and sounds in a Mod uses up primary memory, RAM. The longe
drum sounds in the Mod, the more RAM is required.

Since the drum sounds in a Mod can be of practically any length, there’s no e
way to determine how much memory is required to use a certain Mod.

Furthermore, you can have several Song documents up on screen, which all u
ferent Mods. This requires that all these Mods are loaded into memory, which
up even more RAM.

If there is not enough memory available to use a certain Mod, a dialog will inf
you.

General Memory Strategies

If you run out of memory, the first thing to do is to close other windows, specifi
cally those that use other Mods than the one you plan to use right now.
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PC Memory Strategies

On the PC, memory is “allocated” dynamically to the programs. This means th
you don’t really have much control over how much memory ReBirth RB-338 u
If you run out of memory, there are basically three things you can do:

• Quit other programs.

• Turn of background tasks and system additions that require RAM.

• Install more physical RAM.

Mac Memory Strategies

On the Mac, memory control is more “manual”. You can for yourself see how m
memory you have available for applications, by selecting “About This Comput
from the Apple menu. You should do this after start-up, before you launch any
grams. By checking the amount of memory available for applications, you are
to determine whether it is possible to assign more memory to ReBirth RB-338
not.

If you want to assign ReBirth RB-338 more memory, proceed as follows:

1. Quit ReBirth if it is running.

2. Locate the ReBirth RB-338 icon in the Finder and select it.

3. Select Get Info from the File menu.

4. In the dialog that appears, assign more memory to the program.
For exact details on this dialog, see your Macintosh manuals.

● Avoid assigning the program so much memory that none is left for the system 
once ReBirth RB-338 and other programs are running. The Sound Manager 
(the routines in the Macintosh that handle audio) require that some system 
memory is left unused after all applications have been launched.

If there is not enough memory available, you may consider trimming your sys
to free up memory. You then have the following options:

• Turning of System Extensions and Control Panels that you don’t need.

• Removing Fonts that you don’t use.

If none of this is enough, you need to install more physical RAM.
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Creating a New Song with a Certain Mod
To create a New Song document with a certain Mod, proceed as follows:

1. Select New from the File menu.

2. Select the desired Mod from the Mod menu.
The Mod startup sound is played (this feature can be turned off in the Prefer-
ences dialog).

The options on the Mod menu depend on what Mods you have “installed” in y
system, see later in this chapter.

When you save the Song, the Mod selection is included as part of the Song d
ment. However, the actual Mod is not stored in each Song file, just informatio
about which Mod it uses, see “Opening Songs that use Non-Standard Mods”, be-
low.

Switching Mods for an Open Song
You can switch Mod for any Song document, at any time. However, please note
the musical result is unpredictable, since the creator of the Mod may have use
types of sounds for the rhythm sections.

If you Save the Song after switching Mod, the next time you open the Song, it
use that last selected Mod instead.
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Opening Songs that use Non-Standard Mods
If the Song you open uses a Mod that is not installed on your system, a dialog
inform you. You then have the following options: Download (only available if th
Mod creator specified it), Standard and Cancel. Here are the details:

Download

If you select this option, a dialog informs you that the program will launch your
ternet browser and take you to an ftp site specified by the Mod creator. This w
download the file onto your computer.

1. Click OK and your preferred browser launches.
More information on this can be found on page 179.

2. The browser takes you to the ftp site where the Mod is located (according 
to the information in the Song), and downloading begins.
Normally this works like a charm. However, the are two things that can “go 
wrong”:

• You browser may not recognise files of the type”rbm”. This means that 
instead of downloading the file, it might display it as garbage characters 
in a text window.
If this happens you need to make settings in your browser that specify “rbm” 
files as a file typ valid for downloading.

• Instead of you specifying where you want the file (it should be in your 
Mods folder, in the ReBirth folder) it might get automatically down-
loaded into some predefined folder on your hard disk.
If this happens you may want to modify your browser’s settings so that it asks 
you where you want to store the file before you start downloading it. 
It is also possible that you might be able to specify things so that “rbm” files 
are automatically downloaded into your Mods folder.
If you don’t have any control over where the file is stored, you will have to 
manually move the file to the Mods folder after downloading is finished.

3. After downloading, make sure the Mod is located in the ReBirth Mods 
folder and that it really is in “rbm” format.

4. Switch back to ReBirth and click OK.
The Song now opens with the right Mod. If it doesn’t, the file is either not in 
the correct format, it doesn’t have the right extension (.rbm), or you put it in 
the wrong folder.

For more installation information, see page 95.
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Standard

This will open the Song using the standard sounds in ReBirth RB-338 rather 
the intended Mod. However, this means the Song will not play as intended by
composer.

Cancel

This cancels the whole operation. The Song will not be opened.
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The Mod dialog

The Mod Selector dialog (Macintosh version).

This dialog can be used to select Mods, just as you can directly from the Mod
menu. However, the dialog provides a few additional options:

Option: Description:

Mod pop-up This list the Mod files found in your Mod folder in 
your ReBirth folder. Selecting one and clicking OK, 
applies it to the active Song.

Mod Splash Screen An “About” screen for the Mod.

Mod Information text Text added by the Mod creator that tells you more 
about this particular Mod.

Web Site link An optional link to the Mod creator’s web site. On 
this page you should find more information about 
the Mod, and the author. To go to this web page, 
click the Browser button.

OK This closes the dialog and applies the Mod to the 
active Song document.

Cancel This closes the dialog without making any changes.

Demo Song This plays a demo Song, supplied by the Mod au-
thor, that should give you a hint as to what kind of 
sounds the Mod provides.

Browser This launches your web browser and takes you to 
the web site specified for the Mod. See page 179 for 
details on the web browser mechanism.
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Adding Mods to your Setup

About the Mod Files

Mods are files saved in a special “rbm” file format. The exact same Mod file ca
used on both the Mac and PC platforms without any conversion. Since the file
have been created on either platform, there are two things to note for Mac us

• A Mod file created on the PC will not have a proper icon, it will most 
likely use the default “blank page icon”. It will still work perfectly, though.

• A Mod file must have the extension “rbm”. That is, the file name must end 
with that text, for example, a Mod can be called “myrebirthmod.rbm”.

Downloading

A number of Mod files are available for download from the Internet. Some are
available on the Propellerhead web pages (www.propellerheads.se) and som
be available on other web pages.

New Mods are continuously created by ReBirth users all over the world. To find
what Mods are currently available we recommend that you check the Propelle
heads web pages and search the Internet using any of the search engines av
You may also want to subscribe to mailing lists and news groups that discuss
Birth RB-338.

Once you have located a Mod file, you can download it just like any other file 
retrieve from the Internet, normally using an ftp client.

● We strongly recommend anyone putting Mod files on the Internet to use ftp 
archives rather than web pages (ftp as opposed to http) since the automatic 
downloading mechanism (see page 92) in ReBirth will then work as intended. 
If you find a Mod file on a regular web page (http) please note that it may be 
packed into an archive, using a program such as WinZip (PC) and ZipIt (Mac). 
You then need to unpack the file before you can use it!

Installing

To Install a Mod “manually”, proceed as follows:

1. Copy/move the “.rbm” file to the “Mods” folder in your ReBirth folder.

2. Select “Scan for New Mods” from the Mods menu.

3. Check that the new file appears on the Mods menu.
If it doesn’t, the file is either not in the correct format, it doesn’t have the right 
extension (.rbm), or you put it in the wrong folder.
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Creating Your own Mods
For those so inclined, there is a possibility to create your own Mod files! This 
done by assembling a number of graphical files and audio files etc, and runni
these through a utility included with ReBirth RB-338, called the ReBirth Mod-
Packer. However, making a full Mod (graphics and sound) is not for the faint o
heart. For example you need to create over fifty very detailed image files!

● The descriptions below assumes you are familiar with computers and have 
experience with image editing, audio editing and text editing applications.

Install ModPacker!

If you are interested in creating a Mod yourself, you need to install the ModPa
program and example files. An installer for these components is located on the
next to the ReBirth installation.

What Exactly is in a Mod File?

The following components make up a ReBirth Mod file. To check them out for
yourself, locate the folder “Standard Components” in the ModPacker folder on
your hard disk. This contains all the files that make up the standard ReBirth R
338 graphics and sounds. Open the files in your preferred graphics/audio/text 
and examine the contents. To determine which image files goes where, compa
separate pictures to the complete front panel image in the program.

Here are some more details about the files:

File Type: Comment:

Drum Sounds in AIFF format (.aif) These are the sounds used in the rhythm 
sections. The name gives you a hint about 
where the sound is used.

Startup Sound in AIFF format (.aif) This is the sound that is played when you 
select this Mod.

Front Panel images in JPEG format 
(.jpg)

These make up the front panel graphics. 
There’s one file for each component. Some 
files contain animation strips. For exam-
ple, there’s one image for the synth knobs 
that consist of one “frame” for each possi-
ble knob position.

Splash screen in JPEG format (.jpg) These is the “About screen” for the Mod, 
as displayed in the “Select Mod...” dialog.

Web and ftp links in text format (.txt) These are simple text files that contain the 
links to the Mod creator’s web and ftp 
sites.
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Creating a Mod

To create your own Mod, proceed as follows:

1. Make a copy of the folder “Standard Components” and its contents and 
rename it to avoid confusion.

2. In this folder, replace the files, one by one, with your own files. Be sure 
to use the exact names and file formats as the current files.
It is not required that you replace all files. It is for example perfectly possible 
to make a Mod that only contains new sounds. If any file is completely miss-
ing it will simply be replaced by the corresponding standard ReBirth compo-
nent. For more content guidelines, see below.

3. Drag and drop the new folder onto the application “ModPacker”.
A file dialog allows you specify a name and location for the Mod file.

● Please make sure the file name has the extension “.rbm” (for example “my-
modfile.rbm”), even if you create it on a Macintosh computer.

4. Install your new Mod in the ReBirth Mod folder, as described earlier in 
this chapter.

Content Guidelines

Images

ReBirth utilizes compressed JPEG graphics (uncompressed JPEG is not sup
ported). The amount of compression is technically of no relevance.

● Your images must be of the exact same width and height as the original ones!

Sounds

All sounds files must be in 44.1kHz, mono, AIFF format. If your sounds are in
other format (for example Wave) there are a number of utilities available that 
convert to AIFF for you.

Mod Name and Comments in text for-
mat (.txt)

Text files that specify the exact name of the 
Mod plus any comment the creator wants 
to convey to users of the Mod.

Demo Song in rbs format (.rbs) This is a regular ReBirth RB-338 Song file. 
This Song will play when you click the 
“Demo” button in the “Select Mod...” dia-
log. This allows the creator to give users a 
hint about what sounds to expect from the 
Mod.

File Type: Comment:
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Here follows some notes about the individual sounds:

Important notes:

• Be careful about the layout of your custom drum kit! All drum sounds are 
monophonic except the bass drums (BD). If you place bass drum samples 
or other samples of low frequency audio on the other “slots”, you may ex-
perience a nasty “snap” if the sample is retriggered before it's been played 
back in full.

Drum: Description:

808 BD Single sample. The Decay knob controls a software envelope 
(decay only) and the Tone knob controls a low-pass filter.

808 SD Nine samples in total; Five samples of a “clean” 808 snare (no 
snappy) and four high-pass-filtered “noise” samples (snappy). 
The Tune knob crossfades between the five clean samples. The 
Snappy knob controls the volume of the noise sample(s). The 
noise samples are played one at a time, in random order.

808 CB, CH, 
CL, CP

Single samples.

808 CY Single sample. The Decay knob controls a software envelope 
(decay only) and the Tone knob controls a low-pass filter.

808 LC, MC, 
HC, LT, MT, HT

Single samples. Tune knob controls sample playback speed.

808 MA, RS Single samples.

909 BD Four samples that the Tune knob crossfades between. The Dec 
knob controls a software envelope (decay only) and the Att knob 
controls a low-pass filter.

909 SD Eight samples in total; five samples of a “clean” 909 snare (no 
snappy) and three high-pass-filtered “noise” samples (snappy). 
The Tune knob switches between the five clean samples. The 
noise samples are played one at a time, in random order. The 
Snappy knob controls the volume of the noise sample(s). The 
Tone knob controls the length of the noise samples.

909 LT, MT, HT Single samples. The Tune knob controls sample playback speed. 
The Decay knob controls a software envelope (decay only).

909 RS, CP Single samples.

909 CH, OH Single samples with a common level control. The Decay knob 
controls a software envelope (decay only).

909 CC, RC Single samples. The Tune knob controls sample playback speed.

Startup sample This sample of a Japanese drum machine powering up(!) is 
played back each time ReBirth boots.
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• For each of the two components of the snares (snappy’ and ‘tone’ samples) 
there are a number of variations. All the variations must have identical 
lengths, or some sound may not play in its entire length, under certain cir-
cumstances. Insert silence at the end of the shorter samples, if required.

Text Files

• Use international characters only in all texts. Basic umlauts are allowed, 
but avoid special characters.

• The Name is the identifier for the Mod. This text should not contain any 
version number, just the plain name. It is this text that will be used to 
“connect” Song files to this particular Mod. This means that if you update 
your Mod, you should not change ther Name since then, existing Song 
files will require the old version of the Mod.

• The maximum text for the Comment is 600 characters.

• We recommend that you use the Comment text to describe the types of 
sounds your Mod contains.

• The web and ftp links should contain the complete link text and only the 
link text. For example, write http://www.propellerheads.se/index.htm 
(web) or ftp://ftp.propellerheads.se/mods/supermod.rbs (ftp).

• The web link should take you to a page with more information about the 
creator of the Mod. This should not be a download page! If you don’t have 
a web page, leave this file blank.

• The ftp link should be a direct link to an ftp site (not a web page!) from 
where the Mod can be downloaded. The link should contain a path to the 
file itself (for example (ftp.propellerheads.se/pub/Mods/supermod.rbm). If 
you don’t have access to an ftp site, leave this file blank and no download-
ing options will appear in ReBirth RB-338. alternatively, contac us! If you 
follow our guidelines (see page 100) we might put it on our ftp site for oth-
eres to download.

Demo Song

This is any Song file you think is appropriate for demonstrating the qualities o
your Mod.

Uploading to the Internet

If you want other people to be able to download your Mod, put it on the Intern
and specify the link in the actual Mod file. Whenever someone creates a Song
your Mod, the address to the actual Mod will be included in the Song. If some
then tries to play the Song without the Mod, they will be directed to your ftp site
described on page 92.

You can put the file on a web page or in an ftp archive. Just note the following

• You must put the file on an ftp site for the automatic downloading mech-
anisms to work.
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• Do not archive the file using utilities such as WinZip, ZipIt or StuffIt. It is 
completely unnecessary (the data is already compressed) and it will only 
create extra work and confusion for downloaders.

• If you don’t have access to an ftp site, you will have to put the file on a 
web page. The automatic downloading mechanisms will not work with 
web pages, so don’t specify any link in the ftp.txt file. Furthermore, if you 
put the file on a web site, you will probably need to archive it, due to the 
way web browsers download binary files. 

• Even if you are a Mac user, never use StuffIt if archiving is required. In-
stead use a PC compatible archiving program, such as ZipIt, so that both 
Mac and PC users can download and unpack your Mod without prob-
lems!

About Making an “Approved ReBirth Modification”

If you send us your Mod and we like it, we will distribute it through our “Mod” 
page. However, to get your ReBirth modification approved and distributed by 
pellerhead Software, it must be made according to certain guidelines, namely

• The modification must NOT be based on any copyrighted material. This 
includes both sounds and graphics. Any “mimics” of existing products, 
such as hardware drum machines etc, are completely ruled out. You have 
to create something of your own design!

• The Mod must include both completely new graphics and new audio.
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Why use ReBirth RB-338 with Cubase?
While ReBirth RB-338 is a complete music tool in its own right, you might wan
add other elements to the music, such as:

• Other synthesizers (controlled via MIDI).

• Samples and loops (via a sampler connected via MIDI).

• Vocals.

• Instrumental recordings.

And what better way to do it than to use ReBirth together with Steinberg’s ‘sta
the art’ audio sequencer, Cubase! Using this as a companion to ReBirth RB-3
lows you to expand and integrate your ReBirth Songs with any other type of m
MIDI and acoustic recordings. By recording ReBirth onto audio Tracks in Cub
you can also add more synth lines than is possible when using ReBirth by its

Introducing ReWire!
To make this integration between two audio programs possible, Propellerhead
ware and Steinberg have developed ReWire. This technology provides the follow-
ing possibilities and features:

• Real time streaming of up to eighteen separate ReBirth audio channels, at 
full bandwidth, into Cubase VST’s audio mixer.

• Automatic, sample accurate, synchronization between the audio in the 
two programs.

• The possibility to have the two programs share one sound card and take 
advantage of multiple outputs on that card.

• Linked transport controls that allows you to play, rewind etc, from either 
program.

• Automatic audio mixing functions that separate channels as required.

• Less total system requirements than when using the programs together in 
the conventional way.

How Does it Work?

Basically the key to ReWire is the fact that ReBirth RB-338 is divided into two
components, the ReBirth Engine (a DLL on the PC and a Shared Library file o
Macintosh) and the ReBirth application. The ReBirth Engine is a common reso
to the two programs (Cubase and ReBirth) that generates the audio and pass
onto Cubase VST.
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System Requirements

CPU, RAM and Hard Disk

To run Cubase VST and ReBirth RB-338 you need a fast computer with a hea
amount of RAM:

• Exactly how fast the computer needs to be is impossible to say, because it 
depends on how many audio channels and plug-in effects you want to use 
in Cubase VST. However, for serious works we recommend a Pentium at 
233 MHz or faster or a Macintosh with a 604 processor or better.

• Exactly how much RAM you need is also hard to determine in advance. 
Again this depends on the number of audio channels that you plan to use 
for hard disk recording in VST. But here, ReBirth RB-338 itself is also an 
important factor. The more (and bigger) Mods you want to be able to use, 
the more RAM is required. However, we recommend that you have at least 
64 MBytes of physical RAM, preferably more.

• ReWire does not put any extra requirements on your hard disk.

Cubase Versions

To use ReWire you need Cubase VST 4.0 (or later) for Macintosh or Cubase 
3.6 (or later) for Windows.

Preparations for Using ReWire - Macintosh only

OMS

ReBirth RB-338 currently does not support use of OMS and ReWire simultan
ously. You must turn off OMS. See page 109 in this chapter for details.

Memory Settings

When you use ReWire, some of the system resources normally occupied by R
Birth are “transferred” to Cubase VST:

More specifically, the RAM required for loading Mods in ReBirth, must now be
provided by Cubase VST instead. Therefore, when using ReWire we recomm
you to make the following changes to your memory settings for the two progra
(for details, see your Macintosh manual):

1. If you have raised the maximum memory setting in ReBirth RB-338 (to be 
able to use more Mods) lower it back to the recommended value, but 
make a mental note of how much it was set to.

2. Raise the Maximum memory for Cubase VST by at least the amount that 
you just lowered for ReBirth.
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Launching and Quitting
When using Rewire, the launch and quit order is very important:

Launching for normal use with ReWire

1. First launch Cubase VST.

2. Launch ReBirth.
Please note that it takes slightly longer for ReBirth to start when you are using 
it with Cubase VST.

Quitting a ReWire session

When you are finished, you also need to Quit the applications in a special ord

1. First quit ReBirth.

2. Then quit Cubase VST.

Launching Cubase VST for use without ReBirth/ReWire

If you don’t plan to run ReBirth, just launch Cubase VST as usual.

We recommend that you then also open the ReWire window and deactivate a
Wire channels (see page 105 in this chapter). But this is not completely critical, R
Wire does not use up very much processing power when it isn’t used.

Launching ReBirth for use without Cubase VST/ReWire

If you want to use ReBirth RB-338 as it is, without Cubase VST, just launch it
you normally do.

Launching both programs without using ReWire

We don’t know exactly why you would want to run ReBirth and Cubase VST at
same time on the same computer, without using ReWire, but you can:

1. First launch ReBirth.

2. Then launch Cubase VST.
You will get an error message in Cubase VST, but you can safely ignore it. 
Please also note that the two programs now compete for system resources 
such as audio cards, just as when running either with other, non-ReWire, au-
dio applications.
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Activating ReWire Channels
To activated the desired inputs from ReBirth RB-338, in Cubase VST, proceed
follows:

1. Pull down the Panels menu and select ReWire.

2. Click on the green buttons to activate/deactivate the desired channels.
Exactly what signal are carried on each channel is described below. Please 
note that the more ReWire channels you activate, the more processing power 
is required.

3. If desired, double click on the labels in the right column, and type in an-
other name.
This is the label that will be used in VST to identify the ReWire channel.

The ReWire window in Cubase VST (Macintosh version). Here, only the stereo mix is 
activated.
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Signal Routing

What Signals are on the Inputs?

Mix-L and Mix-R

This is the regular master output in ReBirth RB-338. These are the only stere
channels, all other channels are in mono.

• If none of the other channels are used, then this carries all the sound 
from ReBirth.

• Signals that are activated separately are removed from this mix.
If for example the 909-Mix channel is activated, then Mix-L and Mix-R carries 
all the sound from ReBirth RB-338 except the 909, which will appear on its 
own channel.

• The only signal that can never be removed from these channels is the re-
turns from the Delay effect.

303-1 and 303-2

These are separate mono outputs for each of the 303 synth sections.

808-Mix

• This is a separate mono output for the complete 808 rhythm section.

• Individual 808 drum sounds that are activated (see below) are removed 
from this mix.
If, for example, you activate the 808-BD, then this signal will carry all the 
sounds from the 808, except the bass drum, which will appear on its own 
channel.

808-BD, SD, Tom, Per, HH and CY

These are separate sounds and mixes of sounds from the 808 rhythm section

• “BD” is the bass drum.

• “SN” is the snare.

• “Tom” is a mix of the three Toms/Congas.

• “HH” is the hi-hats (open and closed)

• “CY” is the cymbal.

• “Per” (percussion) carries all the remaining 808 rhythm sounds in a 
mono mix.

909-Mix

Just as 808-Mix, but for the 909 rhythm section.
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909-BD, SD, Tom, Per, HH and CY

Just as the corresponding 808 individual sound outputs, but for the 909 sectio

• “BD” is the bass drum.

• “SN” is the snare.

• “Tom” is a mix of the three Toms.

• “HH” is the hi-hats (open and closed)

• “CY” is both cymbals.

• “Per” (percussion) carries all the remaining 909 rhythm sounds in a 
mono mix.

Levels, Pan and Effects

Mix-L and Mix-R

For the stereo mix, all level controls, panning and effects apply, just as when 
use ReBirth RB-338 by itself.

303-1, 303-2, 808-Mix and 909-Mix

• For the mono outputs for each section, mixer level and pan are disabled.

• All level and sound controls in the actual sections still apply.

• The insert effects – Distortion, Compression and PCF – still apply.

• The Delay send control is still active, but the actual Delay return signal 
always appears on the Mix-L and Mix-R channels.

Separate Rhythm Section Outputs

• For the separate rhythm section outputs (BD, SD, Tom etc.), all levels are 
still enabled.

• All individual sound controls (Tune, Tone, Decay etc.), still apply.

Using the Transport
When you run ReWire, the transports in the two programs are completely linke
doesn’t matter in which program you Play, Stop, Fast Forward or Rewind. Re
ing, however, is still completely separate in the two applications.
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How the ReWire Channels are handled in Cubase VST
When you activate ReWire channels in the ReWire window in VST, as describ
above, new channels are added to the Audio Channel Mixer.

A few ReWire channels in the VST Audio Channel Mixer.

These have the following properties:

• The ReWire channel strips are red and appear in the far right of the Audio 
Channel Mixer, to the right of the group channels.

• ReWire provides mixed mono and stereo channels.

• The name of the ReWire channel is printed at the bottom of each strip, 
for identification.

• These channels are identical to regular VST audio Channel Mixer strips, 
except that they have no input. That is, they have all the fx, eq, bussing 
and automation facilities provided by regular hard disk recording chan-
nels.

• For information about how to set levels, panning, eq, fx and bussing, and 
how to create automation, see the Cubase VST documentation.
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Converting ReWire Channels to Audio Tracks
If you want to “convert” your ReWire channels into hard disk tracks, use the Ex
Audio feature in Cubase VST (see the Cubase VST operation manuals for de
Please note the following points:

• In the Export Audio dialog you have options for automatically reimport-
ing the created audio file onto a Track. See the Cubase VST documenta-
tion for details.

• The Export Audio function converts all unmuted audio channels to a 
stereo or mono mix. If you want to convert only your ReWire channels, 
mute all the hard disk recording Tracks.

• If you want a separate mono track for a particular ReWire channel, solo 
that channel and use the Export Audio function.

• Once you have converted one or more synth lines in ReBirth to hard disk 
tracks, you can reprogram the synths in ReBirth to add more. This allows 
you to layer practically infinite amounts of synth lines!

Considerations and Limitations

Sample Rates

ReBirth RB-338 is limited to 44.1kHz audio playback. If you have Cubase VST
to any other sample rate, ReBirth will play back at the wrong pitch.

Mac Only: No OMS in ReBirth

Currently, ReBirth RB-338 can’t use ReWire and OMS at the same time.When
Wire is running, OMS will be deactivated in ReBirth. Unfortunately this means y
can’t use MIDI Remote Control of ReBirth RB-338 for the Macintosh, while usi
ReWire.

Synchronization

All synchronization to other equipment is handled from Cubase VST, not ReB
In fact there are no special synchronization issues. All that is said in the Cuba
VTS documentation about synchronizing audio channels is true for ReWire ch
nels as well.

Play in Background

Do not deactivate Play in Background (on the Options menu in Cubase VST).
you do, the communication between the two programs will be lost.
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ASIO Drivers

ReWire works well with ASIo drivers. by using the Cubase VST bussing syste
you can route ReBirth sounds to various outputs on an ASIo compatible audio

Multi Processing

When running ReWire, multi processor support should be disabled in Cubase
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Cubase users – Read This!
This chapter does not apply to users of Cubase VST. If you are a Cubase use
do not need to worry about OMS, audio sharing and synchronization issues. P
refer to the chapter, “ReWire – Using ReBirth RB-338 with Cubase VST” on page 
101 instead.

Synchronization with Other Equipment

● Synchronization on the Macintosh computer requires you to have OMS in-
stalled.

What is Synchronization and MIDI Clock?

Synchronization, in this context, is when you make ReBirth play at the same te
as another device; where both start, stop and can locate to certain positions, 
er. This is done by transmitting MIDI Clock signals between ReBirth and the o
device. MIDI Clock is a very fast “metronome” that can be transmitted in a MI
Cable. As part of the MIDI Clock concept there are also instructions for Start, S
and locating to sixteenth note positions.

You can set up synchronization between ReBirth and hardware devices (tape
corders, drum machines, stand alone sequencers, workstations etc) and othe
puter programs running on the same or another computer.

Master/Slave

In a synchronized system there is always one master and one or more slaves.
case, the master is the one that controls the tempo. In other words, it is only th
po setting on the master device that is of any relevance, since the slaves slav
follow the master's tempo.

• ReBirth always acts as a slave. That is it receives MIDI Clocks, it never 
transmits them.

● Before you create any serious projects that require sync, try out the features 
described below and check out “Synchronization Considerations” on page 
117.
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Slaving ReBirth RB-338 to an External Device 

This example assumes you have an external device, such as a drum machine
ware sequencer, another computer, tape recorder etc, that transmits MIDI Clo
that you want to synchronize ReBirth to.

1. Connect a MIDI Cable from the MIDI Out on the other device to a MIDI 
In on the computer running ReBirth.

2. Set up the other device so that it transmits MIDI Clock signals to the 
MIDI Out you just connected to the computer running ReBirth.

3. In ReBirth, pull down the Edit menu and open the Preferences dialog.

4. In this dialog, pull down the Input menu in the MIDI Input section and 
select the MIDI Input to which you connected the MIDI cable from the 
other device.
On the Macintosh, if you do not understand which Input this is, or if that MIDI 
input doesn’t appear in the list, consult your OMS documentation for infor-
mation on MIDI interfaces, MIDI ports and naming.

ReBirth Mac set up to sync to MIDI Clock coming in via the Printer port on an Opcode Studio 
4 interface.

Under Windows, if you can’t find the MIDI Input you want to use, there is ei-
ther something wrong with the installation of the interface, or some other pro-
gram is holding on to it. Consult the documentation for the MIDI interface, 
the other program and Windows, for more information.

ReBirth Windows set up to sync to MIDI Clock coming in via the MIDI interface on a Sound 
Blaster card.

5. Close the dialog.

6. Activate Sync to MIDI Clock from the Options menu in ReBirth.

7. Activate playback on the other device.
ReBirth will start playing ‘in sync’ with it and the Sync LED on the Transport 
will indicate the beats.
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Macintosh Platform – Slaving ReBirth RB-338 to Another Program on the 
Same Computer, using OMS

ReBirth supports the OMS IAC (Inter Application Communication) system, wh
allows you to run MIDI Clock signals from another program to ReBirth.

1. Install OMS, and make sure that IAC gets installed properly.
This might require you to use the Custom install option. To verify, check the 
OMs folder in your System Folder, after installation. It should contain a file 
called “OMS IAC Driver”.

2. Make sure you have an IAC symbol in your OMS Setup document.
If not, create a new Studio Setup, and when you’re asked whether you want to 
use IAC, activate that option.

3. Open the OMS MIDI Setup dialog in OMS Setup and make sure that “Run 
MIDI In Background” is enabled.

4. Quit OMS Setup.

5. Set up the other program, so that it transmits MIDI Clock to one of its 
dedicated “program ports” or to the OMS IAC port.
It doesn’t matter which you choose. If you feel unsure about which port to 
use, select IAC. If you want use a “program port” make sure you launch the 
other application before you launch ReBirth.

6. In ReBirth, pull down the Edit menu and open the Preferences dialog.

7. In this dialog, pull down the Input menu in the MIDI Input section and 
select the MIDI Port you selected for Output in the other application.

ReBirth Mac set up to sync to MIDI Clock coming in via an OMS IAC port.

8. Close the dialog.

9. Activate Sync to MIDI Clock from the Options menu in ReBirth.

10.Activate playback on the other device.
ReBirth will start playing ‘in sync’ with it and the Sync LED on the Transport 
will indicate the beats.
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Macintosh platform – Slaving ReBirth RB-338 to a non-OMS Program on 
the Same Computer

If the MIDI program you use does not support the professional standard for M
on Macintosh computers, OMS, you can still set up synchronization, but this r
quires two MIDI interfaces, each connected to one of the serial ports on your 
puter.

1. Set up OMS so that it uses only one of the MIDI interfaces installed.

2. Set up the other application so that it uses the other MIDI interface.

3. Connect a MIDI cable from an output on the “other application” inter-
face to an input on the OMS-controlled interface.

4. Set up the other application so that it transmits MIDI Clock signals to the 
output you connected the cable to.

5. In ReBirth, pull down the Edit menu and open the Preferences dialog.

6. In this dialog, pull down the Input menu in the MIDI Input section and 
select the MIDI Port you connected the cable to.
If you do not understand which Input this is, or if that MIDI input doesn’t ap-
pear in the list, consult your OMS documentation for information on MIDI in-
terfaces, MIDI ports and naming.

7. Close the dialog.

8. Activate Sync to MIDI Clock from the Options menu in ReBirth.

9. Activate playback on the other device.
ReBirth will start playing ‘in sync’ with it and the Sync LED on the Transport 
will indicate the beats.
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Windows platform – Slaving ReBirth RB-338 to an Another Program on 
the Same Computer

ReBirth synchronizes to other programs on the same computer via a utility ca
”Hubi’s Loopback Device”. This utility is included on the ReBirth RB-338 CD-
ROM, in the folder “Hld” (Hubi’s Loopback Device).

Installing

1. Insert the ReBirth RB-338 CD-ROM into your computer.

2. Locate the folder “Hld” on the CD-ROM.

3. Find the file “How to Install HLD” in this folder, and double click on it.

4. Follow the instructions on screen.

Setting up the applications

With the ”Hubi’s Loopback Device” utility installed, you will find a number of ne
MIDI Inputs and Outputs in your MIDI applications. These are “invisible MIDI c
bles” that run between the MIDI programs on your computer.

1. In the other application, set things up so that it transmits MIDI Clock sig-
nals to the desired output (”LB1” if you haven’t renamed the MIDI 
“ports” in Hubi’s Loopback Device).

2. In ReBirth, pull down the Edit menu and open the Preferences dialog.

3. In this dialog, pull down the Input menu in the MIDI Input section, and 
select the corresponding Input (possibly “LB1”).
Now, ReBirth will receive MIDI Clock signals from the other application, via 
Hubi’s Loopback Device.

ReBirth set up to sync to MIDI Clock coming in via “LB1”.

4. Close the dialog.

5. Activate Sync to MIDI Clock from the Options menu in ReBirth.

6. Activate playback on the other device.
ReBirth will start playing ‘in sync’ with it and the Sync LED on the Transport 
will indicate the beats.

● Note that this makes the two programs play at the same time, that is, they both 
“run” when you “hit play”. It does not means they can both play audio at the 
same time. See page 123 for details about “sharing audio”.
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Synchronization Considerations

trimming Adjust Sync

Adjust Sync (Mac version)

Because of the latency problem described on page 182, you might need to adjust 
ReBirth RB-338’s playback in relation to the sync master, so that they are in pe
time. The tempo will not differ between the two, but ReBirth might play ahead
behind the other application. You might need to adjust this. However, this is so
thing you only need to do once. The setting is stored with your other preference
you don’t need to adjust it again.

Proceed as follows:

1. Set up the other application so that it generates a solid click, on for ex-
ample quarter or eighth notes, preferably with a special sound on the 
downbeat.
This click can either come from an internal metronome or from a MIDI 
source. If you use a MIDI source, make sure you pick one that has solid MIDI 
timing.

2. Set up ReBirth so that it plays a similar rhythm as the other application.
You might for example use the CB and CL sounds.

3. Start the two applications in sync.

4. Make sure you hear both applications at approximately equal level.

5. Open the Preferences dialog in ReBirth.

6. Trim the “Adjust Sync” setting until the “clicks” from the both sources 
sound at exactly the same time.

7. Close the Preferences dialog in ReBirth.
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About the beginning of the Song

Due to the latency phenomenon, described on page 182, ReBirth needs some time
to correct it’s playback speed when it first receives the Start command. This ca
noted as a small glitch in the audio playback, when the program starts. If this
problem, you need to insert a couple of empty measures at the beginning of t
Song. Proceed as follows:

1. Make sure you are in Song mode, in ReBirth.

2. Set up the Loop so that it starts at Bar 1 and is two Bars long.

3. Move to Bar 1, the beginning of the Song.

4. Select Copy from the Edit menu.

5. Select Paste from the Edit menu.
You now have two more measures at the beginning of the Song. Let’s make 
them silent:

6. Activate recording, but not playback.

7. Deactivate all three sections, in the Pattern selector.

8. Move the Song Position to Bar 2.

9. If required, deactivate all three sections in this measure too.

10.Deactivate Recording.

11.Set up the other device/application, so that it also plays two empty bars 
at the beginning.

About MIDI Song Position Pointers

MIDI Clock actually consists of five type of messages: The actual clock (the m
ronome that establishes the tempo), Start, Stop and Continue commands and
Position Pointers. This last type of message contains information about positi
so that a program for example “knows” where in a Song to start playback from

Normally, this ensures that you can locate to any position and activate playba
from there. In older devices, Song Position Pointers might not be implemented.
means that you will be able to synchronize properly only if you start both devi
from the absolute beginning of the song.

About Tempo readouts

If the other program/device also has a tempo display, you might note slight di
ences in tempo readout between ReBirth and the other device/application. Th
normal, especially if the other is an external device, and does not mean the two do 
not sync properly. MIDI Clock does not contain numeric information about wh
tempo to play in. Rather, the tempo has to be calculated by the receiving devic
measuring the pace the clock signals are coming in at. Just like with two watc
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there will always be minor differences in their “speed”.

About Tempo Changes

Again, due to the latency phenomenon, ReBirth RB-338 needs a bit of time to
just to changes in tempo. If there are abrupt changes in the MIDI Clock, due t
drastic tempo changes on the master, you will note that ReBirth RB-338 will r
quire up to one measure to adjust itself to the change. How long this actually 
also depends on the precision of the incoming MIDI Clock. The more precise 
the faster ReBirth can adjust to it.

If this adjustment is a problem, try to use gradual tempo changes rather than 
diate ones.

Also note that drastic tempo changes might introduce “clicks” in the output fro
the Delay unit in ReBirth.
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Using “Live Sync”

Background Information

What is commonly referred to as “MIDI Clock” is actually four different types o
MIDI messages:

• Start and Stop
These are the messages sent out when you Start and Stop your sync master.

• Song Position pointers
These are messages used for sending out positions, so that a slave can deter-
mine where in a Song to start from. If you for example fast forward your mas-
ter to bar 80 and hit play, ReBirth will also start from bar 80.

• The actual clock messages.
Once playback is going, the only messages that are sent are the actual clock 
messages, that allow the slave to play in the same tempo as the master.

ReBirth RB-338 responds correctly to all these messages. Understanding the 
ence between them will help you make the most out of the live sync feature in
program, see later in this chapter.

The Sync and MIDI LEDs

The MIDI LED

The MIDI LED indicates the program is receiving MIDI data.

The MIDI LED on the front panel lights up on all types of MIDI messages, incl
ing MIDI Clock. This means that if this is lit, MIDI clock messages are actually
coming in on the MIDI port specified in the Preferences dialog. This can be us
for determining whether the MIDI ports are set up correctly and whether the m
is actually set to transmit MIDI Clock messages.

● Most devices (but not all) transmit MIDI Clock messages even when in Stop 
mode. This means that if the Master is set to transmit MIDI Clock, the MIDI 
LED on the ReBirth transport panel might be lit constantly, regardless of 
whether the master is playing or not. This is completely normal!
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The Sync LED

The Sync LED indicates the program is in sync with another program or device.

The Sync LED shows the status of the incoming sync and provides a visual in
tion of the bar position. It blinks red on the downbeat and green on all other b

This LED is only operational when the master has been started. This is an ind
tion that ReBirth is in sync mode. Again, this can be used for troubleshooting:
you get an indication on the Sync LED but still have no sync, there can only be
reasons:

• Sync to MIDI Clock is not activated on the Options menu, (or in the Pref-
erences dialog), or...

• You have hit Stop on the ReBirth transport panel. Hit Play again.

Stopping, Starting, and Opening Songs in Sync mode

When ReBirth RB-338 has received a Start message it is by definition “in sync
til it receives a Stop message from the master.

You can hit Stop on the ReBirth transport panel, but the program will keep coun
clocks “in the background”. This allows you to:

• Hit Stop, wind the Song Position to any position in the Song and hit Play 
again.
Playback will start again on the next downbeat.

• Switch to another Song window, move the Song position to any position 
and hit Play.
Playback will stop immediately in the Song that is now playing, and will 
resume in the current Song document, at the next downbeat.

• Open a Song document, move the Song position to any position and hit 
Play.
Opening another document does not affect playback. Not until you hit Play 
does the newly opened document actually start playing (at the next down-
beat).

● Windows 95 users might experience short audio playback glitches while Song 
documents are being loaded from disk. The risk of this happening depends on 
a number of factors; among others the speed of your computer and hard disk 
and the size of the audio buffers as set in the ReBirth Preferences dialog (the 
larger the safer). If this is a problem, open all Songs you intend to play back, 
before you start your “syncing session”.
- 121 - 



 like 
osi-
r 80, 
irth 

g or 
irth, 

ill 
po as 
Repositioning the Master

As described above, you can Start and Stop ReBirth RB-338 as much as you
during playback. This will naturally introduce a difference between the Song p
tions in the master and in ReBirth. For example, when the master indicates ba
ReBirth might be playing bar 12 or 257, all depending on your use of the ReB
transport panel.

However, if you change the Song position on the master, for example by windin
rewinding, it will most likely send out a Song Position Pointer message to ReB
which will adjust itself so that the two program play the same measure.

When the Master Device is in Stop mode

If you Stop the Master, you can still activate Playback in ReBirth RB-338. It w
then play in the tempo set on the Transport bar, not necessarily the same tem
the master is set to.
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Running multiple Audio Applications on one Computer
You might want to run ReBirth RB-338 together with another audio application
the same time. Since ReBirth synchronizes, you might for example want to ru
“in tandem” with an audio sequencer. Exactly how to do this depends on your 
puter configuration and the platform you are on.

Windows

Under Windows, two applications normally do not share an audio card. If you
launch two applications, one of them will “grab” the audio card, which means 
other will stop sounding.

How can I make ReBirth RB-338 and another application play audio at the 
same time?

There are three ways:

• Use two audio cards. You can then assign one to ReBirth (see the installa-
tion instructions) and one to the other audio application.
However, this assumes the other application does not “grab” all the audio 
cards in your computer. Please refer to that program’s documentation for de-
tails.

• A few audio cards can mix the audio from several applications. An exam-
ple of such an audio card is Terratec EWS-64. This card “fools” Windows 
into thinking there is more than one card installed into the system. If you 
have such a card, you can set up both applications to use it.

• If all applications are compatible with DirectX 3 or later and support the 
“secondary buffer feature” in DirectX (see page 183), they can all 
“share” one audio card.
ReBirth of course fulfils both these DirectX requirements.

A note about background playback

If you access the audio card via DirectX version 2, ReBirth will not be able to p
in the background. That is, as soon as you switch to another application, ReB
will stop sounding.
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Macintosh

ReBirth RB-338 plays audio via the standard audio procedures on the Macint
called the Sound Manager. The Sound Manager has the ability to mix audio f
several applications. This means that if you run ReBirth together with another
dard audio application, the audio from both will automatically be mixed and will
pear at the stereo outputs on the computer.

If the other application uses special audio routines, that “grab” the sound on t
computer, ReBirth will not be able to play.

Some audio applications that use audio cards installed into the computer, acc
these cards directly (as opposed to using the Sound Manager). If you run suc
application, you can still play audio from both applications at the same time. R
Birth uses the Sound Manager (the audio appears on the standard Macintosh
puts) and the other application uses the sound card.

Using “Export Loop as AIFF/Wave” to Overcome the “One Audio Card 
Only” Problem.

If you only have one audio card, or for other reasons can not get ReBirth RB-3
play at the same time as another audio program, there are still ways to integra
audio from the two applications:

1. Create a Song in ReBirth.
You can do this either without running any other application at the same time, 
or while being synchronized with another application, only utilizing its MIDI 
capabilities, so that ReBirth has access to the audio on your computer.

2. Export the ReBirth Song as an audio file (see page 142).

3. Quit ReBirth.

4. Import the audio file into the other application, as a stereo audio track.

5. Continue working on the Song in the other program. If you need to make 
changes in the ReBirth material, either use the editing capabilities of the 
other program, or go back into ReBirth, make the necessary change, ex-
port the file and re-import into the other program, replacing the previous 
ReBirth track.

About differences in tempo between applications

Computer applications handle tempo in different ways. Some drive their temp
from the clocking of the digital audio (ReBirth RB-338 uses this method) while
other programs use other types of timing methods. This means that when you
two applications to 120 BPM (without any synchronization between them) and
start them at the same time, they might tick away at slightly different speeds, 
if they run on the same computer.

For this reason, an audio file generated in ReBirth at a certain tempo, might n
play back in perfect time with the material in the other program, even if they pla
the same tempo.
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To get around this, use the other application’s tempo adjustment methods to m
the material already present in the other program to the audio file.
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Introduction
This feature allows you to control practically all parameters on the ReBirth pa
via MIDI. This can be used either as a way of playing ReBirth RB-338 “live” o
when you want to control it via a MIDI sequencer, rather than using ReBirth’s
built-in automation.

Standard Mapping vs Quick Mapping

There are two major modes for Remote MIDI control, which you can select be
tween from ReBirth’s Preferences dialog:

Standard Mapping

This is the preferred mode for those with advanced MIDI setups, for example 
programmable fader panels etc.

Quick Mapping

This is the preferred mode if you want to control the most common parame-
ters, for example from your keyboard synth’s wheels and pedals.

More on these modes later in this text.

About MIDI Channels and Inputs

The MIDI Input and Channel settings in the Preferences dialog are used to de
mine which external device should be used for Remote MIDI control.

● ReBirth RB-338 only receives MIDI messages, it does not transmit any MIDI.
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Setting up Remote MIDI Control from External MIDI 
Hardware

If you have some MIDI device connected to your computer that you want to us
controlling ReBirth RB-338, proceed as follows:

1. Set things up so that the device you want to use for transmitting MIDI 
messages is connected to the desired MIDI input.
Please note that if you want to synchronize ReBirth at the same time as using 
Remote MIDI Control, you must set things up so that the synchronization 
messages come in on the same MIDI input as the controller messages.

2. If you are running ReBirth on a Macintosh computer, create a device in 
OMS setup that corresponds to your external MIDI device and save your 
setup.
See the OMS documentation for details.

3. Launch ReBirth.
If you run ReBirth on a Macintosh it is important that you launch ReBirth after 
making changes to OMS, or the changes you have made will not be available 
in ReBirth.

4. In ReBirth, open the Preferences dialog.

The MIDI section of the Preferences dialog (Macintosh version shown here).

5. Activate Remote MIDI Control.

6. Select the MIDI Input port and MIDI channel that your controller is 
transmitting on.

7. Choose Standard or Quick Mapping, and if required, click the Edit button 
to set up the Quick mapping.
The details on these modes and the Quick Remote MIDI Mapping dialog are 
described on page 130 and onwards.
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Setting up Remote MIDI Control from another Program
If you have another program running on the same computer, that you want to
for controlling ReBirth RB-338, proceed as follows:

1. Set up the other program so that the Tracks you want to use for control-
ling ReBirth transmit to a MIDI port and MIDI channel that ReBirth can 
receive on.
If you are running ReBirth RB-338 on the PC this will probably be one of the 
ports added to your system by HLD (Hubi’s Loopback Device – see page 116). 
If you are using a Macintosh, this will be an OMS IAC port (page 114).

2. Launch ReBirth.

3. In ReBirth, open the Preferences dialog.

4. Activate Remote MIDI Control.

5. Select the MIDI Input port and MIDI channel that the other program is 
transmitting on.

6. Choose Standard or Quick Mapping, and if required, click the Edit button 
to set up the Quick mapping.
The details on these modes and the Quick Remote MIDI Mapping dialog are 
described below.
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Standard Mapping vs Quick Mapping

Standard Mapping

In the Standard Mapping mode practically all controls can be accessed. Howe
this mode more or less assumes you have access to a special hardware or so
control panel, where the controls can be programmed to send arbitrary MIDI 
sages. Since there is such a multitude of controls available in Standard Mapp
mode, accessing them from for example a normal synth keyboard or master k
board, with only a few sliders, becomes ergonomically difficult.

The MIDI implementation used in Standard mode can be found on page 193 and 
onwards.

Quick Mapping

Quick Mapping, on the other hand, is perfect for those with limited MIDI equip
ment. Even if you only have access to a modulation wheel on your synth, it ca
put to good use when recording knob movements in Song mode or when play
live.

How to set up the relation between your controller devices and ReBirth’s funct
is described in the next paragraph.
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Setting up Quick Mapping
1. Setup Remote MIDI Control as described earlier in this chapter.

2. Open the Preferences dialog and make sure Quick Mapping is selected.

3. Click the Quick Mapping Edit button.

The Quick Mapping dialog (Macintosh version).

Manual Setup

1. Select a function you want to use, from the set of pop-up menus.

2. Click in the field to the right of the pop-up and type in the number of the 
controller message you want to use.

Using Learn

1. Select a function that you want to use, from the set of pop-up menus.

2. Move the controller you want to use for this function.
The field at the bottom of the dialog shows the number for this controller. If it 
doesn’t, this is an indication your MIDI connection is not set up correctly. See 
Checking Your Setup, below.

3. Click the Learn button associated with the function you want to use.
This controller number is entered in the corresponding value field.

Checking your Setup

There are a few techniques you can use to check that your setup is done corr
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• Use the MIDI LED on the Transport panel.
This responds to on all MIDI messages except System Exclusive. If it lights up, th
means some type of MIDI data on some MIDI Channel is coming in on the MIDI 
port selected in the Preferences dialog. If this doesn’t light up, check your othe
vice, your MIDI interface and your MIDI port setup (Macintosh users should ch
OMS Setup).

The MIDI LED indicates incoming MIDI data.

• Changes that you make in the Quick Mapping dialog are effective imme-
diately, even while the dialog is up on screen.
This means you can have playback going while you set up the Quick Mapping 
dialog. Make sure you are in Pattern mode and check your mapping as you go 
along.

• The controls move on the screen when they receive MIDI messages, even 
when the dialog is up on screen.
This can be used as visual feedback. If a control moves, it is mapped correctly.
- 132 - 



 in 
Using Remote MIDI Control
Once your Remote MIDI Control connection is up and working it can be used
numerous ways:

• To run the program “live”, in Pattern or Song mode.
See the tips on live usage on page 87.

• To record your Song automation in a more natural way than when using 
the mouse.
This is convenient even if you only have a couple of MIDI controllers to use at 
a time. After each recording pass you can open the Quick Mapping Edit dia-
log and map those controllers to other functions in the program.

• As a way of completely controlling ReBirth from an external hardware 
device.
This assumes you have a very advanced hardware controller with many but-
tons, knobs and faders.

• To record parts of, or all of your Song automation in another program.
You would then remain in Pattern mode but send Pattern changes and control 
messages from the other program. Essentially, you then move all of the Song 
mode functionality over to the other program.
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Important Notes about MIDI Control
• There is only one MIDI input port to the whole program.

If you want to synchronize and control knobs, etc – all at the same time – you 
have to make sure both the MIDI clock signals and the controller data is sup-
plied on the MIDI Input selected in the Preferences dialog. Use the MIDI LED 
on the transport bar to check whether any MIDI data is coming in via the se-
lected port.

• Only one MIDI Channel is used at a time.
All Controller data must be transmitted on the same MIDI Channel, the one 
selected in the Preferences dialog.

• Only MIDI Control Change messages are received in Quick Mapping 
mode.
Do not confuse Control Change messages with other, similar types of MIDI 
messages, such as pitch bend, aftertouch, key pressure etc.

• ReBirth only reads OMS ports on startup.
Macintosh users should be aware that your OMS configuration is only 
checked when you launch ReBirth. Any changes made to your OMS Setup 
will not take effect until you Quit ReBirth RB-338 and launch it again.

• Minimize Latency!
As described in the main ReBirth manual, there is a short delay between the 
moment when you move a control with the mouse and when this takes effect 
on the sound output. This is called latency. Exactly the same delay affects Re-
mote MIDI control. Make sure the sound buffer settings in the Preferences di-
alog are adjusted to the lowest possible values, as described in the main 
ReBirth manual.
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New Songs – Changing the Default Settings
To create a new “blank” Song, select New from the File menu.

New songs can either use default settings for Patterns and controls, or you ca
tomize the settings so that New Songs appear just as you want them:

Customizing

1. Set up a Song so that it is exactly as you want New Songs to be.

2. Open the Preferences dialog.

3. Click the “Use Current Song” button at the bottom of the dialog.

4. Close the dialog.

The Default Song plays a number of “factory Patterns” intended to get you sta
with the program. To “silence” a Pattern, click the Clear button in the relevant s
section.

When you get better acquainted with the program you might want to customize
described above. One quick way of doing this is to load one of two Song files
cated in the ReBirth folder, and then use the “Use Current Song” feature desc
above:

• “ReBirth 1.0 Default Song”. This makes the program behave as in version 
1.0. New Songs play silent rhythm Patterns and repeating 16th note synth 
Patterns.

• “Silent Default Song”. This contains all silent Patterns.

Mod selection for New Songs

When you first launch the program, New Songs that you create will use the st
ard ReBirth panel. After that, New Songs will use the same mod as you last s
lected.
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Saving Songs
When you save your Song, using the Save and Save As commands, you save
Patterns, all settings in Pattern mode, the entire Song and which Mod was us
in one file.

The file dialog used for saving is the standard Windows/Macintosh one. For de
about saving, hard disks, floppy and other media, see the manual that came 
your computer and storage devices.

The Song Information Feature

If you like you can enter information about your Song. This is useful for examp
you intend to distribute your files via Internet and want to make people aware
who the creator is.

Filling in the Dialog

1. Select Song Information from the File menu.

2. Fill in the three fields:

• Text in Window Title will always appear in the Song window title.

• “More Information” and “Creator’s web page” will appear in the Informa-
tion dialog and in the “splash screen” that appears when you load the 
Song (if Show Information...” is activated, see below”).

3. If you like, activate “Show Information on Song Open”.
This ensures everybody will see the information when they load the Song.

Linking to the Song creator’s web page

If the Song creator has entered a URL to a web page, you can launch your pre
web browser and display the page. Proceed as follows:

1. Open the Song Information dialog.

2. Click on the Browse button.
On the PC, your default browser launches directly. On the Macintosh you 
have to select a browser in a dialog. In either case, the browser takes you to 
the specified web page.
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Opening Songs
• Using the Open Dialog

You can of course open saved Song files using a regular Open dialog.

• Using Drag and Drop
ReBirth supports standard Drag and Drop features on each platform.

• Using The Recent Documents Menu Items
There is a “recent documents” section on the File menu. This lists the four 
most recently opened Song files. Selecting one re-opens that file.

Mod Note

Please note that a Song may require a Mod that is not installed on your syste
this happens, you will be given various options, one being to download the M
from the Internet. See page 92 for details.

Macintosh Memory Note

If you can’t open a Song, this is probably because you haven’t assigned enou
memory to the program. This is especially true if the Song uses another Mod
your currently open Song(s) do. Proceed as follows:

1. Quit ReBirth.

2. Locate the ReBirth RB-338 icon in the Finder and select it.

3. Select Get Info from the File menu.

4. In the dialog that appears, assign more memory to the program.
For exact details on this dialog, see your Macintosh manuals. Exactly how 
much memory you can assign to the program depends on the amount of 
memory installed in your Macintosh.

● Avoid assigning the program so much memory that none is left for the system 
once ReBirth RB-338 and other programs are running. The Sound Manager 
(the routines in the Macintosh that handle audio) require that some system 
memory is left unused after all applications have been launched.

Switching between Windows

You can have as many Song documents open as you like, or as memory per
However, only one of them can play back at a time.

You can switch between windows by clicking on them, or by using the Window
menu. This does not affect which window is playing back. Not until you click t
Play button in the active Song window does that Song start playing.
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Switching to Other Programs

As described on page 123, ReBirth RB-338 can play “in the background”, if som
basic criteria are met. This means that the current Song will keep playing eve
you switch to another program.

Stay on Top (Windows only)

The Windows version of ReBirth RB-338 has an item on the Windows menu, ca
“Stay on Top”. When this is activated, the ReBirth window will always stay on 
of other program’s windows. This is intended mainly for when you sync ReBirt
another music program. Since the other program is always the Master, you wi
its transport panel for playing and stopping. Activating this function ensures y
can do this without having your ReBirth windows hidden behind other window

Copying and Moving Patterns between Songs
Since there is no Pattern file format, only the Song format, it might not be obv
how to Copy and move Patterns between Songs. This is done using Cut, Cop
Paste, as described on page 51.
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Moving ReBirth Song files and Mods between Macintosh 
and PC Computers

Moving ReBirth RB-338 files between Mac and PC platforms is easy. As with 
file, getting it from the Mac to the PC or vice versa, requires some kind of port
media (DOS-formatted floppies for example) or a network. However, once the
is on the desired computer disk, the following applies for loading it into ReBirt
RB-338:

Loading Mac files on the PC

Songs

On the PC, Song files must have the extension “.rbs”. This allows you to doub
click the file to open it, and it will have the right file icon.

Mods

Mod files must have the extension “.rbm” to be recognized properly.

Using PC files on the Mac

Song

On the Mac a Song file must meet at least one of two criteria:

• File Type “TSSQ” and Creator “ReBi”.
This ensures the file has the right icon. However, changing the File Type and 
Creator requires special software, see below. Ask your computer dealer if in 
doubt.

• File extension “.rbs”.
This will allow you to open the file, but it will probably not have the right icon 
in the Finder.

• Regardless of whether the file has the right icon or not, you can always 
open it using the Open dialog in ReBirth or by using Drag and Drop.

• However, if the file doesn’t have the right icon you can not open the file 
by double clicking it in the Finder.

When you re-save a file it automatically gets the correct File Type and Creato

Mods

• Mod files should always have the file extension “.rbm”.
This will allow you use the Mod. However, it may still have the wrong icon in 
the Finder.

• To ensure the file has the right icon in the Finder, make sure it has the File 
Type “ RBM” and Creator “ReBi”.
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Setting the File Type and Creator

There are numerous ways of setting the File Type and Creator of files brought
a PC to the Mac. Let us just mention two:

• Using PC Exchange.
This utility is included with every Macintosh computer. It allows you to set up 
“mapping”, so that when a DOS formatted floppy disk (and some other types 
of media) is inserted, files with a certain extension are automatically given the 
correct File Type and Creator.

• Using ZipIt.
This shareware program can be used for unpacking files archived in the com-
mon PC format, “Zip”. ZipIt can be set up so that when a file with a certain 
extension is extracted from an archive, it automatically gets the desired File 
Type and Creator.
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Exporting Songs and Patterns as Audio (AIFF/Wave) files
You can save your entire Song, or parts of it, as an audio file. This file can be
AIFF (Audio Interchange File Format – the standard audio file format on the M
intosh) or Wave (“WAV” – the standard audio file format on the PC). Proceed
follows:

1. Make sure you are in Song mode.

2. Set up the Loop so that it encompasses the part of the Song you want to 
convert.
This can be a Loop of any Length, from a one bar Pattern to the whole Song. If 
you want to export the whole Song, remember to include some extra bars at 
the end, so that any repeats from the Delay section get included.

3. Select “Export Loop as Audio File” (PC) or “Export Loop as AIFF/Wave 
file” (Mac) from the File menu.

4. Specify a name and location for your file.
On the PC platform, select a file format (AIFF or Wave), from the pop-up at the 
bottom of the dialog.

5. Click Save.

● Audio files are relatively big! For example, a three minute Song will occupy 
over 30 MBytes of hard disk space.
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Song Mode/Pattern Mode

This switches ReBirth RB-338 between its two major modes: Pattern mode a
Song mode. The two modes have major differences. Below we will list the pro
ties for each one, in list form:

Pattern Mode

• Is designed for programming the synths and rhythm sections.

• The Fast Forward and Rewind controls are not used.

• Always loops the selected Patterns.

• The Record button isn’t used.

Song Mode

• Allows you to build a complete Song by recording Pattern changes and 
knob movements.

• Introduces the loop feature which allows you to repeat any section of the 
Song infinitely.

MIDI Indicator

This “LED” lights up to indicate incoming MIDI messages. It reacts on all MID
messages except System Exclusive. Use this as a visual indication that your 
setup is done correctly.

Tempo control 
and display

Switches 
between 
Song and 
Pattern mode

Displays the Song 
Position and 
allows you to 
move in steps of 
one bar

Define where the 
Song Loop Starts 
and Ends

Play Stop Moves the Song 
Position ten bars 
forward

Moves the Song 
Position ten bars back

Record - for recording 
Pattern changes and 
controls in Song mode

Song Loop On/OffShows MIDI 
In activity

Indicates that 
ReBirth is in 
Sync with 
another device

Shuffle 
Amount
- 144 - 



 one 
 is 

l-
, with-

nge 

ire), 
er 

de. If 
ack/

“con-

 the 
Sync Indicator

This “LED” indicates incoming MIDI sync. It blinks red on the downbeat and 
green on all other beats. Use this as an indication that the master device (the
transmitting the MIDI Clock messages) is actually started and the MIDI setup
done correctly.

This indicator is also used in conjunction with the “Live Sync” feature, which a
lows you to start and stop ReBirth and even switch between Song documents
out losing sync. See page 120 for details. 

Tempo

Here you can set the tempo for your Song in “bpm” (beats per minute). The ra
is 20 to 500 bpm (80 to 160 is a “normal” range of tempos).

When ReBirth is synchronized to another device (including when you use ReW
this setting is of no importance, since ReBirth will play in the tempo of the oth
device.

Bar Display

This shows the current position in bars (measures). Only relevant in Song mo
you click one of the arrow buttons the Song Position is moved one measure b
forward. If you keep the mouse button down, it scrolls continuously.

Play

This activates playback. If you are in Song mode, this should be thought of as 
tinue play”, that is it will start playback from the current position.

Stop

• When you click this during playback, the program stops.

• If the program is already stopped, the Song Position moves to the Loop 
Start.
There's an exception to this: If the Song Position is already at an earlier posi-
tion than the Left Locator, it moves to the beginning of the Song.

• If you click one more time, the Song Position moves to the beginning of 
the Song.
In other words, clicking three times always moves you to the beginning of the 
Song.

Rewind

Every click on this button moves the Song position ten bars back. If you keep
mouse button pressed, it rewinds continuously.
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Fast Forward

Every click on this button moves the Song position ten bars forward. If you kee
mouse button pressed, it fast forwards continuously.

Record

This button is used for recording Pattern changes and knob movements in So
mode. It has no function in Pattern mode.

Loop On/Off

When this is activated, the section specified by the Start and Length settings 
Looped.

Loop Start and Length

The Loop start is the bar where you want looping to start.

The Length setting is the number of bars you want looped.
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Pattern Section

Bank and Pattern Selectors

These are used for selecting between the 32 Patterns available for each sect
each Song.

• To select another Pattern, in the same Bank, simply click one of the Pat-
tern buttons.

• To switch to another Pattern in another Bank, first select the Bank, then 
the Pattern.

No Pattern gets selected until you click one of the Pattern buttons 1 to 8.

You can also switch Patterns from the computer keyboard, see page 20 and page 
222.

Step Display and Setting

This is used for setting the length of the Pattern, in steps of 16th notes. This c
done at any time and affects playback immediately.

You can even have different Pattern lengths for different sections. Each one l
independently. Different Patterns can have different lengths.

Shuffle On/Off

When this is activated, this section will play with a shuffle rhythm as opposed
straight timing. Exactly how much Shuffle is applied is determined by the Shu
knob on the Transport, which is a global setting for all sections. See page 21 for 
more information.

Selects between the eight 
Patterns in a Bank

Selects between 
the four Banks of 
eight Patterns

Used for deactivating 
the section. Essentially 
the same as an empty 
Pattern

Allows you to set the 
Length of the Pattern, in 
16th note stepsActivates Shuffle 

for this section
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808 Rhythm Section

Sound Selector

This knob is used for selecting between the main sounds.

For more info about selecting sounds, see page 28.

For information about the “shared instruments”, see page 34.

The white knobs are 
used for adjusting the 
various sound 
parameters

Click on the light 
instrument legends to select 
an instrument

The red knobs set 
the levels of the 
individual sounds

The colored step 
buttons are used 
for programming 
the selected 
instrument into the 
Pattern

The large knob is used 
for selecting instruments
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Sound Switches – About the “Shared Instruments”

As stated in the table above, some instrument ”slots” can only play one of two
sounds. In these cases, there’s a small switch that allows you to select which 
will be played by this instrument “slot”. You can flick the switch any time. Wha
ever is programmed for this “instrument slot” will be played by the sound sele
at that time.

Tone

This knob adjusts the “color” of the sound. Exactly in which way depends on 
sound, but the higher the setting, the “brighter” the sound.

Decay

This adjusts the length of the sound. The higher the setting, the longer the so

Legend Name Comment

AC Accent This is not a sound, but rather a way to control dynamics. 
The steps where Accent is activated will be louder. Ex-
actly how much louder is determined by the Accent 
Level control. This control has equal effect on all sounds.

BD Bass Drum Has Tone and Decay controls.

SD Snare Drum Has Tune and Snappy controls.

LT Low Tom Has a tune control. “Shared” with Low Conga.

MT Middle Tom Has a tune control. “Shared” with Middle Conga.

HT High Tom Has a tune control. “Shared” with High Conga.

LC Low Conga Has a tune control. “Shared” with Low Tom.

MC Middle Conga Has a tune control. “Shared” with Middle Tom.

HC High Conga Has a tune control. “Shared” with High Tom.

RS Rim Shot  “Shared” with Claves.

CL Claves  “Shared” with Rim Shot.

CP (Hand) Claps  “Shared” with Maracas.

MA Maracas  “Shared” with Claps.

CB Cowbell No comment...

CY Cymbal Has a Tone and Decay Control.

OH Open Hi-hat Has a Decay Control. Is cut off by the Closed Hi-hat.

CH Closed Hi-hat Cuts off the Open Hi-hat. If you have both open and 
closed Hi-hat on one step, you will hear an open hi-hat 
with an extremely short decay.
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Tune

This adjusts the pitch of the sound. On the Snare Drum it only affects the “tone”
of the sound, not the “noise” part.

Snappy

This is only available for the Snare Drum. It is actually a level control for the 
“snare” (noise) part of the sound. The higher the setting, the more of the “snare
will hear.
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909 Rhythm Section

Sounds

Level

This is simply the volume for the sound.

Legend Name Comment

AC Accent This is not a sound, but rather a way to control dynamics. 
The steps where Accent is activated will be louder. Ex-
actly how much louder is determined by the Accent 
Level control. This control has equal effect on all sounds.

BD Bass Drum Has Tune, Attack and Decay controls.

SD Snare Drum Has Tune, Tone and Snap controls.

LT Low Tom Has Tune and Decay controls.

MT Middle Tom Has Tune and Decay controls.

HT High Tom Has Tune and Decay controls.

RS Rim Shot Has no sound controls.

CP (Hand) Claps Has no sound controls.

CH Closed Hi-hat Has a Decay control. Shares Level with Open Hi-hat. 
Cuts off the Open Hi-hat. 

OH Open Hi-hat Has a Decay control. Shares Level with Closed Hi-hat.Is 
cut off by the Closed Hi-hat.

CC Crash Cymbal Has a Tune control.

RC Cymbal Has a Tune control.

Use the knobs to adjust 
volume and various sound 
parameters

When this is activated, 
the step buttons are 
used for programming 
flam hits

Click on a legend to select 
an instrument

The step buttons are used to program the 
selected instrument into the Pattern. Click 
twice to get an accented hit.

The Flam knob is 
used to adjust the 
length of flam hits.
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Tune

This is the pitch of the sound, the tuning. For the snare, please note that this 
affects the “body” of the sound, not the “rattle”.

Tone

This is a decay control for the snare “rattle”. The higher the setting the longer
sound.

Dec(ay)

This adjusts the length of the sound.

Snap(py)

This is only available for the snare. It adjusts the balance between the “body” o
sound and the “rattle”.

Att(ack)

Adjusts the “click” in the beginning of the 909 bass drum.

Flam Button and Knob

• When the flam button is activated, steps that you activate will be played 
as flams (two hits very close to each other).

• You can adjust the “width” of the flam using the Flam knob.
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Synth Section

Pitch Mode

• When this is activated, the sequencer will automatically advance to the 
next step as soon as you select a pitch, using the Pitch buttons.

• When this is deactivated, the sequencer never advances automatically to 
the next step.

• If you deactivate and then immediately activate Pitch mode, you return 
to the first step in the Pattern.

Clear

This Clears the Pattern completely. This means all steps are set as follows:

Pitch buttons

These are used for specifying a Pitch for the selected step.

Function Setting

Pitch Low C

Note/Pause Pause (no sound!)

Down Off

Up Off

Accent Off

Slide Off

These controls are used 
for adjusting the sound

Click these buttons to set 
the pitch for the step

Selects between two 
waveforms, Square 
and Sawtooth

Pitch Mode 
On/Off

Various buttons 
for programming 
a step (see 
below)

This shows you which 
step in the Pattern you 
are programming

Clears the 
Pattern
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Down

This transposes the pitch of the selected step down, one octave.

Up

This transposes the pitch of the selected step up, one octave.

You can activate both Up and Down at the same time, if you wish. However, th
the same as activating none of them.

Accent (button)

This activates Accent for the selected step. For more information on what effec
cent has, see the Accent knob, page 156.

Slide

When this is activated, the selected step will be tied to the next (legato – no “r
gering”) and the pitch will slide continuously to that of the next step. For a mo
thorough explanation of how Slide works, see page 45.

Note/Pause button and indicators

This is used for specifying whether the selected step will sound or not.

Back

This takes you to the previous step in the Pattern. When you are at the first ste
takes you to the last step in the Pattern.

Step

This takes you to the next step in the Pattern. When you are at the last step, thi
you to the first step in the Pattern.

Step display

This indicates which step you are currently at, when entering notes. This cha
when you press Next or Back or when you specify pitches in Pitch mode. It doe
move on playback.
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Waveform

This allows you to select between two waveforms for the synth oscillator:

Tune

This allows you to set the tuning of the synthesizer. The range is two octaves
steps of one semitone.

Cutoff

This sets the basic cutoff frequency for the filter. The higher this setting, the brig
the sound. This is the basic filter setting. The final filter curve is determined by o
settings, like Env. Mod, Decay and Accent.

For a more thorough description of the filter section, see page 48.

Reso

This also determines the character of the sound. The technical explanation is 
routes the output of the filter back into the input, in a “feedback” loop. This kn
determines the amount of feedback. The higher the sound, the more of the ty
hollow character you will get.

Env. Mod

This determines the amount of effect the filter envelope has on the filter settin

• In its lowest position, the envelope has little effect on the sound.

• At higher values, the envelope makes the filter open further, that is the 
sound will be brighter.

Decay

The higher this setting, the longer it will take for the notes to decay.

Symbol: Name: Description:

Sawtooth This is a full and rich waveform where all harmonics are in-
cluded.

Square This waveform only contains odd harmonics, which gives 
the sound a more “hollow” quality.
- 155 - 



itch ac-

s, see 
Accent (knob)

This determines the amount of change to those steps that have the Accent sw
tivated.

• Steps with Accent will be perceived as shorter, louder and with a slightly 
different tonal character than other steps, when this setting is increased.

• When this knob is all the way down, steps with Accent will only be 
shorter.

For more information on the relationship between Accent and other parameter
page 49.
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Mixers

On/Off switch

This turns the output of the relevant section on/off.

Meter

This shows the output level from the section. Use this as a diagnostic tool if the
from a section is very low or if you don’t hear it at all. If this meter shows any i
cation at all, the section is playing. 

Volume fader

This determines the level of the output from the relevant section. Use this to ba
the relative levels between the synths and the rhythm section.

● Please note that as you increase levels you might run into distortion. To com-
pensate for this, use the Master fader. See page 24 for more details about lev-
els and “clipping”.

Pan

This determines the section’s position in the stereo image.

The range of the parameter is fully left (L), through centre (“twelve o'clock”) to
fully right (R).

Delay

This determines the amount of delay (echo) to be added to this section. The f
amount of delay is determined by a number of other settings in the actual Dela
tion. See page 69 for details on how to use the delay.

Output meter

Volume fader

Mute/unmute. Not part 
of the Song automation!

Delay amount for 
this section

PCF on/off

Pan

Distortion on/off

Compression on/off
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Dist

This is a switch which routes the output of this section through the Distortion (D
unit. For more information on how to use the Distortion effect, see page 59.

PCF

This is a switch that routes the output of this section through the PCF (Pattern
trolled Filter) unit.

Comp

This is a switch which routes the output of this section through the Compress
(Comp) unit. For more information on how to use the Compressor effect, see page 
67.
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PCF

The PCF effect is basically a filter with an envelope, just like there are filters w
envelopes in the synth sections. You route the output of one of the sections th
the PCF and thereby shape the tonal character of the sound.

The main difference between the PCF and the synth filters is that this filter is 
tern controlled”. There are a number of preset patterns that allow the filter to “
perimpose” pumping effects, slow sweeps and rhythmic phrasing onto the so

On/Off switch

This turns the PCF effect on/off. When turned off, sound will pass through the
fect without any filtering. This button is very similar to a Bypass button on a reg
effect unit.

Meter

This shows the input level to the PCF. Use this as a diagnostic tool if you are u
whether any signal appears at the input of the PCF section. If this meter show
indication at all, some signal is coming in.

Pattern

There are a large number of preset patterns that provide various rhythmic effe
They do this by controlling the following envelope parameters:

• Retriggering.
This is the most basic type of control. For example, in Pattern 0 the envelope 
is retriggered (restarted) at each whole note, in pattern 1 on each half note etc.

• Dynamic and Attack control.
In many of the Patterns, the envelope is triggered with different dynamics on 
different “beats”. Some “beats” also have a slightly different attack.

The Patterns are preset, they can not be changed. Their length varies, most ar
32 steps (one or two bars), but some have been created in odd time signature

See page 204 for a list of all Patterns.

PCF on/off

Filter type 
select

Pattern 
selection

Frequency 
(cutoff)

Envelope 
Amount

Envelope 
Decay

Q 
(Resonance)
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Mode (BP/LP)

This switches the filter between its two major modes, lowpass and bandpass.

• The lowpass filter (LP) is similar to the one used in the synth sections in 
ReBirth. It lets all harmonics below a certain frequency (the cutoff fre-
quency) pass through.

• The bandpass filter (BP) only lets frequencies within a certain band (a 
range of frequencies) pass through.

Freq (Frequency)

This is the main frequency range the filter should operate in.

The Freq parameter is related to the Amount (Amt) parameter: If the Amount s
is set to zero, there will be no pattern effect at all. The filter can then be used 
fixed “tone control” by adjusting the Freq and Q parameters. If the Freq slider 
the way up, the Amt slider has no effect since the filter is already fully open.

Q

This is the same as the “Reso” control in the synth sections. Technically it rou
the sound at the output of the filter back to the input, in a feedback loop. Sound
it gives the sound a more hollow, pronounced character.

● Be careful when combining large Q values in the PCF with large Reso values 
in a synth, since this might lead to overloading the output of the PCF, causing 
distortion.

Amt (Amount)

This control determines the amount of effect the envelope has on the filter. Fo
Pattern effect at all, this must be set to some value above zero.

Decay

This adjusts the length of the envelope decay. This has a significant effect on
“feel” of the Pattern.

• At low values there will be a clear pumping effect.

• When the Decay is raised, the pattern effect will be “smeared”. This can 
be used to good effect with Patterns 12 to 17 for smooth “LFO” effects.

• At very high values, the envelope will not be given a chance to decay very 
much until it is retriggered, giving a “stepping” effect (similar to the old 
synth effect “sample and hold”). This is most noticeable on patterns with 
dynamics (12 and above).
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Delay

Delay is an effect which adds repeats or echo to the sound.

This is a “send effect”, which means that any and all sections can be routed t
effect, by variable amounts.

For more detailed information on how to use the Delay effect, please see page 69.

On/Off switch

This turns the Delay effect on/off. When turned off, any sound will pass through
effect without any delay added. This button is very similar to a Bypass button 
regular effect unit.

Meter

This shows the input level to the Delay. Use this as a diagnostic tool if you ar
sure whether any signal appears at the input of the Delay section. If this meter s
any indication at all, some signal is coming in. 

Step and Straight/Triplet switch

These two controls determine the length of the Delay.

• If the Straight/Triplet switch is set to straight 16th notes, Steps is used for 
setting the length in 16th note steps. 

• If the Straight/Triplet switch is set to triplets, Steps is used for setting the 
length in steps of 8th note triplets.

F.Back

To get more than one echo, you can route the output of the Delay unit back to
input. This is often referred to as Feedback. The F.Back knob on the ReBirth d
does exactly this.

● Please be careful when raising this knob to high values. At full value, the echo 
repeats infinitely. While this can be used to good effect, it is something to be 
aware of.

Delay on/off

Feedback (number
of repeats)

Delay Length (sixteenths 
or eighth note triplets)

The panning of the 
output from the delay

Sixteenth note/eighth 
note triplet switch
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Pan

This determines the position of the delay output, in the stereo image.

The range of the parameter is fully left (L), through centre (“twelve o'clock”) to
fully right (R).
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Dist (Distortion)

Distortion is an effect which makes the sound “dirtier”. One section at a time ca
routed to the Distortion effect, using the Dist switches in the mixers.

For more detailed information on how to use the Distortion effect, please see page 
59.

On/Off switch

This turns the Distortion effect on/off. When the Distortion is turned off, any so
will pass through the effect without being distorted. This button is very similar 
Bypass button on a regular effect unit.

Meter

This shows the input level to the dist. Use this as a diagnostic tool if you are un
whether any signal appears at the input of the Dist section. If this meter show
indication at all, some signal is coming in. 

Amount

This determines the amount of distortion. The higher the setting, the dirtier th
sound.

Distortion 
on/off

Distortion 
ShapeDistortion 

Amount
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Compressor

The Compressor section.

A compressor, evens out levels to make the sound “tighter”. At high settings it
introduce a “pumping” effect. The compressor in ReBirth RB-338 is an insert ef
This means it will be inserted into the signal, just after the output of one of the
tions or on the master out. Only one section or the master output can use the
pressor.

On/Off switch

This turns the Compressor on/off. When the Compression is turned off, any s
will pass through the effect without being compressed. This button is very sim
to a Bypass button on a regular effect unit.

Meter

This shows the input level to the compressor. Use this as a diagnostic tool if yo
unsure whether any signal appears at the input of the Comp section. If this m
shows any indication at all, some signal is coming in. 

Threshold

This a setting for which signals should be affected. As the name implies, only le
above the one you specify here (the Threshold) will be affected. Levels below
value will pass through unaffected.

Ratio

This is the amount of level reduction, that is, the resulting reduction in level di
ence. The higher the setting, the more drastic the effect.

Level Reduction meter

This display shows you how much the level of the signal is reduced at any giv
time. The “0” setting (in the middle) means no change, whereas an indication t
left implies a level reduction. 

Compression 
on/off

Compression 
Threshold

Level reduction 
meter

Compression 
ratio
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Master

The Master level and faders.

Meters

These show the Output level from the entire program. Adjust this with the fade
that the meters show as high levels as possible during loud passages, withou
hitting the red top segment. For more information see page 24.

Fader

This is used for adjusting the overall output level from the program. Use this to
er with the meters to retain maximum level without clipping.

Comp

When this is activated, the master signal passes through the Compressor effe
(in stereo).
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Menus and Dialogs

Apple menu (Mac only)

About ReBirth RB-338...

This menu item opens up a dialog that informs you about the version of the pro
and the people behind it.

File menu

New

This creates a new ReBirth panel. Use this when you want to start on a Song
scratch. The settings and Patterns in this window are determined by the Prefe
setting “Pattern and knob settings for new songs”, see page 136.

Open...

This menu item is used for opening saved Song documents. It brings up a reg
file dialog where you can locate a Song file on disk and open it.

Close

This menu item closes the currently active window. If it is a document window, 
you have made any changes since you saved it last (or not saved the docum
all) you will be asked whether you want to save those changes before closing
window.

Save

This menu item allows you to save any changes you have made to the curren
tive document (the one you’re working on, or playing). If you have not yet sav
the document, selecting this is the same as selecting Save As, see below.

Save As...

This is used for saving a document the first time, or to save an existing docum
under a new name or at a new location. A regular file dialog allows you to spe
a name and location for the file.

Windows users might want to note that ReBirth RB-338 songs have the docu
extension “.rbs”.
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Song Information

This allows you to enter some information about your Song. This is useful for
ample if you intend to distribute your files via Internet and want to make peop
aware of who the creator is.

Export Loop As AIFF/Wave File (Mac)/Export Loop As Audio File (PC)

This menu item allows you to export the current Song (or a section of it) as an a
file. This file can later be played back from any program that can read audio fil
the specified format.

Only the area inside the Loop is saved. This allows you to specify any section o
Song to be saved, down to a single measure.

Recent Documents

In this section of the menu you will find up to four of your most recently opene
Song documents. Selecting one of these opens it.

Quit

This will quit the program. If any documents have unsaved changes you will b
asked if you want to save those changes before quitting.

Item: Description:

Text in Window Title This text always appears in the Song window title.

More Information This text will appear in the Information dialog and in the 
“splash screen” that appears when you load the Song (if 
Show Information...” is activated, see below”)

Creator’s Web Page Same as above.

Show information on 
Song open

If this is activated, “More Information” and “Creator’s Web 
Page” will appear in a window when the Song opens.

Browser When you click this, you will be taken to the web page 
specified in the dialog.
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Edit menu (Pattern items)

About the “focus”

All the Pattern operations below act on the Pattern that currently has the “foc
This means the Pattern with the focus bar. See page 22 for details.

Cut Pattern

This function is mainly used together with Paste to move Patterns between Pattern
locations.

It will copy the contents of the Pattern into the Clipboard, from where it can late
Pasted in to another Pattern location. In addition the Pattern will be Cleared, s
low.

Copy Pattern

This function is used together with Paste to copy Patterns between Pattern location
It will copy the contents of the Pattern into the Clipboard, from where it can late
Pasted in to another Pattern location.

Paste Pattern

This will paste the Pattern currently on the Clipboard, into the selected Patter
cation. The Pasted Pattern will replace whatever was previously at that locati

Clear Pattern

This empties the selected Pattern.

For synth Patterns this means that all steps are set as follows:

Shift Pattern/Drum Left/Right

This shifts the contents of the Pattern one sixteenth note in either direction. F
ample, if you shift right, what was on the first step will be on the second, what 
on the second will be on the third, and so on. In the same example, whatever w
the last step will be on the first.

Function Setting

Pitch Low C

Note/Pause Pause (no sound!)

Down Off

Up Off

Accent Off

Slide Off
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• When the focus is on a synth section, only Shift Pattern Left/Right is 
available. This shifts the entire content of the Pattern one step in the se-
lected direction.

• When the focus is on a rhythm section, you have the option of shifting 
the whole Pattern or just the selected drum sound.

Random Pattern/Pitches/Accents etc./Drum

This creates random synth and drum Patterns. This can be used as an inspir
tool (create a Pattern and modify the parts you don’t like) or for completely co
puter generated music.

The exact options available depend on the focus (synth section or rhythm sec
See page 53.

Alter Pattern/Pitches/Accents etc./Drum

This randomly shuffles the synth and rhythm Patterns, using the already pro-
grammed material as a basis for a new Pattern. See page 54.

Transpose...

The Transpose dialog (Macintosh version).

This only applies to synth Patterns. It allows you to transpose the Pattern to an
key. See page 54.
- 169 - 



:

Preferences...

This dialog contains a number of overall settings and options for the program

The Windows Preferences dialog.

The Mac Preferences dialog.
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Control: Description:

Audio Card Driver (PC only) Use this to select one of the card drivers in 
your system. See page 10 for more details 
about the available options.

Playback Performance slider (PC 
only)

This is used for setting the size of the buffers 
associated with audio playback. The smaller 
this number, the faster ReBirth will react to 
changes on the front panel. On the other 
hand, smaller settings require a faster audio 
card driver and computer. Again see the on-
line help and page 183 for details.

Buffer Size This indicates the size of the audio playback 
buffer, as adjusted with the slider.

Underruns (PC only) This shows the number of instances that the 
playback buffers have been “too small” with 
the current setting. If you get underruns, you 
need to raise the size of the buffer.

Multitasking friendly/Crackle safe 
(Macintosh only)

This allows you to select between two 
modes for creating audio on your computer. 
See page 11 for details.

Buffer size (Macintosh only) This should be set to the lowest possible 
value that provides glitch free audio play-
back.

MIDI Input This is used for selecting a MIDI Input for 
synchronization and remote control, see 
page 112 and page 126.

MIDI Clock Sync Enable This is a double up of the setting “Sync to 
MIDI Clock”, on the Options menu, See 
page 112.

Adjust Sync This setting is used for trimming the syn-
chronization, so that ReBirth RB-338 “locks 
in” with the master. See page 117.

Remote MIDI Control This is used for turning Remote MIDI Con-
trol on/off. When this is activated, ReBirth 
can be controlled via MIDI as set up in this 
dialog (and possibly also in the Quick Map-
ping dialog).

MIDI Channel This is used for specifying a MIDI channel 
for remote control messages.

Use ReBirth’s Standard Mapping When this is selected, practically all con-
trols on the front panel can be accessed via 
MIDI. However, the “mapping” between 
MIDI messages and front panel control is 
fixed, you can not modify it. See page 130 
for details.
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Use Quick Mapping When this is activated, only a selection of 
front panel controls can be accessed via 
MIDI Controller messages. However, by 
clicking the Edit button you can set up ex-
actly which, and how.

Edit Clicking this button opens the Quick Setup 
dialog.

Patterns and knob settings for new 
Songs

The two options here are used for setting 
whether new Songs should have default Pat-
terns and knob settings or if they should “in-
herit” Patterns and settings from the current 
Song. This is used for “customizing” the 
contents of New Songs. See page 136.

Play Mod Startup Sound When this is activated, and you select a 
Mod, it will play its startup Sound.

Control: Description:
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Quick Setup

This dialog is used for “mapping” incoming MIDI Controller messages to contr
on the ReBirth front panel, in Quick Setup mode.

Manual setup

1. Select a function you want to use, from the set of pop-up menus.

2. Click in the field to the right of the pop-up and type in the number of the 
controller message you want to use.

Using Learn

1. Select a function that you want to use, from the set of pop-up menus.

2. Move the controller you want to use for this function.
The field at the bottom of the dialog shows the number for this controller. If it 
doesn't, this is an indication that your MIDI connection is not set up correctly.

3. Click the Learn button associated with the function you want to use.
This controller number will then appear in the corresponding value field.
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Control: Description:

ReBirth knob pop-ups Use this to select a knob on the ReBirth front 
panel that you want to control via MIDI.

MIDI Control ID fields Use this to type in the MIDI Controller num-
ber you want to use for controlling the knob 
selected in the pop-up.

Learn buttons When you click a Learn button, the last re-
ceived MIDI Controller number (as dis-
played in the “Received MIDI Control ID to 
Learn” field) is automatically entered in the 
box just to the left. Use this as quick way of 
mapping controls on your synth, fader panel 
or similar, to knobs on the ReBirth front 
panel.

Received MIDI Control ID to Learn This field shows the number of the last re-
ceived MIDI Controller message. Use this as 
verification of incoming MIDI and in con-
junction with the Learn buttons.
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Edit menu (Song mode)

The contents of the Edit menu varies with the “mode” of the program. Below f
lows the items available when you are in Song mode:

Undo

This is not used in ReBirth RB-338.

Cut Loop

This menu item removes measures from the Song and puts them in the Clipb
More specifically, Cut removes all measures inside the Loop. This can be use
two purposes:

• When you want to make the Song shorter.

• Together with Paste, to move measures from one section of the Song to 
another.

Copy Loop

This menu item copies all the measures inside the Loop and puts them in the
board from where they can be pasted in.

Paste at Song Position

Adds the Cut/Copied measures to the Song, beginning at the Song Position. 
measures are inserted into the Song, so that is lengthened.

If you for example have Cut four bars and use “Paste at Song Position”, at Son
sition 13, you will get four new measures between measure 13 and 16. These
tain the pasted material. Whatever was at bar 13 before the operation is now at bar
17.

Paste Replace at Song Position

Similar to Paste at Song Position, but when this option is selected, the Pasted
rial overwrites the material currently in those measures.

Again, if you Cut four bars, and use “Paste Replace at Song Position”, at Son
sition 13, the contents of measures 13, 14, 15 and 16 will be replaced by the 
ures on the Clipboard.

Initialize Loop from Pattern Mode

This “initializes” the measures inside the Loop. This can be a convenient way
use the settings currently in Pattern mode, as initial settings for some measur
the Song you are building.

● Please note that this command clears all the Pattern changes and knob record-
ings currently inside the Loop!
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When you use “Initialize Loop from Pattern Mode”, all measures inside the Lo
are filled with the settings currently made in Pattern mode. That is, the Patter
lected in Pattern mode will be used, as well as all knob and other control setti

Initialize Song from Pattern mode

This is used for initializing the Song, to start over from scratch. It also allows 
to use the settings currently in Pattern mode as your initial settings for the Son
are about to build.

● Please note that this command clears all the Pattern changes and knob record-
ings currently in the Song!

When you use “Initialize Song from Pattern Mode”, all measures in the Song 
filled with the settings currently made in Pattern mode. That is, the three Patt
selected in Pattern mode will be used, as well as all knob and other control se

Copy touched controls to Loop/Song

This menu item allows you to insert “static” settings for any control, for a num
of bars. For example, you might want to turn on the Delay and make sure tha
turned on for the whole Song, or you might want to adjust some level control, 
specific number of bars.

A full explanation of this function can be found on page 83. 

Preferences...

See page 170.
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Mods Menu

Mod items

The first items on this list correspond to the Mods installed into your Mods fol
Selecting one applies it to the current Song. See page 89 for more information.

Select Mod...

This opens a dialog with options related to Mods:

Scan for New Mods

This menu item “refreshes” the list of Mods on the Mods menu. If you have co
a new Mod to the Mods folder since you last launched ReBirth, this command 
this Mod to the menu.

Option: Description:

Mod pop-up This list the Mod files found in your Mod folder in 
your ReBirth folder. Selecting one and clicking OK, 
applies it to the active Song.

Mod Splash Screen An “About” screen for the Mod.

Mod Information text Text added by the Mod creator that tells you more 
about this particular Mod.

Web Site link An optional link to the Mod creator’s web site. On 
this page you should find more information about 
the Mod, and the author. To go to this web page, 
click the Browser button.

OK This closes the dialog and applies the Mod to the 
active Song document.

Cancel This closes the dialog without making any changes.

Demo Song This plays a demo Song that should give you a hint 
as to what kind of sounds the Mod provides.

Browser This launches your web browser and takes you to 
the web site specified for the Mod. See page 179 for 
details on the web browser mechanism.
- 177 - 



ing 

e or 

er de-

log 

nthe-
 

 For 

-

ment 

dow.
Options menu

Sync to MIDI Clock

When this is activated, ReBirth RB-338 will synchronize its playback to incom
MIDI Clock.

When synchronized to MIDI Clock, the tempo is determined by the other devic
application – the tempo on the ReBirth transport bar is of no relevance.

You do not need to activate Play in ReBirth. As soon as it senses that the oth
vice/application starts, it will start automatically.

To determine which MIDI source to synchronize to, open the Preferences dia
and change the Sync Input setting.

For more information about external sync, see page 112.

Program Synth from Keyboard

When this is activated, the computer keyboard is used for programming the sy
sizer that currently has the focus (see page 22 for more info about focus). To learn
how to program the synthesizer from the keyboard, see page 43.

Select Patterns from Keyboard

When this is activated, the computer keyboard is used for selecting Patterns.
more information see page 20 and page 222.

Windows menu

Stay on Top (Windows only)

When this is activated, the ReBirth window will always stay on top of other pro
gram’s windows.

Resize Application Window to Documents

This changes the size of the application window so that it exactly fits the docu
windows.

Window List

This lists all the open Song documents. Selecting one makes it the active win
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Contacts/Help menu

Help... (Windows only)

This menu item open up the Topic window for the Windows on-line help syste

About the Internet menu alternatives

Regardless of which of the four Internet options you select, you will be conne
to the Internet using your preferred browser (on the PC this happens directly, o
Macintosh you have to select a browser in a dialog). The browser will then take
to the page specified in the dialog.

If you prefer, you can of course note down the web address in the dialog and 
nect manually instead.

Go to Propellerhead's Homepage...

This take you to the main entrance on the Propellerheads web site.

Go to Steinberg’s Home Page...

If you are interested in more info from ReBirth’s music retailer distributor, use 
option.

Download ReBirth Songs...

This takes you to our archives of song files that you can download and use, e
with the demo version. You can also contribute with your own creations!

Download ReBirth Mods...

This takes you to Mod files archives with the latest offerings in free Mod files!

ReBirth Tech Info and Support...

If you have a problem or a technical question, this is the place to go!

Order ReBirth Now...

This allows you to purchase your own personal copy of this exquisite applicat

About ReBirth RB-338... (Windows only)

This menu item opens up a dialog that informs you about the version of the pro
and the people behind it.
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General Information

Audio Quality

The general audio quality in a computer based synthesizer system depends o
things:

• The quality of the software calculating the audio.
In our case, this is the ReBirth DSP (Digital Signal Processing) code. And what 
can we say? We have invested all our expertise and an enormous amount of 
time to make ReBirth RB-338 sound as good as possible. All calculations are 
made at the highest possible resolution throughout the signal chain. The 
44.1kHz sampling frequency is maintained at all times. A number of digital 
audio techniques are implemented that reduce the risk of “aliasing”, back-
ground noise, unwanted distortion and “zipper noise”. OK, we’ll say it 
straight out: ReBirth sounds awesome.

• The quality of the hardware playing back the sound.
In a PC this is the sound card. In the Mac it is the built in audio circuitry or 
any audio card you have installed. Don’t be fooled by the “16 bit, 44.1kHz, 
CD quality” tags. How good some audio hardware actually sounds depends 
on a number of things, its frequency range and frequency response curve, the 
signal to noise ratio, the distortion under various circumstances, etc. Further-
more, some designs are more prone to disturbance from the other electronics 
in the computer, than other. Such disturbance might add hum or high pitched 
noise to the signal.

As you probably understand by now, this is a big subject and there’s no way 
we can help you find the right solution in this manual. There are a number of 
text books and magazines covering this subject and any music dealer special-
izing in computers will happily help you out. The only advice we can give 
you is that if you are serious about sound, choose your audio hardware care-
fully!

● PC users, please read the paragraphs about DirectX on page 183, it might 
have an impact on your choice of audio hardware.
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About Latency

On any personal computer system, there is a delay between the moment you
the hardware to play a sound and when it actually does it. This delay is referr
as the “latency” of the design. This imposes a problem for any system where 
want real time user input to affect the sound.

What is acceptable?

As a comparison, consider a hardware synthesizer. Here, you normally wouldn
cept a latency (between key down and sound out) of more than 3 to 7 ms (mi
onds – thousands of a second), if the instrument is to be used “professionally

On a regular PC or Mac, the latency is anywhere from 25 to 300ms! This is ju
effect of the fact that a computer was built for many purposes, not just playing 
audio. For multimedia and games, this is perfectly acceptable, but for playing a
sical instrument it is not!

For this reason, you can not play the sounds in ReBirth RB-338 via MIDI. It wo
feel just awful.

ReBirth’s built in sequencer is not affected by latency!

However, when the sound is played back via a built in sequencer, such as in Re
RB-338, the timing between notes is perfect! Once playback of a ReBirth Patte
Song is up and running, latency isn’t a consideration at all. The computer clock
audio between the steps and does this with perfect quartz accuracy! The timi
immaculate!

Still, latency rears it ugly head in another part of the program:

• When you move controls on the front panel, the time it actually takes be-
fore these movements affect the sound depends on the latency.

• The timing accuracy of the meters on the front panel is determined by la-
tency.

For these two reasons, ReBirth has a buffer size setting in the Preferences d
This allows you to minimize the latency as much as possible. How much you 
be able to reduce the buffer sizes depends on your sound driver and your com
The faster it is, the smaller the buffers required.

Reducing latency

Having said this, there are general methods for reducing latency. The problem
that most of them are based on non-standard solutions that require special har
to be installed in your system. For a software developer they also impose prob
since special routines have to be written for each hardware solution.

On the Macintosh, it is the Sound Manager routines (part of the Mac OS) and
audio hardware in the computer that are responsible for the latency.

On the PC, it is the Windows routines and the audio card that introduce laten
However, you do have some control over this via the choice of using MME or
rectX drivers for your audio card, see below.
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PC Specific Information

About DirectX, MME and the Sound Buffer setting

There are two ways for Windows to access an audio card:

Via an MME (MultiMedia Extensions) driver

This system has been around since Windows 3.0, and it is this type of driver 
that is normally installed in the Control Panel and via Plug’n’Play. Most regu-
lar sound playback (like when Windows goes “bing” on startup) happens via 
MME.

• Practically all cards come with an MME driver. If your card appears in the 
System part of the Control Panel, you have an MME driver installed.

• Using a card via an MME driver gives you relatively long latency (see page 
182), especially under Windows 95.

• Only one program at a time can use a card accessed via MME.

• If you use MME, ReBirth RB-338 can play in the background.

• The latency is around 160 milliseconds when using MME under Windows 
95. 

Via a DirectX driver

DirectX is a later system developed by Microsoft to provide developers with 
more efficient routines to access audio. As of this writing, DirectX version 2 is 
included with Windows 95 and Windows NT. However, version 3 was the lat-
est and can be obtained from Microsoft. However, this does not mean you 
should always use DirectX on your system, read on.

• As of this writing, not all cards come with DirectX drivers. Drivers for 
some cards are included with DirectX itself.

• Using a card via a DirectX driver gives you a pretty short latency, between 
40 and 90 milliseconds under Windows 95 (see page 182).

• If you use DirectX 3 or later, all programs that access the card via DirectX 
and make use of the DirectX “secondary buffer” feature can use it at the 
same time and ReBirth RB-338 can play in the background.
These are the only two differences between DirectX 2 and 3 that concern Re-
Birth.
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Questions and Answers about DirectX

● This text is by no means a complete guide to DirectX! For more information, 
please point your web browser to: http://www.microsoft.com/DirectX/de-
fault.asp (the “DirectX Pavilion” at Microsoft).

Should I access my card via DirectX or MME?

ReBirth RB-338 can use DirectX or MME, the program will work fine with eith
system. However, if, and only if, you have a card for which there is a real Direct
driver, and this driver is installed correctly, you should use DirectX. This will allow 
you to reduce the latency (see page 182) which makes the program more responsiv
It will not make it sound better or give it any other additional features, but twis
knobs and moving controls will “feel better”.

How do I know if I have DirectX installed at all on my computer?

1. Launch ReBirth.

2. Pull down the Edit menu and select Preferences.

3. Pull down the Audio Card Driver menu in the dialog that appears And se-
lect the last driver on the list.
Check the text just below the pop-up. If it says “Driver Type: Direct X”, then 
you have DirectX installed.

How do I know if I have a real driver (as opposed to an “emulated driver”) 
installed for my card?

Select the various alternatives on the Audio Card Driver menu described above
at a time. The text that appears below tells you if the driver is “emulated”.

● If you have a DirectX driver not indicated as emulated, use it! On the other 
hand, if you only have emulated DirectX drivers, don’t use DirectX. Instead 
use one of the MME alternatives on the menu!

How do I know which version of DirectX I have installed?

You can’t, at least not really. However, you can tell if you have version 3 or lat

1. Start ReBirth so that it’s playing.

2. Switch over to another program, for example the Desktop.
If ReBirth keeps playing, you have DirectX 3 or later installed. If it stops you h
an earlier version.
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If I don’t have DirectX installed, should I install it?

There are two situations where we recommend you to install DirectX, if you d
have it already:

• If the card vendor can supply you with a DirectX driver.

• If your card is one of the few for which a driver is included with Micro-
soft’s DirectX package.
The list of included drivers changes constantly. Again, please visit the “Di-
rectX Pavilion” at the Microsoft web pages.

If I have DirectX version 2, should I install a later version?

The major difference between version 2 and later is that the later versions allow
eral applications to share one audio card, whereas version 2 does not.

If you’re the type that always want to keep your computer system up to date w
the latest version of any software, install a later version. If you’re the type that ra
stays with what you have, because you know and understand it, don’t.

Where do I get hold of DirectX?

Version 5 of DirectX is included on the ReBirth CD. For later versions, please 
the “DirectX Pavilion” at the Microsoft web pages, http://www.microsoft.com/D
rectX/default.asp.

Where do I get hold of a “certified” DirectX driver for my audio card?

There are two ways:

• A driver might be included with DirectX.

• Contact the card vendor or the dealer where you purchased the audio card 
and ask for a DirectX driver.
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Cyrix vs. Intel

As of this writing, the two major processor manufacturers are Intel and Cyrix. B
have their advantages and disadvantages, but actually, for ReBirth RB-338, an
processor is the best choice. Why?

This has to do with floating point calculations (counting with decimal numbers rat
er than with non-decimal numbers, integers.). Using floating point arithmetics en-
sures high audio quality. You can get high audio quality on an integer system
but floating point is effective and accurate when it is available.

Intel Pentium processors are much faster at floating point mathematics than Cyrix
586 and 686 chips. This means that much more of your computer’s processing
er will be used up when running ReBirth RB-338 on a Cyrix processor than o
Intel. This has the following effects:

• On a Cyrix processor you need to use larger buffer sizes (the buffer size 
is set in the Preferences dialog), to prevent the sound from “breaking 
up”.
Larger buffers makes the program less responsive to control changes, see page 
182.

• The updating of the graphics will be slower.
This can be noted when moving windows, pulling down menus etc.

• Other programs running at the same time, will not perform as fast as they 
otherwise do.

● Provided the buffering is OK, the speed of the processor has no effect on the 
sound quality. ReBirth RB-338 will sound just as good on an Intel processor as 
on a Cyrix or other brand!
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Macintosh Specific Information

What the Sound Manager does/is

The Sound Manager is a set of software routines in the Mac OS. These routine
care of everything related to sound.

The Sound Manager is built into the system. If you have the latest version of M
OS, you probably don’t need to install any special Sound Manager files. How
if you run an older OS version, you can install the Sound Manager included w
ReBirth, or any even more recent version you can get hold of (for example fro
Apple’s Internet pages: www.apple.com).

One specific character of the Sound Manager is its ability to mix audio from se
applications. This means that even when you run ReBirth, you can run other S
Manager compatible applications at the same time, and they will all sound.

Latency and Mac OS 8.1

In Mac OS 8.1, Apple have reduced the size of their sound buffers, which me
that latency has been cut in half. To take advantage of this, proceed as follow

1. Open one of the demonstration songs.

2. Activate Playback.

3. Open the Preferences dialog, from the Edit menu.

4. Make sure the Multitasking friendly option is selected.

5. Locate the Buffer size pop-up.
This allows you to adjust the audio buffer size.

6. Select the smallest buffer size.
This will probably make the sound completely garbled.

7. Select the next larger buffer size.

8. Repeat with the next larger buffer size, until the sound is OK.
You now have the smallest possible buffer setting that works on your system.

Mac Audio cards

Even though all Macintosh computers have built in sound, there are Mac aud
cards which add capabilities to your system. Such capabilities can be addition
and outputs, digital connections, better sound quality, etc.

• If you have an audio card for which there is a well written Sound Manager 
driver (a piece of software that allows the Sound Manager to play via the 
card) you can use the card with ReBirth RB-338.
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• If you use the card with some special software (such as a hard disk record-
ing system) that does not use the Sound Manager, you can still use that 
software and run ReBirth at the same time. ReBirth will use the built in 
sound connectors on your Macintosh and the other software will use the 
card.

Installing a Macintosh audio card for use with ReBirth

If you have an audio card for which there is a Sound Manager driver, you can 
with ReBirth RB-338. Proceed as follows.

1. Quit ReBirth if it’s running.

2. Install the card as described by the manufacturer.

3. Install the Sound Manager driver for the card, as described by the manu-
facturer.

4. Open the Monitors and Sound control panel.

5. Click on the Sound button.

6. Select the card from the list of audio outputs.

7. Set up the levels and sound quality options as desired.

8. Switch to the warnings display and click on the sounds to check that they 
now play back via the audio card.

9. Close the dialog.

10.Launch ReBirth.
It will now play back via the audio card rather then via the computer’s built in 
audio outputs.
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Introduction
The intent of this chapter is to help you get as effective technical support as p
ble. Please read through the following before you contact technical support.

Where can I get Support?
This depends on where you bought the program:

• If you bought ReBirth RB-338 directly from Propellerhead Software, sup-
port is available via the Internet. See below for details.

• If you bought ReBirth from Steinberg Soft- & Hardware there are two ways 
to get support: via the Internet (see below) or by contacting your local dis-
tributor. If in doubt, examine your package for details on how to contact 
the distributor, or contact the dealer where you bought the program.

What you need to do before Contacting Tech Support
First of all, do you need help with some functionality in the program or do you 
pect something doesn’t work as intended? Read through the following points:

If the Program isn’t Behaving as Expected

Is the problem really with ReBirth RB-338?

Technical support personnel can unfortunately not help you with general prob
with your computer and peripherals. Furthermore, the operation manual and te
cal support facilities assume you have a basic understanding of how your com
works. If not, please go back and study the documentation that came with the
puter and related equipment.

“It worked before...”

Often, when a program stops working it is because you have installed someth
new or changed your configuration in some way. If possible, revert to the old s
and check if things work then.

When you have done so, install the new components one at a time and check
Birth in between each one. This will help you pinpoint exactly what it is that cau
the problem.

Do other programs behave normally?

Sometimes when you have problems with general things like audio playback, M
or file handling, it can help using other programs to perform similar operations
example, if none of your programs can play back audio, the problem might be
the audio card or its installation, rather than with the programs.
- 190 - 



come 
rself 

t, 
e you 

 are 

 and 
e in-

me-
Disa-
, 

the 
Is everything installed properly? Did you really follow the installation 
instructions?

Installing hardware and software can be a daunting task. The instructions that 
with the devices and program are there for a reason. Even if you consider you
a seasoned expert, and even if the manufacturer boasts “Plug’n’Play” suppor
please read the instructions and ReadMe files, there might be something ther
missed!

Is there a system conflict?

Sometimes, problems that appear to be related to a certain program or device
actually caused by something entirely different. Try the following:

• Disable any system extensions and additions not required for running Re-
Birth RB-338.

• Remove any background (“memory resident”) programs that you have in-
stalled.

• Quit all other programs.

• Try with a simple computer configuration.

• Un-install any special hardware that might interfere with your system.

• Now, run ReBirth RB-338 again and see if the problem persists.

If there is Something you don’t understand

Did you really read the manual thoroughly?

We have to say this: a lot of time and effort was put into providing as accurate
complete documentation for ReBirth RB-338 as possible. Chances are that th
formation you are looking for is somewhere in this manual:

• Use the Table Of Contents for finding overall procedures.

• Use the Index to find descriptions related to certain terminology.

• Use the Find feature to search for keywords.

• Read the ReadMe files included with the program. These often contain 
last minute notes and information about special situations.

Reduce the number of pitfalls

When you try to come to grips with a certain procedure or function, try it on so
thing simple. Create some simple material that you can use as “workbench”. 
ble all unrelated functions and features, hold your breath, and try again. Often
when minimizing unrelated options, it is easier to see what is going on within 
program.
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What you need to have at hand

So, you tried all of the above, and you still have problems. This is what you ne
have at hand before you contact technical support:

Serial number and registration information

You must be prepared to state the program serial number of the program and
registration information. This is found somewhere on the package or on a sep
registration card.

Version number

This is very important. The version of the program can be found in the About 

System details

We will need to know many things about your system, like:

• Computer brand and specifications (RAM, hard disk, installed cards etc).

• Graphic and audio card details (driver versions etc.).

• Windows/Mac OS versions.

• Details about other programs you have installed.

A description of the problem

The importance of this can not be underestimated. A description like “it somet
crashes” doesn’t do much good. We need to know:

• The exact series of events that cause a problem.

• Reports about exactly where in the series of events the problem occurs.

• Detailed information about any error messages or alert boxes that appear.

How to Contact Tech Support

If you bought the program directly from Propellerhead Software

• Pull down the Contacts/Help menu and select “Get Technical Support”, 
or...

• Fire up your Internet browser and point it to www.propellerheads.se/
techsupport/.

If you bought the program from Steinberg Soft- & Hardware

• Contact your local distributor in the way they instruct you, or...

• Point your Internet browser to www.steinberg.net.
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The tables in this appendix show all the MIDI messages used in the Standard 
Mapping mode.

Mixers

This table shows you which MIDI Controller messages are used for the variou
controls in the Mixers

Controls in the Synths

This table shows you which MIDI Controller messages are used for the variou
controls in the two synth sections:

Control: Synth 1: Synth 2: 808 Rhythm: 909 Rhythm:

Level 11 14 17 20

Pan 12 15 18 21

Delay Amount 13 16 19 22

Control: Synth 1: Synth 2:

Waveform 23 30

Tune 24 31

Cutoff 25 32

Reso 26 33

Env Mod 27 34

Decay 28 35

Accent 29 36
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Controls in the 808 Rhythm Section

This table shows you which MIDI Controller messages are used for the variou
controls in the 808 rhythm section:

Control: MIDI Ctrl #: Comment:

AC Level 37 

BD Level 38

BD Tone 39

BD Decay 40

SD Level 41

SD Tone 42

SD Snappy 43

LT Level 44

LT Tune 45

LT Switch 46  On/Off

MT Level 47

MT Tune 48

MT Switch 49  On/Off

HT Level 50

HT Tune 51

HT Switch 52  On/Off

RS Level 53

RS Switch 54  On/Off

CP Level 55

CP Switch 56  On/Off

CB Level 57

CY Level 58

CY Tone 59

CY Decay 60

OH Level 61

OH Decay 62

CH Level 63

Instrument Selection 64
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Controls in the 909 Rhythm Section

This table shows you which MIDI Controller messages are used for the variou
controls in the 909 rhythm section:

Control: MIDI Ctrl #: Comment:

AC Level 65 

BD Level 66

BD Tune 67

BD Attack 68

BD Decay 69

SD Level 70

SD Tune 71

SD Snappy 72

LT Level 73

LT Tune 74

LT Decay 75

MT Level 76

MT Tune 77

MT Decay 78

HT Level 79

HT Tune 80

HT Decay 81

Hi-hat Level (CH and OH) 82

RS Level 83

CP Level 84

CH Decayh 85

CC Level 86

CC Tune 87

RC Level 88

RC Tune 89

Flam amount 90

Instrument Selection 91
- 196 - 



s 
Master and Effects Sections

This table shows you which MIDI Controller messages are used for the variou
controls in the Master and effect sections:

Section: Control: MIDI Ctrl. #:

Master Level 7

PCF Pattern 94

Mode (LP/HP) 95

Freq 96

Q 97

Amount 98

Decay 99

Delay Steps (1-32) 100

Triplet mode 101

Pan 102

Feedback 103

Dist Shape 104

Amount 105

Compressor Ratio 106

Threshold 107
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Various Switches

This table shows which keys (MIDI Note messages) that can be used in all m
for various functions on the panel:

MIDI Key Note Number Function
C6 96 Program Synths from Keyboard
B5 95 Select Patterns from Keyboard

A#5 94 Master – Comp On/Off
A5 93 909 – Comp On/Off

G#5 92 909 – PCF On/Off
G5 91 909 – Dist On/Off
F#5 90 909 – Mix On/Off
F5 89 808 – Comp On/Off
E5 88 808 – PCF On/Off

D#5 87 808 – Dist On/Off
D5 86 808 – Mix On/Off
C#5 85 Synth 2– Comp On/Off
C5 84 Synth 2 – PCF On/Off
B4 83 Synth 2 – Dist On/Off

A#4 82 Synth 2 – Mix On/Off
A4 81 Synth 1 – Comp On/Off

G#4 80 Synth 1 – PCF On/Off
G4 79 Synth 1 – Dist On/Off
F#4 78 Synth 1 – Mix On/Off
F4 77 Comp – Enable
E4 76 Dist – Enable

D#4 75 Delay – Enable
D4 74 PCF – Enable
C#4 73 Transport – Bar +
C4 72 Transport – Bar –
B3 70 Transport – Record

A#3 71 Transport – Stop
A3 69 Transport – Play

G#3 68 Focus to 909 Rhythm
G3 67 Focus to 808 Rhythm
F#3 66 Focus to Synth 2
F3 65 Focus to Synth 1
E3 64 Select Pattern/Program Synth
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Pattern Selection

When “Select Patterns from Keyboard” is activated on the Options menu, the
lowing keys (MIDI Note numbers) can be used for select Patterns.

MIDI Key Note Number Function
D#3 63 909 – Pattern 8
D3 62 909 – Pattern 7
C#3 61 909 – Pattern 6
C3 60 909 – Pattern 5
B2 59 909 – Pattern 4

A#2 58 909 – Pattern 3
A2 57 909 – Pattern 2

G#2 56 909 – Pattern 1
G2 55 909 – Bank D
F#2 54 909 – Bank C
F2 53 909 – Bank B
E2 52 909 – Bank A

D#2 51 909 – Pattern On/Off
D2 50 808 – Pattern 8
C#2 49 808 – Pattern 7
C2 48 808 – Pattern 6
B1 47 808 – Pattern 5

A#1 46 808 – Pattern 4
A1 45 808 – Pattern 3

G#1 44 808 – Pattern 2
G1 43 808 – Pattern 1
F#1 42 808 – Bank D
F1 41 808 – Bank C
E1 40 808 – Bank B

D#1 39 808 – Bank A
D1 38 808 – Pattern On/Off
C#1 37 Synth 2 – Pattern 8
C1 36 Synth 2 – Pattern 7
B0 35 Synth 2 – Pattern 6

A#0 34 Synth 2 – Pattern 5
A0 33 Synth 2 – Pattern 4

G#0 32 Synth 2 – Pattern 3
G0 31 Synth 2 – Pattern 2
F#0 30 Synth 2 – Pattern 1
F0 29 Synth 2 – Bank D
E0 28 Synth 2 – Bank C

D#0 27 Synth 2 – Bank B
D0 26 Synth 2 – Bank A
C#0 25 Synth 2 - Pattern On/Off
C0 24 Synth 1 – Pattern 8
B–1 23 Synth 1 – Pattern 7

A#–1 22 Synth 1 – Pattern 6
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A–1 21 Synth 1 – Pattern 5
G#–1 20 Synth 1 – Pattern 4
G–1 19 Synth 1 – Pattern 3
F#–1 18 Synth 1 – Pattern 2
F–1 17 Synth 1 – Pattern 1
E–1 16 Synth 1 – Bank D

D#–1 15 Synth 1 – Bank C
D–1 14 Synth 1 – Bank B
C#–1 13 Synth 1 – Bank A
C–1 12 Synth 1 – Pattern On/Off

MIDI Key Note Number Function
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Synth Section Switches

When “Program Synth from Keyboard” is activated on the Options menu, and
focus (see the main ReBirth manual) is set to one of the synths, the following 
tions can be activated via MIDI note messages:

MIDI Key Note Number Function
G#0 32 Pitch Mode On/Off
G0 31 Step
F#0 30 Back
F0 29 Note/Pause
E0 28 Slide

D#0 27 Accent
D0 26 Octave Up
C#0 25 Octave Down
C0 24 Pitch C
B–1 23 Pitch B

A#–1 22 Pitch A#
A–1 21 Pitch A

G#–1 20 Pitch G#
G–1 19 Pitch G
F#–1 18 Pitch F#
F–1 17 Pitch F
E–1 16 Pitch E

D#–1 15 Pitch D#
D–1 14 Pitch D
C#–1 13 Pitch C#
C–1 12 Pitch C
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808 Rhythm Section Switches

When “Program Synth from Keyboard” is activated on the Options menu, and
focus (see the main ReBirth manual) is set to the 808 Rhythm section, the fol
ing functions can be activated via MIDI note messages:

MIDI Key Note Number Function
D#1 39 Instrument – CH
D1 38 Instrument – OH
C#1 37 Instrument – CY
C1 36 Instrument – CB
B0 35 Instrument – CP

A#0 34 Instrument – RS
A0 33 Instrument – HT

G#0 32 Instrument – MT
G0 31 Instrument – LT
F#0 30 Instrument – SD
F0 29 Instrument – BD
E0 28 Instrument – AC

D#0 27 Step 16 - On/Off
D0 26 Step 15 - On/Off
C#0 25 Step 14 - On/Off
C0 24 Step 13 - On/Off
B–1 23 Step 12 - On/Off

A#–1 22 Step 11 - On/Off
A–1 21 Step 10 - On/Off

G#–1 20 Step 9 - On/Off
G–1 19 Step 8 - On/Off
F#–1 18 Step 7 - On/Off
F–1 17 Step 6 - On/Off
E–1 16 Step 5 - On/Off

D#–1 15 Step 4 - On/Off
D–1 14 Step 3 - On/Off
C#–1 13 Step 2 - On/Off
C–1 12 Step 1 - On/Off
- 202 - 



 the 
low-
909 Rhythm Section Switches

When “Program Synth from Keyboard” is activated on the Options menu, and
focus (see the main ReBirth manual) is set to the 909 Rhythm section, the fol
ing functions can be activated via MIDI note messages:

MIDI Key Note Number Function
D#1 39 Instrument – RC
D1 38 Instrument – CC
C#1 37 Instrument – OH
C1 36 Instrument – CH
B0 35 Instrument – CP

A#0 34 Instrument – RS
A0 33 Instrument – HT

G#0 32 Instrument – MT
G0 31 Instrument – LT
F#0 30 Instrument – SD
F0 29 Instrument – BD
E0 28 Instrument – AC

D#0 27 Step 16 - On/Off
D0 26 Step 15 - On/Off
C#0 25 Step 14 - On/Off
C0 24 Step 13 - On/Off
B–1 23 Step 12 - On/Off

A#–1 22 Step 11 - On/Off
A–1 21 Step 10 - On/Off

G#–1 20 Step 9 - On/Off
G–1 19 Step 8 - On/Off
F#–1 18 Step 7 - On/Off
F–1 17 Step 6 - On/Off
E–1 16 Step 5 - On/Off

D#–1 15 Step 4 - On/Off
D–1 14 Step 3 - On/Off
C#–1 13 Step 2 - On/Off
C–1 12 Step 1 - On/Off
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The pictures on the following pages show the 34 PCF patterns (see page 61).

The length of a Pattern is important since it determines the repetition. Let’s use
examples to illustrate this:

• Pattern 3 is a sixteenth note pattern that is 12 steps long. This means it re-
peats itself after 12 sixteenth notes (three quarters of a measure, in 4/4).

• Pattern 40 is a thirtysecond note pattern that is 28 steps long, which means 
it repeats itself after 14 sixteenth notes.

The height of the bars show the dynamics of the pattern, that is, the “velocity”
the triggering of each step.

16th Note Patterns

In the first 34 Patterns, each step represents a sixteenth note. The total length 
but the maximum length is 32 steps (two bars).

Pattern 0

Pattern 1

Pattern 2

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16
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Pattern 3

Pattern 4

Pattern 5

Pattern 6

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16
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Pattern 7

Pattern 8

Pattern 9

Pattern 10

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16
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Pattern 11

Pattern 12

Pattern 13

Pattern 14

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16
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Pattern 15

Pattern 16

Pattern 17

Pattern 18

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16
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Pattern 19

Pattern 20

Pattern 21

Pattern 22

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16
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Pattern 23

Pattern 24

Pattern 25

Pattern 26

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16
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Pattern 27

Pattern 28

Pattern 29

Pattern 30

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16
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Pattern 31

Pattern 32

Pattern 33

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16
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32nd Note Patterns

In Pattern 34 to 45, each step represents a thirtysecond note. Again, the leng
ies, but the maximum length is 32 steps (one bar).

Pattern 34

Pattern 35

Pattern 36

Pattern 37

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26 27 28 29 30 31 32

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26 27 28 29 30 31 32

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26 27 28 29 30 31 32

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26 27 28 29 30 31 32
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Pattern 38

Pattern 39

Pattern 40

Pattern 41

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26 27 28 29 30 31 32

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26 27 28 29 30 31 32

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26 27 28 29 30 31 32

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26 27 28 29 30 31 32
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Pattern 42

Pattern 43

Pattern 44

Pattern 45

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26 27 28 29 30 31 32

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26 27 28 29 30 31 32

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26 27 28 29 30 31 32

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26 27 28 29 30 31 32
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Additional 2.0 Patterns

Pattern 47 to 54, are of varying lenth. As you can tell from the horizontal axis t
are mixed 16th note and 32nd note patterns and even one eighth note Pattern
spans four bars.

Pattern 46

Pattern 47

Pattern 48

Pattern 49

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26 27 28 29 30 31 32

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26 27 28 29 30 31 32

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16
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Pattern 50

Pattern 51

Pattern 52

Pattern 53

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26 27 28 29 30 31 32

1 2 3 4 5 6 7 8 1 2 3 4 5 6 7 8 1 2 3 4 5 6 7 8 1 2 3 4 5 6 7 8
- 218 - 



Pattern 54

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16
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Menus

File menu

Edit menu

Mods menu

Mods menu

Command: Mac: PC:

New [Command]-[N] [Control]-[N]

Open [Command]-[O] [Control]-[O]

Close [Command]-[W] [Control]-[W]

Save [Command]-[S] [Control]-[S]

Song Information [Command]-[I] [Control]-[I]

Quit [Command]-[Q] [Control]-[Q]

Command: Mac: PC:

Cut [Command]-[X] [Control]-[X]

Copy [Command]-[C] [Control]-[C]

Paste [Command]-[V] [Control]-[V]

Copy Touched Controls to Song [Command]-[T] [Control]-[T]

Shift Pattern Left [Command]-[J] [Control]-[J]

Shift Pattern Right [Command]-[K] [Control]-[K]

Randomize Pattern [Command]-[R] [Control]-[R]

Alter Pattern [Command]-[Y] [Control]-[Y]

Alter Accents etc. [Command]-[U] [Control]-[U]

Command: Mac: PC:

Select Mod [Command]-[M] [Control]-[M]

Command: Mac: PC:

Program Synth From Keyboard [Command]-[F] [Control]-[F]

Select Pattern from Keyboard [Command]-[G] [Control]-[G]
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Transport Controls
The following transport commands can be executed from the numeric key pad
the left on the computer keyboard:

Pattern Selection
To select Patterns from the computer keyboard, make sure “Select Patterns f
Keyboard” is selected on the Options menu. Use the typewriter part of the com
ter keyboard!

This assumes you are using an American keyboard. If not, check the illustratio
page 20 instead. The keys are on absolute positions on the keyboard, not on c
character positions.

Command: Mac: PC:

Stop [0] [0]

Play [Enter] [Enter]

Stop/Play [space bar] [space bar]

Record [*] [*]

Fast Forward [=] [4]

Rewind [Num Lock] [5]

Go to Loop Start [1] [1]

Go to Loop End [2] [2]

Next Bar [8] [8]

Previous Bar [7] [7]

Tempo Up [+] [+]

Tempo down [–] [–]

Pattern: 1 2 3 4 5 6 7 8

Synth 1: [1] [2] [3] [4] [5] [6] [7] [8]

Synth 2: [Q] [W] [E] [R] [T] [Y] [U] [I]

808 Rhythm: [A] [S] [D] [F] [G] [H] [J] [K]

909 Rhythm: [Z] [X] [C] [V] [B] [N] [M] [,]
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Synth Programming
To program the synth section from the computer keyboard, make sure “Progr
Synth from Keyboard” is selected on the Options menu.

This assumes you are using an American keyboard. If not, check the illustratio
page 43 instead. The keys are on absolute positions on the keyboard, not on c
character positions.

Command: Mac/PC:

Step [Return]

Back [Backspace]

C [C]

C# [F]

D [V]

D# [G]

E [B]

F [N]

F# [J]

G [M]

G# [K]

A [,] (comma)

A# [L]

B [.] (period)

C [/]

Note/Pause [–]

Accent [P]

Slide [[](left bracket)

Octave Down [;](semicolon)

Octave Up [‘] (apostrophe)

Tab “Tap” Rhythm

Shift Delete notes during playback
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Rhythm Tap Programming
As described on page 32, you can “tap” the rhythm on the keyboard.This assum
you are using an American keyboard (see page 32).

Command: Mac: PC:

Low Volume [Command] [Control]

High Volume [Option] [Alt]

Flam [Command]+[Option] [Control]+[Alt]

Command: 808 Section: 909 Section:

– AC AC

A BD BD

S SD SD

D LT/LC LT

F MT/MC MT

G HT/HC HT

H RS/CL RS

J CP/MA CP

K CB CH

L CY OH

; OH CC

‘ CH RC

Shift Delete notes during playback Delete notes during playback
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A
About ReBirth RB-338 166, 179
AC 149, 151
Accent

Rhythm 35, 149, 151
Synth button 45, 154, 156
Synth knob 49

Adjust Sync 117, 171
AIFF files 124, 142, 167
Alter 54, 169
AMD 186
Amount (Distortion) 60, 163
Amt 66, 160
Apple menu 166
Attack 37, 152
Audio

Buffer 12, 14
Exporting 142
Playing in background 123
Setting up 10, 14
Sharing on Mac 124
Sharing under Windows 123

Audio card
General 181
Macintosh 187
Selecting 11
Sharing audio 123, 124
Windows 183

Audio Card Driver 11, 171, 184
Audio Quality 181

B
Back 40, 154
Background playback 123
Bank selector 147
BD 149, 151
BP 65, 160
Buffer Size 171
Buffer size 12, 14

C
CB 149
CC 151
CH 149, 151
CL 149
Clear Pattern 168
Clearing

General 52
Synth 46, 153

Close 166
- 22
Compressor
Introduction to 67
Level Reduction meter 68, 164
On/Off 164
Ratio 68, 164
Reference 164
Threshold 68, 164

Computer 19
Computer keyboard 19, 220
Controllers

For controlling ReBirth 126
Specifying 131
Standard implementation 193

Copy
in Song 85
Pattern 51

Copy Loop 175
Copy Pattern 168
Copy Touched Controls 78, 83, 176
CP 149, 151
Crackle safe 14
Cubase 101
Customizing Songs 136
Cut

Loop 85, 175
Pattern 51, 168

Cutoff 48, 155
CY 149
Cyrix 186

D
Dec 66, 160
Decay

Rhythm 37, 149, 152
Synth 49, 155

Delay
Amount 157
Feedback 161
Introduction to 69
Meter 161
On/off 161
Pan 162
Reference 161
Steps (Length) 161

DirectX 11, 183
Distortion

Amount 163
Introduction to 59
On/Off 163
Reference 163
Switch 158

Down 154
Download ReBirth Mods 179
Download ReBirth Songs 179
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E
Effects

Compressor 67
Delay 69
Distortion 59
Introduction to 56
PCF 61
Routing 58

Env. Mod. 49
Export Loop as AIFF/Wave 124, 142, 167

F
F.Back 70, 161
Fast Forward button 146
Feedback 70, 161
Flams 30, 152
Focus Bar 22, 52
Freq 65, 160

G
Go to Propellerhead's Homepage 179
Go to Steinberg's Homepage 179

H
HC 149
Help 179
Hi-hat (open vs. closed) 35
HT 149, 151
Hubi’s Loopback Device 116

I
Initialize Loop from Pattern Mode 83, 175
Initialize Song from Pattern mode 75, 176
Intel 186

K
Keyboard

Rhythm Programming From 32
Selecting Patterns From 20
Shortcuts 220
Synth Programming From 43
- 22
L
Latency 182
LB1 116
LC 149
Learn 131, 174
Level

Introduction to 24
Master 56
Mixer 56
Rhythm 37, 151

Level Reduction meter (Compressor) 68, 164
Live Sync 120
Loop

On/Off 146
Playback 73
Recording 84
Start and Length 146

LP 65, 160
LT 149, 151

M
MA 149
Master

Level 23, 56, 165
Meter 165

Master Section 165
MC 149
Meter

Compressor section 164
Delay 161
Distortion section 163
Master 165
Mixer 157
PCF 159

MIDI
Indicator 120, 144
Input 171
LED 120, 132, 144
Remote Control 126
Standard Mapping Table 193

MIDI Channel 127, 171
MIDI Clock 112, 120
MIDI Clock Sync 113
MIDI Clock Sync Enable 171
MIDI Control ID 174
MIDI Indication 132
MIDI Input 113, 128, 171
MIDI Port 114
Mixers 23, 157
Mixing

Introduction to 56
Levels 56
Master Level 56
Muting 57
Pan 57
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MME 183
Mode 65, 160
ModPacker 96
Mods

Creating 96
Dialog 94
Downloading automatically 92
Downloading manually 95
Installing 95
Introduction to 89
Memory requirements 89
New Songs 91
Opening Songs with 92
Uploading 99

MT 149, 151
MultiMedia Extensions 183
Multitasking friendly 14
Muting 57

N
New 136, 166
Note/Pause button 154

O
Octave 45
OH 149, 151
OMS 109, 113, 114
Open 166
Opening Songs 138
Order ReBirth Now 179

P
Pan

Delay 70, 162
Mixer 57, 157

Paste
Pattern 51, 168
Song 85

Paste at Song Position 175
Paste Replace at Song Position 86, 175
Pattern

Length 36, 46
Moving between Songs 139
PCF 159
Rhythm programming 25
Selecting 20
Synth programming 38
Tapping 32, 44
- 22
Pattern Editing
Alter 54
Copy 51
Cut 51
Paste 51
Random 53
Shift 53
Transpose 54

Pattern mode 17, 72
Pattern selector 147
Patterns and knob settings for new Songs 172
PCF

About 61
Amt 66, 160
BP/LP 65
Dec 66, 160
Freq 65, 160
Mode 65, 160
Pattern 65, 159
Pattern diagrams 204
Q 66, 160
Routing 64
Switch 158

Pitch buttons 153
Pitch Mode 42, 153
Pitches

from Keyboard 43
Setting in existing Pattern 42
Specifying 41

Play button 145
Play Mod Startup Sound 172
Playback Performance slider 171
Preferences 170
Program Synth from Keyboard 178, 223

Q
Q 66, 160
Quick Mapping 130, 131
Quick Setup 173
Quit 167

R
Random 53, 169
Ratio (Compressor) 68, 164
RC 151
ReBirth knob 174
ReBirth ModPacker 96
ReBirth Tech Info and Support 179
Received MIDI Control ID to Learn 131, 174
Recent Documents 167
Record button 146
Remote MIDI

Quick Mapping 130, 131
Standard Mapping 130, 193
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Remote MIDI Control 126, 171
Repeating measures 86
Reso 155
Resonance 48, 155
Rewind button 145
ReWire

Channels 105
Converting to Audio Tracks 109
CPU requirements 103
In VST Channel Mixer 108
Introduction to 102
Launching 104
Limitations 109
Memory requirements 103
Signal Routing 106

Rhythm Patterns
Accents 35
Adding notes 29
Clearing 36
Lengths 36
Programming 25
Removing notes 29
Tap recording 32

Rhythm sounds
Parameters 37
Reference for 808 149
Reference for 909 151
Selecting 28
Shared sounds 34

RS 149, 151

S
Save 166
Save As 166
Saving Songs 137
Scan for New Mods 95
SD 149, 151
Select Mod 94
Select Patterns from Keyboard 178, 222
Shared sounds 149
Shift 53, 168
Shuffle 21
Slide 45, 154
Snappy 37, 150, 152
Song

Customizing 136
End 78
Introduction to 72
Moving Pattern between 139
New 136
Opening 138
Playing 73
Punching In and Out 79
Recording Control changes 80
Recording Pattern changes 76
Saving 137
- 22
Song Editing
Copy 85
Cut 85
Paste 85
Paste Replace 86
Remove 85
Repeating 86

Song Mode 17, 72, 144
Song Position Pointers 118, 120
Sound Manager 14, 187
Sound Selector 28, 148
Standard Mapping 130
Standard MIDI Mapping Table 193
Startup Song 136
Stay on Top 139, 178
Step

Button 40, 154
Display 147, 154
Rhythm 29, 30

Steps (Delay setting) 70, 161
Stop button 145
Straight notes/Triplets 70, 161
Sync Indicator 121, 145
Sync to MIDI Clock 113, 178
Synchronization

Adjust 117
Introduction to 112
Live Sync 120
Song Position Pointers 118, 120
Sync Indicator 121
Tempo changes 119
Tempo Display 118
To external device 113
To other program 114

Synth Patterns
Accent button 45
Clearing 46
Length 46
Notes or pauses for start 40
Octave 45
Pitch Mode 42
Programming 38
Programming from keyboard 43
Slide 45

Synth settings
Accent 49
Cutoff 48
Decay 49
Env. Mod. 49
Resonance 48
Tune 48
Waveform 48

System 8 15
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T
Tap recording

Rhythm 32
Synth 44

Tempo 145
Tempo changes 119
Tempo display 118
Threshold (Compressor) 68, 164
Tone 37, 149, 152
Transport Panel 144
Transpose 54, 169
Tune

Rhythm 37, 150, 152
Synth 48, 155

U
Underruns 171
Up 154
Use Current Song 136

V
Values, setting 18
Volume

Master 165
Mixers 56, 157
Rhythm 37, 151

W
Wave files 124, 142, 167
Waveform selector 48, 155
Windows menu 138, 178
- 23
0 - 


	Table of Contents
	Introduction
	Thanks!
	About this Documentation

	Making Audio Settings
	Introduction
	Windows Computers
	Macintosh Computers

	Overview and Basic Concepts
	Introduction
	Song Mode vs. Pattern Mode
	Setting Values
	Using the Computer Keyboard
	MIDI
	Real Time Operation
	The Song Window
	Pattern Selection
	Using Shuffle
	About Focus and the Focus Bar
	The Mixers
	About Levels

	Programming Rhythm Patterns
	Introduction
	Preparations for Creating a Rhythm Pattern
	Soloing the Rhythm Section
	Programming and Playback
	Selecting Sounds
	Adding and Removing Notes
	Tap Recording
	Deleting notes via the Computer Keyboard
	Working with Shared Instruments on the 808 section
	Working with Accents
	About Open and Closed Hi-hat
	Clearing the Pattern
	Working with Various Pattern Lengths
	Sound Parameters

	Programming Synth Patterns
	Preparations
	Soloing a Synth Section
	Programming and Playback
	Clearing the Pattern
	Basic Procedures
	Using Pitch Mode
	Using the Keyboard for Creating and Editing Patterns
	Working with Octave settings
	Working with Accents
	Working with Slide
	Clearing the Pattern
	Working with Various Pattern Lengths

	The Synth Sound settings
	Waveform
	Tune
	Cutoff
	Resonance
	Env. Mod. (Envelope Modulation)
	Decay
	Accent

	Pattern Editing Functions
	Cut, Copy and Paste (Pattern)
	Pattern Functions

	Mixing & Effects
	Introduction
	Setting Levels
	Muting
	Using Pan
	Effect Routing
	Dist (Distortion)
	The PCF (Pattern Controlled Filter)
	Compressor
	Delay

	Creating and Playing Songs
	Introduction
	About the Song/Pattern Modes
	Playing Songs
	How the Song Sequencer works – The “Signal Flow”
	Preparations for Creating your own Songs
	Building a String of Patterns
	Correcting Mistakes and Making changes to the Pattern Order
	Recording Control (knob) Changes
	Correcting Mistakes and Making Changes to Control (knob) Recordings
	Recording while Looping
	About Recording Pattern changes vs. Control Changes
	Making Modifications to Patterns
	Moving, Removing and Repeating Measures in the Song
	Using the Song Feature in a “live” situation

	Using “Mods”
	What is a Mod?
	Creating a New Song with a Certain Mod
	Switching Mods for an Open Song
	Opening Songs that use Non-Standard Mods
	The Mod dialog
	Adding Mods to your Setup
	Creating Your own Mods

	ReWire – Using ReBirth RB-338 with Cubase VST
	Why use ReBirth RB-338 with Cubase?
	Introducing ReWire!
	System Requirements
	Preparations for Using ReWire - Macintosh only
	Launching and Quitting
	Activating ReWire Channels
	Signal Routing
	Using the Transport
	How the ReWire Channels are handled in Cubase VST
	Converting ReWire Channels to Audio Tracks
	Considerations and Limitations

	Using ReBirth RB-338 with Other Equipment and Programs
	Cubase users – Read This!
	Synchronization with Other Equipment
	Using “Live Sync”
	Running multiple Audio Applications on one Computer

	Remote MIDI Control
	Introduction
	Setting up Remote MIDI Control from External MIDI Hardware
	Setting up Remote MIDI Control from another Program
	Standard Mapping vs Quick Mapping
	Setting up Quick Mapping
	Using Remote MIDI Control
	Important Notes about MIDI Control

	File and Song Window Handling
	New Songs – Changing the Default Settings
	Saving Songs
	Opening Songs
	Copying and Moving Patterns between Songs
	Moving ReBirth Song files and Mods between Macintosh and PC Computers
	Exporting Songs and Patterns as Audio (AIFF/Wave) files

	Reference
	Transport Panel
	Pattern Section
	808 Rhythm Section
	909 Rhythm Section
	Synth Section
	Mixers
	PCF
	Delay
	Dist (Distortion)
	Compressor
	Master
	Menus and Dialogs

	About Audio on Computers
	General Information
	PC Specific Information
	Macintosh Specific Information

	Troubleshooting
	Introduction
	Where can I get Support?
	What you need to do before Contacting Tech Support
	How to Contact Tech Support

	Standard MIDI Mapping Tables
	PCF Pattern Diagrams
	Keyboard Shortcuts
	Menus
	Transport Controls
	Pattern Selection
	Synth Programming
	909 Section Modifiers
	Rhythm Tap Programming

	Index

